# Contents

## Chapter 1 Operational Precautions and Limitations
- General Safety Information ........................................................................................................... 8
- Regulatory Compliance ......................................................................................................................... 8
  - Australia and New Zealand ................................................................................................................. 8
  - Canada .................................................................................................................................................. 9
  - Europe ................................................................................................................................................ 9
  - United States ...................................................................................................................................... 9
  - International ...................................................................................................................................... 10
- Electrical Precautions .......................................................................................................................... 10
  - AC Mains Supply ................................................................................................................................. 10
  - Protective Earth Conductor ................................................................................................................ 11
- Chemical Precautions ........................................................................................................................... 11
  - System Safe Fluids .............................................................................................................................. 12
- Ventilation Precautions ......................................................................................................................... 13
- Environmental Precautions .................................................................................................................... 14
  - Electromagnetic Environment ........................................................................................................... 14
  - Decommissioning and Disposal .......................................................................................................... 15
- Qualified Personnel ............................................................................................................................... 16
- Laboratory Conditions ........................................................................................................................... 16
  - Operating Conditions ......................................................................................................................... 16
  - Performance Specifications ................................................................................................................. 16
- Equipment Use and Modification .......................................................................................................... 17
- Contact Us ............................................................................................................................................ 17
- Technical Support ................................................................................................................................. 18
- Documentation Symbols and Conventions .......................................................................................... 18
- Related Documentation ......................................................................................................................... 19

## Chapter 2 Principles of Operation
- System Overview ................................................................................................................................. 20
  - Hardware Overview ............................................................................................................................ 21
  - Theory of Operation—Hardware ........................................................................................................ 24
  - Analyst® Software Overview ............................................................................................................. 26
  - Theory of Operation—Analyst® Software ........................................................................................... 31

## Chapter 3 Operating Instructions — Sample Workflows

## Chapter 4 Operating Instructions—Hardware
- Start Up the System ............................................................................................................................. 43
- Reset the Mass Spectrometer ................................................................................................................. 45
- Shut Down and Vent the System .......................................................................................................... 45
Contents

Adjust the Integrated Syringe Pump Position..........................................................46
Plumb the Diverter Valve.........................................................................................50
Plumb the Diverter Valve in Injector Mode...............................................................51
Plumb the Diverter Valve in Diverter Mode.................................................................52

Chapter 5 Operating Instructions — Hardware Profiles and Projects..................54
Hardware Profiles..................................................................................................54
Create a Hardware Profile.......................................................................................54
Add Devices to a Hardware Profile........................................................................58
Troubleshoot Hardware Profile Activation............................................................60
Projects and Subprojects.......................................................................................61
Create Projects and Subprojects............................................................................61
Create Subprojects.................................................................................................62
Copy Subprojects....................................................................................................62
Switch Between Projects and Subprojects..............................................................63
Installed Project Folders.........................................................................................63
Back Up the API Instrument Folder.........................................................................64
Recover the API Instrument Folder..........................................................................64

Chapter 6 Tune and Calibrate..............................................................................65
Verify Instrument Performance................................................................................65
About the Verifying or Adjusting Performance Dialog...........................................66
Results Summary....................................................................................................66

Chapter 7 Automatic Optimization.......................................................................68
About Automatic Optimization................................................................................69
Types of Sample Introduction................................................................................69
Automatically Optimize for an Analyte Using Infusion........................................70
Confirm the Presence of Compounds.......................................................................70
Perform Automatic MS and MS/MS Optimization Using Infusion with a
Known Precursor Ion and an Unknown Product Ion..............................................72
Review the Optimization Results............................................................................75
Automatically Optimize for an Analyte Using FIA................................................76

Chapter 8 Operating Instructions — Acquisition Methods..............................84
Create an Acquisition Method Using the Acquisition Method Editor....................84
Configure the Integrated Syringe Pump...................................................................85
Add an Experiment..................................................................................................85
Add a Period.............................................................................................................86
Copy an Experiment into a Period...........................................................................86
Copy an Experiment within a Period.......................................................................86
Scan Techniques.....................................................................................................87
Quadrupole-Mode Scan Types................................................................................87
LIT-Mode Scan Types.............................................................................................88
About Spectral Data Acquisition.............................................................................88

Chapter 9 Operating Instructions — Analyze and Process
Quantitative Data.....................................................................................................90
Quantitative Analysis.............................................................................................90
Quantitation Methods............................................................................................90
# Contents

- About Results Tables .................................................................................................................. 91
- Quantitation Methods and Results Tables ..................................................................................... 91
- Create a Method Using the Quantitation Method Editor ............................................................... 91
- Create a Results Table Using the Quantitation Wizard ............................................................... 93
- Create a Standard Query (Optional) ............................................................................................. 94
- Results Table Right-click Menu .................................................................................................. 97
- Peak Review and Manual Integration of Peaks .............................................................................. 98
  - Review Peaks ............................................................................................................................ 98
  - Manually Integrate Peaks ........................................................................................................ 103
  - Peak Review Right-Click Menu ............................................................................................... 104
- Calibration Curves ........................................................................................................................ 105
  - View Calibration Curves .......................................................................................................... 105
  - Overlay Calibration Curves ..................................................................................................... 107
  - Calibration Curve Right-Click Menu ....................................................................................... 107
- Sample Statistics .......................................................................................................................... 108
  - View the Statistics for Standards and QCs ............................................................................... 108
- Compare Results Between Batches .............................................................................................. 109

## Chapter 10 Operating Instructions — Analyze and Explore Data ...................................................... 110

- Open Data Files ......................................................................................................................... 110
- Navigate Between Samples in a Data File ..................................................................................... 110
- View Experimental Conditions ................................................................................................. 111
- Show Data in Tables .................................................................................................................. 112
- Show ADC Data ........................................................................................................................ 113
- Show Basic Quantitative Data .................................................................................................... 114
- Chromatograms ........................................................................................................................ 115
- Show TICs from a Spectrum ....................................................................................................... 116
- Show a Spectrum from a TIC ..................................................................................................... 116
- About Generating XICs ............................................................................................................ 117
  - Generate an XIC Using a Selected Range ............................................................................... 118
  - Generate an XIC Using the Maximum Peak ......................................................................... 118
  - Generate an XIC Using Base Peak Masses .......................................................................... 119
  - Extract Ion by Selecting Masses ............................................................................................ 119
- Generate BPCs .......................................................................................................................... 120
- Generate XWCS ........................................................................................................................ 122
- Generate DAD Data .................................................................................................................. 122
- Generate TWCS ........................................................................................................................ 123
- Adjust the Threshold .................................................................................................................. 123
- Chromatogram Panes ................................................................................................................ 124
- Spectra Panes ............................................................................................................................ 125
- Graphical Data Processing ......................................................................................................... 125
- Graphs ..................................................................................................................................... 126
  - Manage Data .......................................................................................................................... 126
  - Zoom In on the Y-axis ........................................................................................................... 128
  - Zoom In on the X-axis ........................................................................................................... 128

## Chapter 11 Reporter Software ....................................................................................................... 129

- Analyst Reporter User Interface ................................................................................................. 130
## Contents

Generate Reports.................................................................................................................................132

### Chapter 12 Operating Instructions — Batches..................................................................................134

- Set Queue Options...............................................................................................................................134
- Create and Submit a Batch....................................................................................................................135
  - Add Sets and Samples to a Batch........................................................................................................135
  - Equilibrate the System.......................................................................................................................138
  - Submit a Sample or Set of Samples..................................................................................................139
- Change Sample Order.............................................................................................................................139
- Acquire Data.........................................................................................................................................139
- Set Sample Locations in the Batch Editor............................................................................................140
- Select Vial Positions Using the Locations Tab (Optional)..................................................................141
- Set Quantitation Details in the Batch Editor (Optional).......................................................................142
- Stop Sample Acquisition.......................................................................................................................142
- Import Batch Files...............................................................................................................................143
  - Build a Batch as a Text File................................................................................................................143
  - Import a Batch from a Text File..........................................................................................................143
- Batch Editor Right-click Menu..........................................................................................................144
- Queue States and Device Status........................................................................................................145
  - Queue States......................................................................................................................................145
  - View Instrument and Device Status Icons......................................................................................146
  - Queue Right-click Menu...................................................................................................................147

### Chapter 13 Service and Maintenance Information............................................................................149

- Recommended Maintenance Schedule................................................................................................149
- Clean the Surfaces...............................................................................................................................151
- Clean the Front-End.............................................................................................................................151
  - Symptoms of Contamination.............................................................................................................152
  - Required Materials..........................................................................................................................152
  - Cleaning Best Practices....................................................................................................................153
- Prepare the Mass Spectrometer..........................................................................................................154
- Clean the Curtain Plate........................................................................................................................155
- Clean the Front of the Orifice Plate......................................................................................................156
- Put the Mass Spectrometer Back in Service........................................................................................156
- Inspect the Roughing Pump Oil Level................................................................................................157
- Empty the Source Exhaust Drain Bottle..............................................................................................157
- Storage and Handling.........................................................................................................................159

### Chapter 14 Mass Spectrometer Troubleshooting.............................................................................160

### Appendix A Operating Instructions — Manual Compound Optimization........................................163

- About Manual Compound Optimization............................................................................................164
- About Scan Types...............................................................................................................................164
- Manually Optimize an Analyte.............................................................................................................164
  - Confirm the Presence of Compounds...............................................................................................165
  - Optimize MS-Specific Parameters....................................................................................................166
  - Determine the Product Ions for Optimization.................................................................................168
  - Optimize Collision Cell Exit Potential for each Product Ion..........................................................169
- Manually Optimize the Ion Source and Gas Parameters....................................................................170
Note: Before operating the system, carefully read all of the sections of this guide.

This section contains general safety-related information and provides regulatory compliance information. It also describes potential hazards and associated warnings for the system and the precautions that should be taken to minimize the hazards.

In addition to this section, refer to Glossary of Symbols on page 186 for information about the symbols and conventions used in the laboratory environment, on the system, and in this documentation. Refer to the Site Planning Guide for site requirements, including AC mains supply, source exhaust, ventilation, compressed air, nitrogen, and roughing pump requirements.

General Safety Information

To prevent personal injury or system damage, read, understand, and obey all of the safety precautions and warnings in this document, the manufacturer chemical safety data sheet (SDS), and product label information. These labels are shown with internationally recognized symbols. Failure to heed these warnings could result in serious injury.

This safety information is intended to supplement federal, state, provincial, and local environmental health and safety (EHS) regulations. The information provided covers system-related safety information applicable to the operation of the system. It does not cover every safety procedure that should be practised. Ultimately, the user and the organization are responsible for compliance with federal, state, provincial, and local EHS regulations and for maintaining a safe laboratory environment.

Refer to the appropriate laboratory reference material and standard operating procedures.

Regulatory Compliance

This system complies with the regulations and standards listed in this section. Refer to the Declaration of Conformity included with the system and the individual system components for dated references. Applicable labels have been affixed to the system.

Australia and New Zealand

- Electromagnetic Compatibility (EMC): Radio Communications Act 1992 as implemented in these standards:
• **Safety:** AS/NZ 61010-1 and IEC 61010-2-061

**Canada**

• **Electromagnetic Interference (EMI):** CAN/CSA CISPR11. This ISM device complies with Canadian ICES-001. Refer to Electromagnetic Interference on page 15.
• **Safety:**
  - CAN/CSA C22.2 No. 61010-1
  - CAN/CSA C22.2 No 61010-2-061

**Europe**

• **Electromagnetic Compatibility (EMC):** Electromagnetic Compatibility directive 2014/30/EU as implemented in these standards:
  - EN 61326-1
  - EN 55011 (Class A)
  Refer to Electromagnetic Compatibility on page 14.
• **Safety:** Low Voltage Directives 2014/35/EU as implemented in these standards:
  - EN 61010-1
  - EN 61010-2-061
• **Waste Electrical and Electronic Equipment (WEEE):** Waste Electrical and Electronic Equipment 2012/96/EEC, as implemented in EN 40519. Refer to Waste Electrical and Electronic Equipment on page 16.
• **Packaging and Packaging Waste (PPW):** Packaging and Packaging Waste Directive 94/62/EC
• **RoHS Restriction of Hazardous Substances:** RoHS Directive 2011/65/EU

**United States**

• **Radio Emissions Interference Regulations:** 47 CFR 15, as implemented in FCC Part 15 (Class A)
• **Safety:** Occupational Safety and Health Regulations, 29 CFR 1910, as implemented in these standards:
  - UL 61010-1
  - IEC 61010-2-061
Operational Precautions and Limitations

International

• Electromagnetic Compatibility (EMC):
  • IEC 61326-1
  • IEC CISPR 11 (Class A)
  • IEC 61000-3-2
  • IEC 61000-3-3
  Refer to Electromagnetic Compatibility on page 14.

• Safety:
  • IEC 61010-1
  • IEC 61010-2-061

Electrical Precautions

WARNING! Electrical Shock Hazard. Do not remove the covers. Removing the covers might cause injury or malfunctioning of the system. The covers need not be removed for routine maintenance, inspection, or adjustment. Contact a SCIEX Field Service Employee (FSE) for repairs that require the covers to be removed.

• Follow required electrical safe work practices.
• Use cable management practices to control electrical cables. This will reduce the chance of a tripping hazard.

For information about system electrical specifications, refer to the Site Planning Guide.

AC Mains Supply

Connect the system to a compatible AC mains supply as instructed in this guide.

WARNING! Electrical Shock Hazard. Use only qualified personnel for the installation of all of the electrical supplies and fixtures, and make sure that all of the installations adhere to local regulations and safety standards.

WARNING! Electrical Shock Hazard. Make sure that the system can be disconnected from the mains supply outlet in an emergency. Do not block the mains supply outlet.
WARNING! Electrical Shock Hazard. Use only the power cables supplied with the system. Do not use power cables that are not properly rated for the operation of this system.

An external line transformer is not needed for the mass spectrometer, optional bench, or roughing pump.

**Protective Earth Conductor**

The mains supply must include a correctly installed protective earth conductor. The protective earth conductor must be installed or checked by a qualified electrician before the system is connected.

WARNING! Electrical Shock Hazard. Do not intentionally interrupt the protective earth conductor. Any interruption of the protective earth conductor creates an electrical shock hazard.

WARNING! Electrical Shock Hazard. Make sure that a protective earth conductor (grounding cable) is connected between the sample loop and an appropriate grounding point at the ion source. This supplementary grounding will reinforce the safety configuration specified by SCIEX.

**Chemical Precautions**

WARNING! Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Determine whether decontamination is required prior to cleaning or maintenance. The customer must decontaminate the system prior to cleaning or maintenance if radioactive materials, biological agents, or toxic chemicals have been used with the system.

WARNING! Environmental Hazard. Do not dispose of system components in municipal waste. Follow local regulations when disposing of components.

WARNING! Biohazard, Toxic Chemical Hazard. Connect the drain tubing to the mass spectrometer and the source exhaust drain bottle properly, to prevent leaks.
**Operational Precautions and Limitations**

- Determine which chemicals have been used in the system prior to service and regular maintenance. Refer to the *Safety Data Sheets* for the health and safety precautions that must be followed with chemicals. SCIEX Safety Data Sheets can be found at [sciex.com/tech-regulatory](http://sciex.com/tech-regulatory).
- Work in a well-ventilated area or fume hood.
- Always wear assigned personal protective equipment, including powder-free neoprene or nitrile gloves, safety glasses, and a laboratory coat.
- Avoid ignition sources when working with flammable materials, such as isopropanol, methanol, and other flammable solvents.
- Take care in the use and disposal of any chemicals. Potential risk of personal injury if proper procedures for handling and disposing of chemicals are not followed.
- Avoid skin contact with chemicals during cleaning and wash hands after use.
- Make sure that all exhaust hoses are connected properly and that all connections are functioning as designed.
- Collect all spent liquids and dispose of them as hazardous waste.
- Comply with all of the local regulations for the storage, handling, and disposal of biohazardous, toxic, or radioactive materials.
- (Recommended) Use secondary containment trays beneath the roughing pump, the solvent bottles, and the waste collection container to capture potential chemical spills.

**System Safe Fluids**

The following fluids can safely be used with the system. Refer to *Required Materials on page 152* for information about safe cleaning solutions.

*CAUTION: Potential System Damage. Do not use any other fluid until confirmation is received from SCIEX that it does not present a hazard. This is not an exhaustive list.*

- **Organic Solvents**
  - MS-grade acetonitrile; up to 100%
  - MS-grade methanol; up to 100%
  - Isopropanol; up to 100%
  - HPLC-grade or higher water; up to 100%
- **Buffers**
  - Ammonium acetate; less than 1%
  - Ammonium formate; less than 1%
• **Acids and Bases**
  - Formic acid; less than 1%
  - Acetic acid; less than 1%
  - Trifluoroacetic acid (TFA); less than 1%
  - Heptafluorobutyric acid (HFBA); less than 1%
  - Ammonia/ammonium hydroxide; less than 1%

## Ventilation Precautions

The venting of fumes and disposal of waste must comply with all of the federal, state, provincial, and local health and safety regulations. It is the responsibility of the customer to make sure that the air quality is maintained in compliance with local health and safety regulations.

The source exhaust system and roughing pump must be vented to a dedicated laboratory fume hood or an external exhaust system.

**WARNING!** Fire Hazard. Make sure that the source exhaust system is connected and functioning to prevent flammable vapor from accumulating in the ion source.

**WARNING!** Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Take care to vent exhaust gases to a dedicated laboratory fume hood or exhaust system and make sure that the ventilation tubing is secured with clamps. Make sure that the laboratory has appropriate air exchange for the work performed.

**WARNING!** Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Do not operate the mass spectrometer if the source exhaust drain and roughing pump exhaust hoses are not properly connected to the laboratory ventilation system. Perform a regular check of the exhaust tubing to make sure that there are no leaks. The use of mass spectrometers without proper system ventilation might constitute a health hazard and might result in serious injury.

**WARNING!** Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Use the ion source only if you have knowledge of and training in the proper use, containment, and evacuation of toxic or injurious materials used with the ion source.
Operational Precautions and Limitations

WARNING! Puncture Hazard, Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Discontinue use of the ion source if the ion source window is cracked or broken and then contact a SCIEX Field Service Employee (FSE). Any toxic or injurious materials introduced into the equipment will be present in the source exhaust output. Dispose of sharps following established laboratory safety procedures.

Environmental Precautions

Use qualified personnel for the installation of electrical mains, heating, ventilation, and plumbing supplies and fixtures. Make sure that all of the installations comply with local bylaws and biohazard regulations. For information about the required environmental conditions for the system, refer to the Site Planning Guide.

Allow access space around the equipment when setting up the system.

DANGER! Explosion Hazard. Do not operate the system in an environment containing explosive gases. The system is not designed for operation in an explosive environment.

WARNING! Biohazard. For biohazardous material use, always comply with local regulations for hazard assessment, control, and handling. This system or any part is not intended to act as a biological containment.

CAUTION: Potential Mass Shift. Maintain a stable ambient temperature. If the temperature changes by more than 2 °C per hour, then the resolution and mass calibration might be affected.

Electromagnetic Environment

Electromagnetic Compatibility

Basic Electromagnetic Environment: Environment existing at locations characterized by being supplied directly at low voltage from the public mains network.

Performance Criteria A (Criteria A): Equipment shall operate as intended with no degradation of performance and no loss of function during or after test.

Performance Criteria B (Criteria B): Equipment may experience loss of function (one or more) during test but shall operate as intended with some degradation of performance and functions self-recoverable after test.
Performance Criteria C (Criteria C): Equipment may experience loss of function (one or more) during test but shall operate as intended with some degradation of performance and functions recoverable by operator after test.

The equipment is intended for use in a basic electromagnetic environment.

The expected performance loss under the electromagnetic immunity conditions is less than 20% change in total ion count (TIC).

Make sure that a compatible electromagnetic environment for the equipment can be maintained so that the device will perform as intended. If the power supply line is subject to high electrical noise, then install a surge protector.

Electromagnetic Interference

Class A Equipment: Equipment which is suitable for use in all establishments other than domestic and those directly connected to a low voltage power supply network which supplies buildings used for domestic purposes. [Derived from CISPR 11:2009, 5.3] Class A equipment shall meet Class A limits.

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC (Federal Communications Commission) Compliance Rules.

These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the operator’s manual, can cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference in which case you will be required to correct the interference, at your own expense. Changes or modifications not expressly approved by the manufacturer could void your authority to operate the equipment.

Decommissioning and Disposal

WARNING! Environmental Hazard. Do not dispose of system components in municipal waste. Follow local regulations when disposing of components.

Before decommissioning, decontaminate the entire system following local regulations.

When removing the system from service, separate and recycle different materials according to national and local environmental regulations. Refer to Storage and Handling on page 159.

Note: SCIEX will not accept any system returns without a completed Decontamination Form. Contact an FSE to obtain a copy of the form.

Do not dispose of system components or subassemblies, including computer parts, as unsorted municipal waste.
Waste Electrical and Electronic Equipment

Follow local municipal waste ordinances for proper disposal provisions to reduce the environmental impact of waste, electrical, and electronic equipment (WEEE). To safely dispose of this equipment, contact a local Customer Service office for complimentary equipment pick-up and recycling.

Qualified Personnel

Only qualified SCIEX personnel shall install, inspect, and service the equipment. After installing the system, the Field Service Employee (FSE) uses the Customer Familiarization Checklist to orient the customer on system operation, cleaning, and basic maintenance.

Only personnel qualified by the manufacturer shall maintain the equipment. A laboratory designate can be familiarized with the Qualified Maintenance Person (QMP) procedures during the installation. A QMP is a person who is suitably aware of the electrical and chemical risks associated with servicing laboratory equipment.

Laboratory Conditions

Operating Conditions

The system is designed to operate safely under these conditions:

- Indoors
- Altitude: Up to 2 000 m (6 400 feet) above sea level
- Ambient temperature: 5 °C (41 °F) to 40 °C (104 °F)
- Relative humidity: 80% for temperatures up to 31 °C (88 °F), decreasing linearly to 50% at 40 °C (104 °F)
- Mains supply voltage fluctuations: ±10% of the nominal voltage
- Transient overvoltages: Up to the levels of Overvoltage Category II
- Temporary overvoltages on the mains supply
- Pollution degree: Pollution Degree 2

Performance Specifications

The system is designed to meet specifications under these conditions:

- Ambient temperature: 15 °C (59 °F) to 30 °C (86 °F)
  Over time, the temperature must remain within a range of 4 °C (7.2 °F), with the rate of the change in temperature not exceeding 2 °C (3.6 °F) per hour. Ambient temperature fluctuations exceeding the limits might result in mass shifts in spectra.
- Relative humidity: 20% to 80%, non-condensing
Equipment Use and Modification

**WARNING!** Personal Injury Hazard. Contact the SCIEX representative if product installation, adjustment, or relocation is required.

**WARNING!** Electrical Shock Hazard. Do not remove the covers. Removing the covers might cause injury or malfunctioning of the system. The covers need not be removed for routine maintenance, inspection, or adjustment. Contact a SCIEX Field Service Employee (FSE) for repairs that require the covers to be removed.

**WARNING!** Personal Injury Hazard. Use SCIEX-recommended parts only. Use of parts not recommended by SCIEX or use of parts for any purpose other than their intended purpose can put the user at risk of harm or negatively impact system performance.

Use the mass spectrometer and ion source indoors in a laboratory that complies with the environmental conditions recommended in the *Site Planning Guide*.

If the mass spectrometer and ion source is used in an environment or in a manner not prescribed by the manufacturer, then the protection provided by the equipment might be impaired.

Unauthorized modification or operation of the mass spectrometer and ion source might cause personal injury and equipment damage, and might void the warranty. Erroneous data might be generated if the mass spectrometer and ion source is operated either above or below the recommended environmental conditions or operated with unauthorized modifications. Contact an FSE for information on servicing the system.

Contact Us

**SCIEX Support**

- sciex.com/contact-us
- sciex.com/request-support

**Customer Training**

- In North America: NA.CustomerTraining@sciex.com
- In Europe: Europe.CustomerTraining@sciex.com
- Outside the EU and North America, visit sciex.com/education for contact information.
Operational Precautions and Limitations

Online Learning Center

- SCIEXUniversity

CyberSecurity

For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/Documents/brochures/win7-SecurityGuidance.pdf.

Technical Support

SCIEX and its representatives maintain a staff of fully-trained service and technical specialists located throughout the world. They can answer questions about the system or any technical issues that might arise. For more information, visit the SCIEX website at sciex.com.

Documentation Symbols and Conventions

The following symbols and conventions are used throughout the guide.

DANGER! Danger signifies an action which leads to severe injury or death.

WARNING! Warning signifies an action that could cause personal injury if precautions are not followed.

CAUTION: Caution signifies an operation that could cause damage to the system or corruption or loss of data if precautions are not followed.

Note: Note emphasizes significant information in a procedure or description.

Tip! Tip provides useful information that helps apply the techniques and procedures in the text for a specific need and provides shortcuts, but is not essential to the completion of a procedure.
Related Documentation

To find software product documentation, refer to the release notes or software installation guide that comes with the software. Documentation for the hardware products can be found on the Customer Reference DVD that comes with the system or component.

For the latest versions of the documentation, visit the SCIEX website at sciex.com.
Principles of Operation

The SCIEX Triple Quad™ 3500 system is designed for the qualitative and quantitative analysis of chemical species. This section includes information about the mass spectrometer and the Analyst® software. Refer to the ion source Operator Guide for an overview of the ion source.

For information on the computer and software, refer to the Software Installation Guide for the Analyst® software.

WARNING! Lifting Hazard. Do not move the system. Risk of personal injury or system damage. If the system must be moved, then contact a Field Service Employee (FSE).

System Overview

WARNING! Lifting Hazard. Make sure that at least six people are available to lift the mass spectrometer. Follow established safe lifting procedures. Refer to the Site Planning Guide for the weights of system components.

This system is intended for the qualitative and quantitative analysis of chemical species.

The SCIEX Triple Quad™ 3500 system includes the following components:

- A SCIEX Triple Quad™ 3500 mass spectrometer with a roughing pump and a source of compressed air and nitrogen
- Turbo V™ ion source that uses either the TurbolonSpray® probe or the atmospheric pressure chemical ionization (APCI) probe. Refer to the Turbo V™ Ion Source Operator Guide.
- SCIEX-supplied computer and monitor with the Analyst® software for instrument optimization, acquisition method development, processing, and data acquisition. For computer specifications and requirements, refer to the Analyst® Software Installation Guide.
Hardware Overview

Figure 2-1 Front View

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Refer to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Panel symbols</td>
<td>Panel Symbols on page 21.</td>
</tr>
<tr>
<td>2</td>
<td>Syringe pump</td>
<td>Adjust the Integrated Syringe Pump Position on page 46</td>
</tr>
<tr>
<td>3</td>
<td>Ion source</td>
<td>Turbo V™ Ion Source Operator Guide, available from the ion source documentation DVD, or from the SCIEX Web site, at sciex.com</td>
</tr>
<tr>
<td>4</td>
<td>Diverter valve</td>
<td>Plumb the Diverter Valve on page 50.</td>
</tr>
</tbody>
</table>

Panel Symbols

*Table 2-1* describes the mass spectrometer status LEDs.
Principles of Operation

Table 2-1 Panel Symbols

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Power" /></td>
<td>Green</td>
<td>Power</td>
<td>Lit when the system is powered up.</td>
</tr>
<tr>
<td><img src="image" alt="Vacuum" /></td>
<td>Green</td>
<td>Vacuum</td>
<td>Lit when the correct vacuum level has been achieved. Flashing if the vacuum is not at the correct level (during pump down and venting).</td>
</tr>
<tr>
<td><img src="image" alt="Ready" /></td>
<td>Green</td>
<td>Ready</td>
<td>Lit when the system is in the Ready state. The system must be in the Ready state to operate.</td>
</tr>
<tr>
<td><img src="image" alt="Scanning" /></td>
<td>Blue</td>
<td>Scanning</td>
<td>Flashing when the system is acquiring data.</td>
</tr>
<tr>
<td><img src="image" alt="Fault" /></td>
<td>Red</td>
<td>Fault</td>
<td>Lit when the system encounters a system fault.</td>
</tr>
</tbody>
</table>

After the system is turned on, all of the LEDs illuminate. The power LED remains lit. The other LEDs flash for two seconds and then turn off. The vacuum LED starts flashing. After the correct vacuum level is achieved this LED remains lit.

Connections

Figure 2-2 shows the location of the mass spectrometer connections, including the locations of the **RESET** and **VENT** buttons and the mass spectrometer convenience switch.
**Figure 2-2 Back and Side Views**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Primary Materials</th>
<th>For more information...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Roughing pump vacuum connection</td>
<td>Aluminum (hose fitting), zinc-plated steel (hose clamp)</td>
<td>Contact an FSE.</td>
</tr>
<tr>
<td>2</td>
<td>Air supply (Gas 1/Gas 2)</td>
<td>Plastic</td>
<td>Refer to the <em>Site Planning Guide</em>. Gas tubing from the Gas 1/Gas 2 supply connects to this port.</td>
</tr>
<tr>
<td>3</td>
<td>Source exhaust supply</td>
<td>Stainless steel</td>
<td>Refer to the <em>Site Planning Guide</em>. Gas tubing from the source exhaust gas supply connects to this port.</td>
</tr>
<tr>
<td>4</td>
<td>Source communication connection</td>
<td>Aluminum</td>
<td>Contact an FSE.</td>
</tr>
<tr>
<td>5</td>
<td>RESET button</td>
<td>Plastic</td>
<td>Refer to <a href="#">Reset the Mass Spectrometer</a> on page 45.</td>
</tr>
</tbody>
</table>

---

**SCIEX Triple Quad™ 3500 Instrument System User Guide**
**RUO-IDV-05-6830-A**

**Principles of Operation**
### Theory of Operation—Hardware

Mass spectrometry measures the mass-to-charge ratio of ions to identify unknown compounds, to quantify known compounds, and to provide information about the structural and chemical properties of molecules.

The mass spectrometer has a series of quadrupole filters that transmit ions according to their mass-to-charge \((m/z)\) ratio. The first quadrupole in this series is the QJet<sup>®</sup> ion guide located between the orifice plate and the Q0 region. The QJet<sup>®</sup> ion guide does not filter ions, but focuses them before they enter the Q0 region. By prefocusing the larger ion flux created by the wider orifice, the QJet<sup>®</sup> ion guide increases system sensitivity and improves the signal-to-noise ratio. In the Q0 region, the ions are again focused before passing into the Q1 quadrupole.
Figure 2-3 Ion Path

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Orifice plate</td>
</tr>
<tr>
<td>2</td>
<td>QJet ion guide</td>
</tr>
<tr>
<td>3</td>
<td>Q0 region</td>
</tr>
<tr>
<td>4</td>
<td>Q1 quadrupole</td>
</tr>
<tr>
<td>5</td>
<td>Q2 collision cell</td>
</tr>
<tr>
<td>6</td>
<td>Q3 quadrupole</td>
</tr>
<tr>
<td>7</td>
<td>Detector</td>
</tr>
</tbody>
</table>

The Q1 quadrupole is a filtering quadrupole that sorts the ions before they enter the Q2 collision cell. The Q2 collision cell is where the internal energy of an ion is increased through collisions with gas molecules to the point that molecular bonds break creating product ions. This technique allows users to design experiments that measure the \( m/z \) of product ions to determine the composition of the parent ions.

After passing through the Q2 collision cell, the ions enter the Q3 quadrupole for additional filtering, and then they enter the detector. In the detector, the ions create a current that is converted into a voltage pulse. The voltage pulses leaving the detector are directly proportional to the quantity of ions entering the detector. The system monitors these voltage pulses and then converts the information into a signal. The signal represents the ion intensity for a particular \( m/z \) value and the system shows this information as a mass spectrum.

Data Handling

The Analyst® software requires a computer running the Windows 7 (32- or 64-bit) operating system or the Windows 10 (64-bit) operating system. The computer and the associated system software work with the system controller and the associated firmware to control the system and data acquisition. During system operation, the acquired...
data is sent to the Analyst® software where it can be shown as either full mass spectra, intensity of single or multiple ions over time, or total ion current over time.

**Analyst® Software Overview**

The Analyst® software works with the mass spectrometer and the liquid chromatography (LC) system and the associated firmware to control the system and data acquisition. During system operation, the acquired data is sent to the Analyst® software where it can be shown as full mass spectra, intensity of single or multiple ions over time, or total ion count over time.

**Different Data Views**

The following figures show examples of two types of data views: total ion chromatogram (TIC) and extracted ion chromatogram (XIC).

**TIC**: The plot of the total ion current as a function of time.

**Figure 2-4 Example TIC**

![Example TIC](image)

**XIC**: An ion chromatogram created by taking intensity values at a single, discrete mass value or a mass range, from a series of mass spectral scans. It indicates the behavior of a given mass or mass range as a function of time.
The working parameters are the set of instrument parameters currently being used.

- Source and gas parameters: These parameters can change depending on the ion source used.
- Compound parameters: These parameters consist mostly of voltages in the ion path. Optimal values for compound-dependent parameters vary depending on the compound being analyzed.
- Resolution parameters: These parameters affect the resolution and calibration.
- Detector parameters: These parameters affect the detector.

The following figure shows the location of the parameters on the ion optics path.
Figure 2-6 Ion Optics Path and Parameters

<table>
<thead>
<tr>
<th>Location</th>
<th>Parameter Type</th>
<th>Use</th>
<th>Scan Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>IonSpray Voltage (IS)</td>
<td>The IS parameter controls the voltage applied to the electrode in the TurbolonSpray® probe that ionizes the sample in the ion source. The parameter depends on the polarity and it affects the spray stability and the sensitivity. This parameter is also used with the NanoSpray® ion source. Refer to the applicable ion source Operator Guide. The parameter can be compound-dependent and should be optimized for each compound.</td>
<td>All</td>
</tr>
<tr>
<td>1</td>
<td>Nebulizer Current (NC)</td>
<td>The NC parameter controls the current applied to the corona discharge needle in the APCI probe, used in the Turbo V™ or DuoSpray™ ion source. The discharge ionizes solvent molecules, which in turn ionize the sample molecules.</td>
<td>All</td>
</tr>
</tbody>
</table>

RUO-IDV-05-6830-A
The IHT parameter controls the temperature of the NanoSpray® interface heater and is only available if the NanoSpray® ion source and interface are installed. The optimal heater temperature depends on the type of sample being analyzed and the solvent used. If the heater temperature is too high, the signal degrades. Typically, heater temperatures are in the 130 °C to 180 °C range. The maximum heater temperature that can be set is 250 °C, but this is too high for most applications.

The GS1 parameter controls the nebulizer gas for both the TurbolonSpray® and APCI probes. The GS1 parameter controls the nebulizer gas for the TurbolonSpray® probe.

The GS2 parameter controls the heater gas for the TurbolonSpray® probe. The GS2 parameter controls the heater gas for the TurbolonSpray® probe and the nebulizer gas for the APCI probe.

The TEM parameter controls the temperature of the heater gas for the TurbolonSpray® probe or the temperature of the APCI probe.

The CUR parameter controls the gas flow of the Curtain Gas™ interface. The Curtain Gas™ interface is located between the curtain plate and the orifice. It prevents the contamination of the ion optics.

The sdp parameter controls the selection of the DuoSpray™ ion source probes: TurbolonSpray® or APCI probe.
## Principles of Operation

<table>
<thead>
<tr>
<th>Location</th>
<th>Parameter</th>
<th>Parameter Type</th>
<th>Use</th>
<th>Scan Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Declustering Potential (DP)</td>
<td>Compound</td>
<td>The DP parameter controls the voltage on the orifice, which controls the ability to decluster ions between the orifice and the QJet® ion guide. It is used to minimize the solvent clusters that might remain on the sample ions after they enter the vacuum chamber, and, if required, to fragment ions. The higher the voltage, the higher the energy imparted to the ions. If the DP parameter is too high, then unwanted fragmentation might occur. Use the preset value and optimize for the compound.</td>
<td>All</td>
</tr>
<tr>
<td>2</td>
<td>Entrance Potential (EP)</td>
<td>Compound</td>
<td>The EP parameter controls the potential difference between the voltage on Q0 and ground. The entrance potential guides and focuses the ions through the high-pressure on the Q0 region. Use the preset value.</td>
<td>All</td>
</tr>
<tr>
<td>3</td>
<td>CAD Gas</td>
<td>Source and gas</td>
<td>The CAD parameter controls the pressure of the CAD gas in the collision cell during Q3, MS/MS. For Q3 scans, the collision gas helps to focus the ions as they pass through the Q2 collision cell. The preset value for the CAD parameter is in fixed mode. For MS/MS scan types, the CAD gas helps to fragment the precursor ions. When the precursor ions collide with the collision gas, they dissociate to form product ions. Use the preset value and optimize for the compound.</td>
<td>Q3 MI, Q3 MS, MRM, Prec, NL</td>
</tr>
</tbody>
</table>
The CE parameter controls the potential difference between the Q0 region and the Q2 collision cell. It is used only in MS/MS scan types. This parameter is the amount of energy that the precursor ions receive as they are accelerated into the Q2 collision cell, where they collide with gas molecules and fragment. Use the preset value and optimize for the compound.

The CXP parameter is only used in Q3 and MS/MS scan types. This parameter transmits the ions into the Q3 quadrupole. Use the preset value and optimize for the compound.

The CEM parameter controls the voltage applied to the detector. The voltage controls the detector response.

---

**Theory of Operation—Analyst® Software**

**Quantitation**

The goal of quantitation in LC-MS/MS is to accurately determine the concentration of a compound in an unknown sample. The MRM scan type is primarily used for quantitative analysis in a triple quadrupole or QTRAP® mass spectrometer. In an MRM scan, the ability to define the precursor ion and characteristic product ion enables the creation a pair that is highly specific of the analyte. The MRM transition (pair) coupled with the retention time associated with the analyte during liquid chromatography provides the specificity required for quantitation.

Quantitation is accomplished through the use of validated MRM LC-MS/MS acquisition methods, acquisition of calibration standard curves, and the subsequent integration of the peaks associated with the compounds of interest. The calibration curve relationship between signal response and concentration is used to determine the quantity of a particular analyte in an unknown sample.

**Integration**

In LC-MS/MS data, integration refers to obtaining the area under a curve for the peak associated with a specific compound. Through the development of a method which specifies the transitions, expected retention times, internal standards, integration, and regression parameters, the software is able to automatically integrate peaks for a given set of samples.
About Results Tables

Results tables summarize the calculated concentration of an analyte in each unknown sample based on the calibration curve. Results tables also include the calibration curves as well as statistics for the results. The user can customize the results tables and view the results tables in layouts.

The data from a results tables can be exported to a txt file for use in other applications, such as Microsoft Excel. The user can also export data in the table or just the data in the visible columns.

Calibration Curves

A calibration curve, also know as a standard concentration curve, is a method for determining the concentration of a substance in an unknown sample by comparing the unknown sample to a set of standard samples of known concentration. The calibration curve is a plot of how the instrument responds (the analytical signal) to changes in the concentration of the analyte (the substance to be measured). The operator prepares a series of standards across a range of concentrations near the expected concentration of the analyte in the unknown sample.

Calibration standards are used to build calibration curves. Incorrect readings or missing readings on some of the calibration samples might indicate issues with the analytical run. Follow acceptable methods found in literature and regulatory agency guidances to create a calibration curve. Examples of good practice in the preparation of calibration curves include:

- Preparing calibration standards in blank matrix in which the analyte is to be measured.
- Generating a calibration curve for each analyte to be measured.
- Making sure of the coverage of the expected concentration range of the analyte, including typical and atypical specimens.
- Using six to eight standards to generate the curve.

This is not a comprehensive list and other guidances should be used in determining the best practice in developing a calibration curve for the laboratory.

Note: In some analytical runs, single-point calibration standards are used. Single-point calibrations are performed using a matrix blank sample and a single standard concentration. The relationship between instrument response and analyte concentration is determined by the line created by these two points. Both the acquisition and quantitation methods should be validated before being accepted for their intended use.

Regression

The area of the analyte peaks in the calibration curve standards is plotted against the known concentrations. Subsequently, a line is fitted to the points. This regression line is used to calculate the concentration of the unknown samples.

- Linear \( y = mx + b \)
- Linear through Zero \( y = mx \)
- Quadratic \( y = a^2 + bx + c \)
As well, it is possible to add different types of weighting for the regression, including:

- $1/x$
- $1/x^2$
- $1/y$
- $1/y^2$
Table 3-1 Instrument Setup Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>To do this...</th>
<th>Find the information in...</th>
<th>What does it do?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a hardware profile.</td>
<td>Create a Hardware Profile on page 54</td>
<td>Each hardware profile must include a mass spectrometer and other devices, such as an LC system. Only devices included in the active hardware profile can be used when creating acquisition methods.</td>
</tr>
<tr>
<td>2</td>
<td>Create projects to store data.</td>
<td>Create Projects and Subprojects on page 61</td>
<td>Using projects and subprojects facilitates data management and makes comparison of results easier.</td>
</tr>
<tr>
<td>3</td>
<td>Optimize the mass spectrometer.</td>
<td>Verify Instrument Performance on page 65</td>
<td>This is the process of optimizing the resolution and mass spectrometer parameters, and calibrating the mass spectrometer to obtain the best sensitivity and performance from the system.</td>
</tr>
</tbody>
</table>
Table 3-2 Sample Acquisition Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>To do this...</th>
<th>Find the information in....</th>
<th>What does it do?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create projects to store data.</td>
<td>Create Projects and Subprojects on page 61</td>
<td>Using projects and subprojects facilitates data management and makes comparison of results easier.</td>
</tr>
<tr>
<td>2</td>
<td>Create an acquisition method.</td>
<td>Operating Instructions — Acquisition Methods on page 84</td>
<td>To analyze samples, create an acquisition method for the mass spectrometer and any LC devices. An acquisition method indicates which peripheral devices to use, when to use them to acquire data, and the associated parameters.</td>
</tr>
<tr>
<td>3</td>
<td>Create and submit a batch.</td>
<td>Add Sets and Samples to a Batch on page 135 and Submit a Sample or Set of Samples on page 139</td>
<td>After creating an acquisition method, run samples by creating an acquisition batch and submitting the batch to the acquisition queue.</td>
</tr>
<tr>
<td>4</td>
<td>Run samples to acquire data.</td>
<td>Acquire Data on page 139</td>
<td>Running samples involves managing the acquisition queue and monitoring instrument and device status. To submit samples and acquire data, use the Queue Manager. The Queue Manager shows queue, batch, and sample status, and facilitates management of samples and batches in the queue.</td>
</tr>
</tbody>
</table>
Table 3-2 Sample Acquisition Workflow (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>To do this...</th>
<th>Find the information in....</th>
<th>What does it do?</th>
</tr>
</thead>
</table>
| 5    | Analyze data in Explore mode. **—OR—**  
Step 6—Analyze quantitative data. | Operating Instructions — Analyze and Explore Data on page 110 | In Explore mode, many tools are available for viewing and processing the acquired data. Graphs can be customized with peak labels and captions, contour plots can be shown, and spectra can be saved in the library. |
| 6    | Analyze quantitative data. | Operating Instructions — Analyze and Process Quantitative Data on page 90 | Use the various quantitative method creation tools in Quantitate mode to analyze the acquired data and build a quantitative method to generate a Results Table. Use the Results Table to manually review all of the peaks for each analyte and internal standard within a batch and to view calibration curves, sample statistics, and metric plots. |
### Table 3-3 Example Routine Analysis Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>To do this...</th>
<th>Find the information in....</th>
<th>What does it do?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Activate a hardware profile applicable to the method.</td>
<td>Create a Hardware Profile on page 54</td>
<td>Each hardware profile must include a mass spectrometer and other devices, such as an LC system. Only devices included in the active hardware profile can be used when creating acquisition methods.</td>
</tr>
<tr>
<td>2</td>
<td>Create projects to store data.</td>
<td>Create Projects and Subprojects on page 61</td>
<td>Using projects and subprojects facilitates data management and makes comparison of results easier.</td>
</tr>
<tr>
<td>3</td>
<td>Create and submit a batch.</td>
<td>Add Sets and Samples to a Batch on page 135 and Submit a Sample or Set of Samples on page 139</td>
<td>After creating an acquisition method, run samples by creating an acquisition batch and submitting the batch to the acquisition queue.</td>
</tr>
<tr>
<td>4</td>
<td>Equilibrate the system.</td>
<td>Equilibrate the System on page 138</td>
<td>Equilibrate the system prior to starting data acquisition. A system that is not equilibrated can result in poor data.</td>
</tr>
<tr>
<td>5</td>
<td>Run samples to acquire data.</td>
<td>Acquire Data on page 139</td>
<td>Running samples involves managing the acquisition queue and monitoring instrument and device status. To submit samples and acquire data, use the Queue Manager. The Queue Manager shows queue, batch, and sample status, and facilitates management of samples and batches in the queue.</td>
</tr>
</tbody>
</table>
### Table 3-3 Example Routine Analysis Workflow (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>To do this...</th>
<th>Find the information in....</th>
<th>What does it do?</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Analyze data in Explore mode (optional).</td>
<td><strong>Operating Instructions — Analyze and Explore Data on page 110</strong></td>
<td>In Explore mode, many tools are available for viewing and processing the acquired data. Graphs can be customized with peak labels and captions, contour plots can be shown, and spectra can be saved in the library.</td>
</tr>
</tbody>
</table>

- For quantitative analysis using the MultiQuant™ software follow steps 7 to 8. The MultiQuant™ software is recommended for larger data sets.
- For quantitative analysis using the Analyst® software follow steps 9 to 10a
- For qualitative analysis using the Analyst® software follow steps 9 to 10b.

| 7    | Analyze quantitative data in the MultiQuant™ software. | **MultiQuant™ Software Reference Guide**: Chapter 7, 8, 10, 11, 12, 13, 14 | Generate and use a Results Table to manually review all of the peaks for each analyte and internal standard within a batch and to view calibration curves, sample statistics, and metric plots. |

| 8    | Create a report in the MultiQuant™ software. | **MultiQuant™ Software Reference Guide**: Appendix C | Generate a report using the provided report templates for the generated and reviewed results. |

| 9    | Analyze qualitative (or quantitative) data in the Analyst® software. | **Operating Instructions — Analyze and Process Quantitative Data on page 90** | Generate a Results Table to manually review all of the peaks for each analyte and internal standard within a batch. For quantitative analysis, also review calibration curves, sample statistics, and metric plots. |
Table 3-3 Example Routine Analysis Workflow (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>To do this...</th>
<th>Find the information in....</th>
<th>What does it do?</th>
</tr>
</thead>
<tbody>
<tr>
<td>10a</td>
<td>Create a report in the Analyst Reporter.</td>
<td>Generate Reports</td>
<td>Generate a report using the provided report templates for the generated and reviewed results. For reports specific to qualitative analysis, use the set of report templates labeled with library searching.</td>
</tr>
<tr>
<td>10b</td>
<td>Select a library and then create a report using the Analyst Reporter.</td>
<td>Generate Reports</td>
<td>Select the appropriate MS/MS spectra library for the results and generate a report using the provided report templates labeled as library search for the generated and reviewed results. For reports specific to qualitative analysis, use the set of report templates labeled with library search.</td>
</tr>
</tbody>
</table>

Table 3-4 Example Method Developer Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>To do this...</th>
<th>Find the information in....</th>
<th>What does it do?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a hardware profile.</td>
<td>Create a Hardware Profile on page 54</td>
<td>Each hardware profile must include a mass spectrometer and other devices, such as an LC system. Only devices included in the active hardware profile can be used when creating acquisition methods.</td>
</tr>
<tr>
<td>2</td>
<td>Create projects to store data.</td>
<td>Create Projects and Subprojects on page 61</td>
<td>Using projects and subprojects facilitates data management and makes comparison of results easier.</td>
</tr>
<tr>
<td>Step</td>
<td>To do this...</td>
<td>Find the information in....</td>
<td>What does it do?</td>
</tr>
<tr>
<td>------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 3    | Optimize the compound automatically  
  - Or - Step 4 Optimize the  
    compound manually.               | Automatic Optimization on page 68                                                             | The software automatically optimizes the compound and mass spectrometer parameters for the compounds of interest.                               |
| 4    | Optimize the compound manually.                                              | Operating Instructions — Manual Compound Optimization on page 163                            | The user manually optimizes the compound and mass spectrometer parameters for the compounds of interest. Manual optimization provides more experienced users with greater control during the optimization process. |
| 5    | Create an acquisition method.                                                 | Operating Instructions — Acquisition Methods on page 84                                     | To analyze samples, create an acquisition method for the mass spectrometer and any LC devices. An acquisition method indicates which peripheral devices to use, when to use them to acquire data, and the associated parameters. |
| 6    | Create and submit a batch.                                                    | Add Sets and Samples to a Batch on page 135 and Submit a Sample or Set of Samples on page 139 | After creating an acquisition method, run samples by creating an acquisition batch and submitting the batch to the acquisition queue.            |
| 7    | Equilibrate the system.                                                       | Equilibrate the System on page 138                                                            | Equilibrate the system prior to starting data acquisition. A system that is not equilibrated can result in poor data.                         |
### Table 3-4 Example Method Developer Workflow (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>To do this...</th>
<th>Find the information in....</th>
<th>What does it do?</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Run samples to acquire data.</td>
<td>Acquire Data on page 139</td>
<td>Running samples involves managing the acquisition queue and monitoring instrument and device status. To submit samples and acquire data, use the Queue Manager. The Queue Manager shows queue, batch, and sample status, and facilitates management of samples and batches in the queue.</td>
</tr>
<tr>
<td>9</td>
<td>Analyze data in Explore mode (optional).</td>
<td>Operating Instructions — Analyze and Explore Data on page 110</td>
<td>In Explore mode, many tools are available for viewing and processing the acquired data. Graphs can be customized with peak labels and captions, contour plots can be shown, and spectra can be saved in the library.</td>
</tr>
</tbody>
</table>

- For quantitative analysis using the MultiQuant™ software follow steps 10 to 12. The MultiQuant™ software is recommended for larger data sets.
- For quantitative analysis using the Analyst® software follow steps 13 to 15.
- For qualitative analysis, contact Support.

| 10   | Create a quantitative method in the MultiQuant™ software. | MultiQuant™ Software Reference Guide: Quantitation Method Editor | Use the various quantitative method creation tools in the software to analyze the acquired data and build a quantitative method to generate a Results Table. |
## Table 3-4 Example Method Developer Workflow (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>To do this...</th>
<th>Find the information in....</th>
<th>What does it do?</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Analyze quantitative data in MultiQuant™ software.</td>
<td><em>MultiQuant™ Software Reference Guide</em>: Chapter 7, 8, 10, 11, 12, 13, 14</td>
<td>Generate and use a Results Table to manually review all of the peaks for each analyte and internal standard within a batch and to view calibration curves, sample statistics, and metric plots.</td>
</tr>
<tr>
<td>12</td>
<td>Create a report in MultiQuant™ software.</td>
<td><em>MultiQuant™ Software Reference Guide</em>: Appendix C</td>
<td>Generate a report using the provided report templates for the generated and reviewed results.</td>
</tr>
<tr>
<td>13</td>
<td>Create a quantitative method in the Analyst® software.</td>
<td><em>MultiQuant™ Software Reference Guide</em>: Quantitation Method Editor</td>
<td>Use the various quantitative method creation tools in the software to analyze the acquired data and build a quantitative method to generate a Results Table.</td>
</tr>
<tr>
<td>14</td>
<td>Analyze qualitative (or quantitative) data in Analyst® software.</td>
<td><em>Operating Instructions — Analyze and Process Quantitative Data on page 90</em></td>
<td>Generate a Results Table to manually review all of the peaks for each analyte and internal standard within a batch. For quantitative analysis, also review calibration curves, sample statistics, and metric plots.</td>
</tr>
<tr>
<td>14</td>
<td>Create a report in the Analyst Reporter.</td>
<td><em>Generate Reports</em></td>
<td>Generate a report using the provided report templates for the generated and reviewed results. For reports specific to qualitative analysis, use the set of report templates labeled with library searching.</td>
</tr>
</tbody>
</table>
**Operating Instructions—Hardware**

**WARNING!** Personal Injury Hazard. Follow the instructions in the documentation when using the system. The protection provided by the equipment might be impaired if the equipment is used in a manner not specified by SCIEX.

**Start Up the System**

**WARNING!** Electrical Shock Hazard. Make sure that the system can be disconnected from the mains supply outlet in an emergency. Do not block the mains supply outlet.

**WARNING!** Lifting Hazard. Do not move the system. Risk of personal injury or system damage. If the system must be moved, then contact a Field Service Employee (FSE).

**Note:** Before operating the instrument, read the safety information in *Operational Precautions and Limitations* on page 8.
Prerequisites

- The site requirements specified in the *Site Planning Guide* are met. The *Site Planning Guide* includes information on the mains supply and connections, compressed air, nitrogen, roughing pump, ventilation, exhaust, and site clearance requirements. Contact us for a copy of the *Site Planning Guide*, if required. For contact information, go to sciex.com/contact-us.

- The source exhaust gas, compressed air, and nitrogen gases are connected to the mass spectrometer.

- The 4 L source exhaust drain bottle is connected to the exhaust waste connection on the back of the mass spectrometer and to the laboratory ventilation system.

- The source exhaust hoses are securely clamped at the mass spectrometer, drain bottle, and ventilation connections.

- The mass spectrometer convenience switch is turned off and the mains supply cable is plugged into the mass spectrometer.

- The mass spectrometer and roughing pump mains supply cables are plugged into the 200 VAC to 240 VAC mains supply.

- The Ethernet cable is connected to both the mass spectrometer and the computer.

1. Turn on the roughing pump.

   The On/Off switch is beside the mains supply input connection on the roughing pump.

   **Figure 4-1 Roughing Pump—On/Off Switch**

2. Wait five minutes, and then turn on the mass spectrometer convenience switch.

3. Turn on the computer.

4. Open the Analyst® software.
Reset the Mass Spectrometer

1. Stop any ongoing scans and then turn off sample flow to the mass spectrometer.
2. In the Analyst® software, deactivate the hardware profile, if it is active.
3. Press and hold the Reset button for five seconds.

A click is heard when the relay activates. After approximately three minutes, the mass spectrometer reaches operating pressure.

Shut Down and Vent the System

Some procedures require that the system be shut down. Others require that it also be vented. Follow these steps to shut down and, if required, vent the system.

**Note:** If the input gas supply must be disconnected, then relieve the pressure in the gas lines before disconnecting it.

**Tip!** If the mass spectrometer will not be used for a length of time, then leave it in Standby mode with the ion source in place. If the mass spectrometer must be shut down, then follow these instructions. Do not turn off the roughing pump until after the turbo pumps have spun down.

1. Complete or stop any ongoing scans.

**CAUTION:** Potential System Damage. Turn off the sample flow before shutting down the system.

2. Turn off the sample flow to the system.
3. In the Analyst® software, deactivate the hardware profile, if it is active.
4. Close the software.
5. (If required) Follow these steps to vent the system:

**Note:** Vent the system before performing a full cleaning of the vacuum interface, before cleaning the Q0 region, and before replacing the roughing pump oil. For more information contact the Qualified Maintenance Person (QMP) or FSE.
a. Press and hold the **Vent** button for three seconds.

   The Vacuum LED begins flashing quickly (more quickly than during pump down). The turbo pump spins down gradually.

b. Allow the system to vent for 15 minutes and then turn off the roughing pump.

6. Turn off the mass spectrometer convenience switch.

7. Disconnect the mass spectrometer mains supply cable from the mains supply outlet.

8. (If venting the system) Disconnect the roughing pump mains supply cable from the mains supply outlet.

---

**Adjust the Integrated Syringe Pump Position**

---

**WARNING! Puncture Hazard.** Take care when handling the syringe. The tip of the syringe is extremely sharp.

---

**WARNING! Puncture Hazard.** Make sure that the syringe is seated properly in the syringe pump and that the automatic syringe pump stop is adjusted properly to avoid damaging or breaking the glass syringe. If the syringe breaks, follow established safety procedures for sharps disposal.

---

1. Press the **Release** button on the right side of the syringe pump to lower the base and then insert the syringe. Refer to **Figure 4-2**.
2. Make sure that the end of the syringe is flush against the base and that the shaft of the syringe rests in the cutout.

3. Adjust the post so that it triggers the automatic syringe stop before the syringe plunger hits the bottom of the glass syringe. Refer to Figure 4-3.
Automatic syringe stop. After the post hits the automatic syringe stop, the syringe pump stops.

1. Post. Adjust the height to prevent the syringe plunger from hitting the syringe during sample infusion.

2. Post lock screw. Tighten the screw after the height of the post is adjusted.

3. Turn the side screws as shown in Figure 4-4 to secure the syringe.
5. Make sure that the mass spectrometer and integrated syringe pump are activated in the software.

**Note:** For subsequent manual use, on the mass spectrometer, press the button on the right side of the syringe pump to start the flow. Refer to Figure 4-5. The LED beside the button flashes when the syringe pump is in use. The syringe pump flow can also be controlled automatically by the Analyst® software.
6. In the Analyst® software, on the Navigation bar, double-click **Manual Tuning**.
7. Click **Start Syringe**.
8. To stop the syringe pump, click **Stop Syringe**.

## Plumb the Diverter Valve

The integrated diverter valve, which is located next to the ion source, can be plumbed in injector mode or diverter mode. To configure the valve, access the **Configuration** tab and then make sure that the **Use integrated injector/diverter valve** check box is selected. Refer to **Add Devices to a Hardware Profile** on page 58.

**CAUTION:** Potential Wrong Result. Do not press the diverter valve button during a run. Doing so might result in incorrect data.
Plumb the Diverter Valve in Injector Mode

When the valve is in Position A, the sample flows through the external loop. When the valve switches to Position B, the sample is injected.

- Plumb the valve for injector mode.

Figure 4-6 Diverter Valve—Injector Mode Position A

Figure 4-7 Diverter Valve—Injector Mode Position B
### Plumb the Diverter Valve in Diverter Mode

When the valve is in Position A, the flow goes to waste. When the valve switches to Position B, the flow goes to the mass spectrometer.

- Plumb the valve for diverter mode.

---

**Figure 4-8 Diverter Valve—Diverter Mode Position A**
Figure 4-9 Diverter Valve—Diverter Mode Position B

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>To mass spectrometer</td>
</tr>
<tr>
<td>2</td>
<td>From column</td>
</tr>
<tr>
<td>3</td>
<td>Waste out</td>
</tr>
</tbody>
</table>
Hardware Profiles

A hardware profile tells the software how the mass spectrometer and the devices are configured and connected to the computer. Multiple hardware profiles can be set up, but only one profile can be active at any time.

When a hardware profile is created in the Hardware Configuration Editor, the peripheral devices must be configured so that the software can communicate with them. Configuring the peripheral devices requires two procedures: setting up the physical connections and configuring the software to communicate with the peripheral devices.

When the software is installed, the driver required for each peripheral device is also installed. After the peripheral devices are physically connected to the computer, set up the appropriate configuration information.

Each hardware profile must include a mass spectrometer. Before creating an acquisition method, make sure that all devices to be used in the method are included in the hardware profile, including the syringe pump. The devices configured in the active hardware profile and selected in the Add/Remove Device Method dialog are shown as icons in the Acquisition method pane. Only peripheral devices included in the active hardware profile can be used when creating acquisition methods.

Each hardware profile must include a mass spectrometer. Before creating an acquisition method, make sure that all devices to be used in the method are included in the hardware profile. The devices configured in the active hardware profile and selected in the Add/Remove Device Method dialog are shown as icons in the Acquisition method pane. Only peripheral devices included in the active hardware profile can be used when creating acquisition methods.

For information about setting up the physical connections to the devices, refer to the Peripheral Devices Setup Guide. For a list of the supported devices, refer to the Software Installation Guide for the Analyst® software.

Create a Hardware Profile

The user can create multiple hardware profiles, but only one profile can be active at any time.

1. On the Navigation bar, under Configure, double-click Hardware Configuration.
2. In the Hardware Configuration Editor dialog, click **New Profile**.
3. Type a name in the **Profile Name** field.
4. Click **Add Device**.
In the Available Devices dialog, in the **Device Type** field, **Mass Spectrometer** is the preset value.

5. In the **Devices** list, select the appropriate mass spectrometer and then click **OK** to return to the Create New Hardware Profile dialog.

6. Click **Setup Device**.

7. (Optional) To configure mass spectrometers that use the integrated syringe pump, on the **Configuration** tab, select the **Use integrated syringe pump** check box.

8. (Optional) To configure the mass spectrometer for the diverter valve, on the **Configuration** tab, select **Use integrated injector/diverter valve**.

9. (Optional) Select additional features on the **Configuration** and **Communication** tabs as required.

10. Click **OK** to return to the Create New Hardware Profile dialog.

11. Click **Add Device** and then add and set up each device that is used with the mass spectrometer. Refer to **Add Devices to a Hardware Profile on page 58**.

12. Click **OK** in the **Create New Hardware Profile** dialog.

13. Click the hardware profile to be activated in the **Hardware Configuration Editor**.

14. Click **Activate Profile**.

   The check mark turns green. If a red x is shown, then there is an issue with the hardware profile activation.
Tip! A hardware profile need not be deactivated before another is activated. Click a hardware profile and then click **Activate Profile**. The other profile is deactivated automatically.

15. Click **Close**.

## Add Devices to a Hardware Profile

Devices must be configured to enable the software to communicate with them. When the software is installed, the driver required for each device is also installed. After the devices are physically connected to the computer, configure them.

Only the devices configured in the active hardware profile and selected in the Add/Remove Device Method dialog are shown as icons in the Acquisition Method Browser pane.

1. Open the Hardware Configuration Editor.
2. In the **Hardware Profiles** list, deactivate the hardware profile.
3. Click **Edit Profile**.
4. Click **Add Device**.

**Note:** Remember to add a mass spectrometer. For more information, refer to Create a Hardware Profile on page 54.

5. In the Available Devices dialog, in the **Device Type** list, select the device and then click **OK**.
6. Click **OK**.

7. Select the device from the **Devices** list and then click **OK**.

8. Click **Setup Device**.

   A dialog containing configuration values for the device opens.

9. (Optional) On the Communication tab, in the **Alias** field, type a name or other identifier for the device.

   **Note:** For devices using serial communication, make sure that the serial port selected matches the serial port to which the device is physically connected. When the serial expansion cable is used, the number selected in the profile is the number on the cable plus two.

   **Note:** The **Alias** field might also be referred to as the **Name** box and might be found on another tab under **Alias**.

   - If the device uses a **Serial Port** as a communication interface, then in the **COM Port Number** list, select the COM port to which the device is connected.
• If the device uses **Ethernet** as a communication interface, then type the **IP Address** assigned to the device by the administrator or use the corresponding **Host Name** for the address.

• If the device uses **GPIB Board** as a communication interface, then do not change the settings for the GPIB board.

  The rest of the preset values for the device are probably appropriate. Do not change them. For information about the Configuration and Communication tabs, refer to the Help.

10. To restore the device preset values, on the Communication tab, click **Set Defaults**.

11. To save the configuration, click **OK**.

12. Repeat step 4 to step 11 for each device.

13. Click **OK** in the Create New Hardware Profile dialog.

14. To activate the hardware profile, in the Hardware Configuration Editor, click the hardware profile.

15. Click **Activate Profile**.

   The check mark turns green. If a red x is shown, then there is an issue with the hardware profile activation. For more information, refer to Troubleshoot Hardware Profile Activation on page 60.

   **Tip!** An active hardware profile does not have to be deactivated before another one is activated. Click an inactive hardware profile and then click **Activate Profile**. The other profile is deactivated automatically.

16. Click **Close**.

**Troubleshoot Hardware Profile Activation**

If a hardware profile fails to become active, then a dialog opens indicating which device in the profile failed. A device might fail to activate because of communications errors.

1. Read the error message generated. Depending on the message, there might be an issue with a device or how the communication is set up.

2. Verify that the device has power and is turned on.

3. Verify that the COM port or IP address assigned to the device is correct.

   **Tip!** On computers with two built-in serial ports, the first port on the serial port expansion card is usually COM3, even though the cable indicates P1.

4. Verify that the communication settings for the device (for example, dip switch settings) are set correctly and match the settings on the Communication tab.

5. Turn off the device.

6. Wait 10 seconds.
7. Turn on the device.
   Wait until all device power-up activities are complete before trying to activate the hardware profile again. Some devices might require 30 seconds or more to complete the power-up activities.

8. Activate the hardware profile.

9. If the issue persists, then delete the failing profile and create a new one.

10. If the issue still persists, then contact technical support.

Projects and Subprojects

Before beginning an experiment, decide where to store the files related to the experiment. Use projects and subprojects for each experiment to better manage data and compare results. For example, use subprojects to store the results for specific dates.

Create Projects and Subprojects

To use a subproject structure within a project, create the subproject structure when the project is created.

1. Click Tools > Project > Create Project.

   Figure 5-5 Create New Project/Subproject Dialog

2. Type a project name in the Project name field.

   Note: A new subproject cannot be created for a project that was not originally created with a subproject.
Create Subprojects

Subprojects can only be created in a project that has an existing subproject structure.

1. On the Project tool bar, from the Project list, select the project.
2. Click Tools > Project > Create Subproject.
3. In the Subproject name box, type a name for the subproject or use the existing date.
4. Click OK.

Copy Subprojects

A subproject can be copied from another project that has existing subprojects. If the copied subprojects contain folders that also exist in the project folder, then the software uses the project level folders.

1. Click Tools > Project > Copy Subproject.
   
   The Copy Subproject dialog is shown.
2. Click Browse to navigate to the subproject source.
3. Click OK.
4. Select the subproject from the Source Subproject list.
5. Click Browse to navigate to the subproject destination.
6. Type the name in the Target Subproject field.
7. Click OK.
8. Do one of the following:
   
   - To copy all folders and files from the Subproject Source into the Subproject Destination, select the Copy Contents check box.
• To copy only the folders in the same structure into the Subproject Destination, make sure that the Copy Contents check box is cleared.

9. Click Copy.

Switch Between Projects and Subprojects

• On the software tool bar, from the project list, click the required project or subproject.

Figure 5-6 Project List

The project list in this figure shows the API Instrument, Default, and Example folders.

Installed Project Folders

Three project folders are installed with the software: API Instrument, Default, and Example.

API Instrument Folder

The API Instrument folder is unique and very important to the correct functioning of the mass spectrometer. The API Instrument folder contains the information required for tuning and calibrating the mass spectrometer. This information includes parameter settings files, reference files, instrument data files that contain calibration and resolution information, and the acquisition methods used during automatic tuning. The API Instrument folder also contains data files for manual tuning runs that were performed using the Start button rather than the Acquire button. These data files are saved automatically in the API Instrument folder in the Tuning Cache folder and named with the date and time they were created. The Tuning Cache folder is automatically cleared periodically.

Default Folder

The Default folder contains folders that are present in new projects and serves as a template for new projects.

Example Folder

The Example folder contains sample methods and data files. Users can practice working with the Explore or Quantitate modes using the example data files. The example files are sorted into subfolders by mass spectrometer type and application area.
Back Up the API Instrument Folder

Back up the API Instrument folder regularly and after routine maintenance has been performed.

- Copy the API Instrument folder, paste it to a different location, preferably to another computer, and then rename the folder. Use the date and a mass spectrometer reference if there is more than one mass spectrometer when the folder is named. For example, API Instrument_instrument model 3_010107

Recover the API Instrument Folder

Back up the API Instrument folder regularly and after routine maintenance has been performed. To recover the API Instrument folder, do the following:

1. Rename the current API Instrument folder.
2. Copy the backup folder into the Projects folder.
3. Change the name of the backup folder to API Instrument.
Tune and Calibrate

Run the Verify instrument performance option weekly or after the mass spectrometer is cleaned to confirm that the system is working properly. In general, for triple quadrupole systems, calibration and resolution is maintained for three to six months unless the system loses vacuum. For QTRAP® systems, the resolution should also be maintained for three to six months but the system should be calibrated approximately monthly. If the system loses vacuum, then check the calibration and resolution before using the system. For more information about tuning and calibration, refer to the Advanced User Guide and the Manual Tuning Tutorial.

Tip! Perform maintenance tasks regularly to make sure that the mass spectrometer is performing optimally.

<table>
<thead>
<tr>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The spray is stable and the correct tuning solution is being used.</td>
</tr>
<tr>
<td>• A printer is configured.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Required Materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Tuning solutions that are supplied in the Standards Chemical Kit shipped with the system. If required, a new kit can be ordered from SCIEX.</td>
</tr>
<tr>
<td>• 5 mL, 1 mL, and 250 µL serial gas-tight syringes.</td>
</tr>
<tr>
<td>• Red PEEK sample tubing.</td>
</tr>
</tbody>
</table>

Verify Instrument Performance

The following procedure describes how to verify or adjust the performance of the mass spectrometer. For information about using the other instrument performance options, refer to the Help. Refer to Calibration Ions and Solutions.


2. Start the syringe pump and then run a calibration method. Confirm that the Total Ion Chromatogram (TIC) is stable and that the peaks of interest are present in the spectrum.


   The Instrument Optimization dialog opens.

4. Click Verify instrument performance.

5. Click Next.
6. Click **Approved Tuning**.
7. Click **Next**.
8. Select a **Tuning Solution** from the list.

   Depending on the solution selected, different modes are available:
   a. Click a polarity.
   b. (If available) Click **Q1** and **Q3** in the **Quad** section.
   c. (If available) Click the required scan speeds.
   d. (If available) Click the scan speeds in the **LIT** section.
   e. (If available) Click **Excitation** in the **MS/MS/MS** section.

9. Click **Next**.
10. If the **Select a mode** page opens, then select **Automatic**.
11. Click **Next**.
12. Click **GO**.

   The Verifying or Adjusting Performance dialog opens. After the process has completed, the Results Summary opens. For more information, refer to the Help.

13. If applicable depending on the options selected. Change solutions for different scan types and polarities when prompted.

### About the Verifying or Adjusting Performance Dialog

The top left corner shows the part of the instrument that is being tuned.

The Current Spectrum graph shows the spectrum of the current scan, the optimal scan selected by the software, or the scan at the current parameter value when the software results are viewed in interactive mode.

The Instrument Optimization Decision Plots, in the top right graph, dynamically show the intensity versus voltage curves of the parameters that are currently being optimized.

### Results Summary

The Results Summary is a record of any instrument settings changes that were made by the Instrument Optimization wizard.
The Results Summary includes the location of data files and instrument settings backups, as well as step-by-step changes and results during optimization.

The Results Summary also shows a verification report. This report contains a snapshot of the mass spectrum for each relevant mass for the scan modes being verified. The spectrum is labeled with the target mass, where the mass was found, mass shift, peak width, and peak intensity. The spectrum can be used as a visual record of peak shape or scan mode performance. A summary table of results follows the spectra.

The Results Summary is automatically saved in the following path: <drive>:\Analyst Data\Projects\API Instrument\Data\Instrument Optimization\yyyy-mm-dd\results.doc, where yyyy-mm-dd is the date on which the report was created. Users can print the Results Summary or open a previously saved Results Summary.
Users will learn how to:

- Automatically optimize for the analyte using the Compound Optimization wizard.
- Choose between infusion and flow injection analysis (FIA).
- Optimize parameters:
  - If infusion analysis is chosen, then use an infusion method to optimize compound-dependent parameters.
  - If FIA analysis is chosen, then use FIA to optimize compound- and ion source-dependent parameters.

This tutorial uses minoxidil, tolbutamide, reserpine, and rescinnamine as example compounds. Other available compounds can be used, but the methods must be adjusted accordingly.

The user can also optimize compounds manually.

### Prerequisites

- The mass spectrometer is tuned and calibrated.
- (For FIA analysis) An acquisition method template is available.
- (For FIA analysis) An LC pump and an autosampler are connected and configured in the hardware profile.
- If the system has an integrated syringe pump, a syringe pump is configured in the hardware profile.
- All of the required peripheral devices, including the LC components, if needed, are configured in the hardware profile.

### Required Materials

- Four-compound mix (50 ng/mL), consisting of reserpine, minoxidil, tolbutamide, and rescinnamine. The solution can be used for infusion and FIA. The concentration is system-dependent. Use a solution that is 49.9% acetonitrile, with 50% deionized water and 0.1% formic acid as diluent.
- A syringe, preferably a 1.0 mL syringe.
- (For FIA analysis) Mobile phase: 1:1 acetonitrile:water + 2 mM ammonium acetate + 0.1% formic acid.

*Note:* Users can choose a different mobile phase based on the experimental properties of the compound.

- LC pump and autosampler.
- (For FIA Analysis) Autosampler vials.
Table 7-1 Compounds and Molecular Weights

<table>
<thead>
<tr>
<th>Compound</th>
<th>m/z</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minoxidil</td>
<td>210.2</td>
</tr>
<tr>
<td>Tolbutamide</td>
<td>271.3</td>
</tr>
<tr>
<td>Reserpine</td>
<td>609.4</td>
</tr>
<tr>
<td>Rescinnamine</td>
<td>635.4</td>
</tr>
</tbody>
</table>

Table 7-2 Estimates for Starting Concentrations

<table>
<thead>
<tr>
<th>System</th>
<th>Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCIEX Triple Quad™ 3500 system</td>
<td>10 ng/mL</td>
</tr>
</tbody>
</table>

**About Automatic Optimization**

Automatic optimization first checks for the presence of the compounds. The voltages of the various ion path parameters are gradually increased or decreased to determine the maximum signal intensity (Q1 scan) for each ion. A text file is generated and shown during the optimization process. This file records the various experiments performed and the optimal values for each parameter. A file folder containing all the experiments performed is also generated and can be found by opening the data file folder in Explore mode. For each experiment performed, an acquisition method is also generated and saved in the Acquisition Method folder.

During the optimization process, select how the precursor ion and the corresponding product ions are to be chosen.

**Types of Sample Introduction**

**Infusion**

Infusion is the continuous flow of the sample at low flow rates into the ion source using a syringe pump. During the infusion optimization process, the software can select precursor and product ions and optimize for declustering potential, collision energy, and collision cell exit potential. The voltages of the ion path parameters are gradually increased or decreased to determine the maximum signal intensity for the precursor and product ions.

Use infusion optimization to optimize compound-dependent parameters only at much lower flow rates than those used during LC-MS/MS analysis.

**FIA**

FIA is the injection of a sample by the autosampler into the mass spectrometer using LC. During the FIA optimization process, multiple sample injections are performed for various ion source- or compound-dependent parameter types...
Automatic Optimization

that are changed between injections. FIA compound optimization optimizes parameters by performing looped experiments in succession. One compound-dependent parameter is optimized first, followed by the next compound-dependent parameter. FIA optimizes for ion source-dependent parameters by making one injection for each value.

Compound parameters must be narrowed down using at least two more FIA cycles. Use FIA optimization to optimize both compound-dependent and source-dependent parameters using LC at higher flow rates.

Table 7-3 Differences Between Sample Introduction Methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Required Devices</th>
<th>Parameters</th>
<th>Typical Flow Rate Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Infusion</td>
<td>Syringe pump</td>
<td>Compound-dependent</td>
<td>5 µL/min to 25 µL/min</td>
</tr>
<tr>
<td>FIA</td>
<td>LC pump and autosampler</td>
<td>Source- and compound-dependent</td>
<td>25 µL/min to 1000 µL/min</td>
</tr>
</tbody>
</table>

During optimization, a text file is generated and then shown. This file records the various experiments performed and the optimal values for each parameter. A file folder containing all the data files is also generated. For each experiment performed, an acquisition method is also generated and saved in the Acquisition Methods folder.

Automatically Optimize for an Analyte Using Infusion

In this section, users will perform automatic MS/MS optimization using infusion with a known precursor ion and an unknown product ion.

Confirm the Presence of Compounds

Confirm the presence of compounds of interest before continuing with automatic optimization.

1. In the Analyst® software, create a project.
2. Activate the hardware profile.
3. Infuse the compound in solution at a rate of 5 µL/min. to 10 µL/min.
5. In the method list field, click Syringe Pump Method.
6. On the Syringe Pump Method Properties tab, type the appropriate parameter values. Refer to Table 7-4.
### Table 7-4 Syringe Pump Method Properties Tab

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Typical Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Syringe Diameter</td>
<td>Syringe dependent; 1.0 mL syringe is 4.610 mm</td>
</tr>
<tr>
<td>Flow Rate</td>
<td>10</td>
</tr>
<tr>
<td>Unit</td>
<td>µL/min</td>
</tr>
</tbody>
</table>

### Figure 7-1 Syringe Pump Method Properties Tab

7. Click **Start Syringe Pump**.
8. Click **MS Method** from the method list.
9. Click **Start**.
10. Wait until an even TIC is shown on the left and peaks are shown on the right and then click **Stop**.
11. Select the **MCA** check box.
12. Type **10** in the **Cycles** field.
13. Click **Start**.

When the ten scans are complete, the graph should show the masses of the four compounds as ions.

**Note:** The intensities of the compounds should be much higher than the smallest noise peaks but not so high that any noise peaks are not seen. In the first case, the peak might not be a real compound. In the second case, the concentration might be too high for the software to optimize properly.
Perform Automatic MS and MS/MS Optimization Using Infusion with a Known Precursor Ion and an Unknown Product Ion

Automatic optimization for MS/MS analysis optimizes certain compound-dependent parameters for one or more MRM transitions. The software finds the ion of interest and then optimizes the compound-dependent parameters to get the maximum sensitivity for the compound. The software ramps CE and then selects the most intense fragments that meet all of the product ion selection criteria.

If the initial Q1 scan signal is too high, then the software attempts to reduce the CEM to keep ions within the detector range. If the signal is still too high after the CEM is reduced, then the process stops and an error message is shown. Dilute the solution and then restart the optimization. Be sure to purge the infusion line. The parameters from the last quantitative optimization are stored.

1. Make sure that the proper concentration of solution has been installed in the syringe pump, and that the syringe pump has been started. If an integrated syringe pump is available and has been started, then the Syringe Pump Status LED is flashing.

   The syringe pump must be started in the Manual Tune window before compound optimization begins.

2. On the Navigation bar, under Tune and Calibrate, double-click Compound Optimization.


4. Click MS/MS Analysis in the Mass Spectrometer section.
5. Click Next.

6. On the Ions to use in MS/MS Analysis page, select the appropriate parameter values. Refer to Table 7-5.

**Table 7-5 Example Parameters to use in MS/MS Analysis Page**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>MW Ion: Search Window</td>
<td>2.500</td>
</tr>
<tr>
<td>Resolution</td>
<td>Unit</td>
</tr>
<tr>
<td>Polarity</td>
<td>Positive</td>
</tr>
<tr>
<td>Product Ion</td>
<td>Auto Select</td>
</tr>
<tr>
<td>Resolution</td>
<td>Unit</td>
</tr>
</tbody>
</table>

**Note:** The optimization algorithm looks for the most intense peak in the specified search window. If the most intense peak in that window is not the mass of interest, then the software optimizes on the wrong ion.

7. Click Criteria next to the Auto Select option.

8. In the Product Ion Auto Selection Criteria dialog, type the appropriate parameters. Refer to Table 7-6.
### Table 7-6 Example Product Ion Auto Selection Criteria Dialog Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Most Intense (peaks)</td>
<td>3</td>
<td>The number of fragment peaks to be optimized. The algorithm generates a product ion scan spectrum while ramping the CE in MCA mode. In this example, the algorithm takes the three most intense fragment ions from the spectrum and then continues the MS/MS optimization on those fragments only. For unknown compounds, select more peaks.</td>
</tr>
<tr>
<td>Build final method using (most intense peaks)</td>
<td>2</td>
<td>The number of fragment ions per precursor ion (target compound) to be automatically included in the acquisition method. The specified number defines the number of MRM transitions to be included for each target compound in the method. The order of preference is based on the intensity of the fragment ion. Two is a better starting value than one because typically two product ions are required for quantitation. Start with three in case there is an issue with one of the two best. Go back and the third is already identified. For unknown compounds, select more peaks for use in case of interference.</td>
</tr>
<tr>
<td>Exclude Product Ions within ± (Da of Precursor Ion m/z)</td>
<td>20.000</td>
<td>The Da value that defines the exclusion window around the precursor ion so that fragment ions that fall within this window are not selected for MRM optimization. For example, if the user types ± 5 Da for a precursor ion that has an m/z of 500, then any fragment ions within an m/z of 495 to 505 are excluded. This prevents the precursor ion from being optimized as a product ion.</td>
</tr>
<tr>
<td>Min. Mass for Product Ion (Da)</td>
<td>60.000</td>
<td>The lowest fragment mass to be considered for optimization. Use this option to narrow or widen the window of fragment ions to be considered from the precursor mass.</td>
</tr>
<tr>
<td>Threshold for Product Ion (cps)</td>
<td>100.000</td>
<td>Minimum number of counts for a product ion to be considered.</td>
</tr>
</tbody>
</table>

9. Click **OK** to save the changes to the selection criteria.

10. Click **Next**.

11. In the Target Components dialog, type the appropriate parameter values. Refer to **Table 7-7**.

**Note:** The compound name must be unique for each compound or transition.
Table 7-7 Example Target Compounds Dialog Parameters

<table>
<thead>
<tr>
<th>Target Compound</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserpine</td>
<td>Compound Name</td>
<td>Reserpine</td>
</tr>
<tr>
<td></td>
<td>MW (Da)*</td>
<td>609.3</td>
</tr>
<tr>
<td></td>
<td>No. Charges</td>
<td>1</td>
</tr>
<tr>
<td>Minoxidil</td>
<td>Compound Name</td>
<td>Minoxidil</td>
</tr>
<tr>
<td></td>
<td>MW (Da)*</td>
<td>210.2</td>
</tr>
<tr>
<td></td>
<td>No. Charges</td>
<td>1</td>
</tr>
<tr>
<td>Tolbutamide</td>
<td>Compound Name</td>
<td>Tolbutamide</td>
</tr>
<tr>
<td></td>
<td>MW (Da)*</td>
<td>271.3</td>
</tr>
<tr>
<td></td>
<td>No. Charges</td>
<td>1</td>
</tr>
<tr>
<td>Rescinnamine (IS)</td>
<td>Compound Name</td>
<td>Rescinnamine</td>
</tr>
<tr>
<td></td>
<td>MW (Da)*</td>
<td>635.4</td>
</tr>
<tr>
<td></td>
<td>No. Charges</td>
<td>1</td>
</tr>
</tbody>
</table>

*Type the exact ion mass.

12. Click **Finish** to begin the optimization process.

The screen shows two windows, a text file window and an acquisition window. The user might need to minimize one of them to see the other. The experiment being run is shown on the top of the acquisition window. The X-axis shows the parameter that is being optimized for each experiment. The text file window is updated as results are generated.

After optimization is complete, an MRM acquisition file is created and named `[compound]_QOpt_FinalMRM_Pos.dam`, where `[compound]` is the first compound in the Target Components page.

**Review the Optimization Results**

At the end of the optimization, the optimized parameters are saved in an acquisition method. All dam and wiff files generated in the optimization process are saved in the Acquisition Methods folder and in a subfolder in the Data folder, respectively, in the project. The name of the subfolder is generated using the name of the compound and the date.

1. After completing the optimization, print the text file containing the optimized parameters for each compound.
2. Click **File > Open** and then select the Reserpine_QOpt_FinalMRM.POS.dam file.
3. Compare the values in the text file to those in the dam file.

4. Inspect the contents of the following folders:

   - **Data**: Look through all of the runs executed during optimization. Compare a wiff file with the optimized value in the method or printed parameters.
   - **Acquisition Method**: Reserpine_QOpt_FinalMRM.POS.dam file and other dam files created during optimization.
   - **Log**: Report file (rtf) shown during the optimization process.

### Automatically Optimize for an Analyte Using FIA

<table>
<thead>
<tr>
<th><strong>Prerequisites</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Identify the ions for the compounds and save the basic acquisition method.</td>
</tr>
<tr>
<td>• Add an autosampler and LC pump to the basic acquisition method. Using FIA for optimization requires that these devices be active in the hardware profile.</td>
</tr>
<tr>
<td>• Create an LC-MS/MS acquisition method based on the Reserpine_QOpt_FinalMRM.POS.dam file and then name the new method FIA_AutoOpt_Tutorial.dam.</td>
</tr>
<tr>
<td>• Make sure that the selected project contains the acquisition method that is being used.</td>
</tr>
</tbody>
</table>

*Note*: Although FIA can be used to optimize compound-dependent parameters, this is typically not done because of the number of cycles required to obtain the optimal parameter values.

1. Put a dilution of the four-compound mix in an autosampler.

   Enough sample is required to review each variable of each parameter and have sample left over. For example, for the temperature to run at 300 °C, 400 °C, and 500 °C, if the injection volume is 10 µL, then more than a 30 µL (3 × 10 µL injection) is required.

2. Confirm that **LC Sync** is selected in the method.

*Note*: In LC Sync mode, the mass spectrometer coordinates with the action of the LC system to make sure that data is acquired properly.
3. Make sure that the ion source and gas parameters are set to reasonable levels to prevent the contamination of the mass spectrometer while optimizing. For more information, refer to the ion source Operator Guide.

4. Set the horizontal micrometer to 5.

5. Set the vertical micrometer on the ion source for the flow rate. As a starting point, use the parameters in the following table: For more information, refer to the ion source Operator Guide.

<table>
<thead>
<tr>
<th>Flow rate</th>
<th>Initial Vertical Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 µL/min to 20 µL/min</td>
<td>10 mm</td>
</tr>
<tr>
<td>20 µL/min to 250 µL/min</td>
<td>5 mm</td>
</tr>
<tr>
<td>250 µL/min to 500 µL/min</td>
<td>2 mm</td>
</tr>
<tr>
<td>500 + µL/min</td>
<td>0 mm</td>
</tr>
</tbody>
</table>

6. Set the values for the HPLC system and use an autosampler injection volume of 10 µL. Use the same concentration or lower as for the infusion experiment.

   The LC pumps must be configured for an isocratic run with no column. The MS and LC times must be the same to collect the proper data.
Automatic Optimization

The flow rate and percent of mobile phases used should be based on the LC column used, the general chromatography, and the approximate mobile phase concentration at which the compounds of interest elute.

7. On the Navigation bar, under Tune and Calibrate, double-click Compound Optimization.

8. On the Instrument Settings page, depending on the LC system being used, type the appropriate parameter values. Refer to Table 7-9.

Table 7-9 Example Instrument Settings Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inlet</td>
<td>FIA</td>
</tr>
<tr>
<td>Default Acq. Method</td>
<td>FIA_AutoOpt_Tutorial.dam</td>
</tr>
<tr>
<td>Rack Code</td>
<td>Autosampler specific</td>
</tr>
<tr>
<td>Rack Position</td>
<td>Autosampler specific</td>
</tr>
<tr>
<td>Injection Volume</td>
<td>10 µL</td>
</tr>
<tr>
<td>Mass Spectrometer</td>
<td>MS/MS Analysis</td>
</tr>
</tbody>
</table>

9. Click Next.

10. Make sure that the Int. Std. check box is cleared.

Selecting the check box indicates which MRM corresponds to the internal standards. Internal standards are not optimized during the optimization process.

11. In the Resolution section, select Unit in both the Q1 Resolution and Q3 Resolution fields.
12. Click **Next**.

13. On the FIA Source Parameters page, type numbers that are lower or higher than the original value as long as they are still within specifications.

   Be sure not to go too low with any of the settings to keep the system clean. Refer to Table 7-10 for parameters that can be used as a starting point.

   **Tip!** Type the values before selecting the check box.
### Table 7-10 Example Parameters for FIA Source Parameters Page

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Select the Optimize Check Box?</th>
<th>Values for Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curtain Gas</td>
<td>Yes</td>
<td>20;40;55</td>
</tr>
<tr>
<td>Collision Gas</td>
<td>No</td>
<td>—</td>
</tr>
<tr>
<td>IonSpray Voltage</td>
<td>Yes</td>
<td>1500;2000;3000;4000;5000</td>
</tr>
<tr>
<td>Temperature</td>
<td>Yes</td>
<td>300;400;500;600;700</td>
</tr>
<tr>
<td>Ion Source Gas 1</td>
<td>Yes</td>
<td>40;50;60;70;80;90</td>
</tr>
<tr>
<td>Ion Source Gas 2</td>
<td>Yes</td>
<td>40;50;60;70;80;90</td>
</tr>
<tr>
<td>Interface Heater</td>
<td>No</td>
<td>—</td>
</tr>
</tbody>
</table>

14. Select 1 or 2 beside **Replicate Injection for each Parameter**.

The total number of injections and the total sample volume are calculated based on the specifications here. Note the total sample volume needed. Sample volume might be high depending on how many variables for each parameter are being optimized, as each variable is a separate method.
15. Click **Next**.

16. On the FIA Compound Parameters page for each analyte, use the example parameter values provided as a starting point. Refer to **Table 7-11**.

**Note:** The values in **Table 7-11** are suggested values. For more information, refer to the Help.

**Table 7-11 Example FIA Compound Parameters Page**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Select the Optimize Check Box?</th>
<th>Values for Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Declustering Potential</td>
<td>Yes</td>
<td>60;80;100;120;200</td>
</tr>
<tr>
<td>Entrance Potential</td>
<td>No</td>
<td>—</td>
</tr>
</tbody>
</table>

**Figure 7-5 Example Replicate Injection for each Parameter Field**
Table 7-11 Example FIA Compound Parameters Page (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Select the Optimize Check Box?</th>
<th>Values for Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collision Energy</td>
<td>Yes</td>
<td>20;30;40;50;70;80;100</td>
</tr>
<tr>
<td>Collision Cell Exit</td>
<td>Yes</td>
<td>2;4;6;8;10;12</td>
</tr>
<tr>
<td>Potential</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The total number of injections and dependent sample volume update automatically. In contrast to ion source parameters, which require one injection per value per replicate, compound-dependent parameters only require one injection per parameter. A looped experiment is performed for each parameter. The values are alternated scan-by-scan within one injection.

**Note:** Do not enter too many values. Doing so will prevent proper evaluation of the parameter.

17. Using the Compound list, move to another compound and type the parameters to be optimized.
18. Repeat step 19 until all of the parameters for all of the compounds are provided.
19. Type 1.5 in the Mass Spec. Duration field.

**Note:** This value should be at least the required length of time for each injection.
20. Click **Finish** to begin the optimization process.

The software optimizes the specified ion source- and compound-dependent parameters to get the maximum sensitivity for the MRM transition of the compound. As the software proceeds through the optimization, it creates a **Compound Optimization** report.

21. To obtain optimized parameters, repeat this routine.

**Note:** Typically, the ion source and gas parameters must be narrowed using one more FIA cycle.

22. Open the final optimized FIA method called *_FIA_sample_1*.

**Note:** The software generates several acquisition methods.

23. Save this method using a simpler name.
An acquisition method consists of experiments and periods. Use the Acquisition Method Editor to create a sequence of periods and experiments for the instrument and devices.

We recommend that only users who are proficient in method development create or modify acquisition and quantitation methods. Refer to the Laboratory Director’s Guide for more information about roles and security.

**Create an Acquisition Method Using the Acquisition Method Editor**

**Tip!** If users are creating a new acquisition method file from an existing file, then some or all of the peripheral device methods in the acquisition method might be used.

Only devices configured in the active hardware profile appear in the Acquisition method pane. Any devices added to the hardware profile must also be added to existing acquisition methods. For more information about devices, refer to the Peripheral Devices Setup Guide.

1. Make sure that a hardware profile containing the mass spectrometer and peripheral devices is active.
2. On the Navigation bar, under Acquire, double-click Build Acquisition Method.
3. Select a Synchronization Mode on the Acquisition Method Properties tab.
4. (Optional) Select the Auto-Equilibration check box and then type the required equilibration time, in minutes.
5. Click the Mass Spec icon in the Acquisition method pane.
6. Select a Scan type on the MS tab.
7. Type values in the fields as required. Refer to Parameters on page 27.
8. On the Advanced MS tab, type values in the fields as required.
9. On the MS tab, click Edit Parameters.
10. On the Source/Gas tab, specify values in the fields as required.
11. On the Compound tab, specify values in the fields as required and then click OK.
12. Click a device icon and then select the parameters for the device.
13. Add any additional periods and experiments. Refer to Add an Experiment on page 85 and Add a Period on page 86.
14. Click File > Save.
Configure the Integrated Syringe Pump

1. Confirm that the integrated syringe pump is selected in the hardware device profile.

2. Click the Syringe Pump icon in the Acquisition method pane.

   The Syringe Pump Method Properties tab opens in the Acquisition Method editor.

   **Figure 8-1 Syringe Pump Properties tab**

3. Type the syringe diameter in the **Syringe Diameter (mm)** field.

4. Type the flow rate in the **Flow Rate** field.

5. Select the units of flow from the **Unit** list.

Add an Experiment

1. In the Acquisition method pane, on the period where the experiment is to be added, right-click and then click **Add experiment**.
Figure 8-2 Add Experiment

An experiment is added below the last experiment in the period.

**Note:** An experiment cannot be inserted between experiments, IDA criteria, or periods. Users can only add an experiment at the end of the period.

2. In the MS tab, select the appropriate parameters.

Add a Period

- In the Acquisition method pane, right-click the **Mass Spec** icon, and then click **Add period**.

A period is added below the last period created.

**Note:** Users cannot use multiple periods in an IDA experiment.

Copy an Experiment into a Period

1. Open a multi-period method.

2. In the Acquisition method pane, press **Ctrl**, and then drag the experiment to the period.

The experiment is copied below the last experiment in the period.

Copy an Experiment within a Period

Use this procedure to add the same or similar experiments to a period if most or all of the parameters are the same.

- Right-click the experiment and then click **Copy this experiment**.
A copy of the experiment is added below the last experiment created. This is useful when the same or similar experiments are added to an acquisition method.

**Scan Techniques**

**MS:** In MS scans, also referred to as single MS scans, ions are separated according to their mass-to-charge ratio \((m/z)\). A single MS scan might be used to determine the molecular weight of a compound. Single MS scans can also be referred to as survey scans. MS scans do not provide any information about the chemical make-up of the ions other than the mass. Perform MS/MS scans to obtain more information about the ions.

**MS/MS:** MS/MS scans are used to determine a molecular species.

- For MS/MS scans in triple quadrupole systems, precursor ion fragmentation occurs in the collision cell.

If enough energy is used, then the precursor ion fragments to produce characteristic product ions.

**Quadrupole-Mode Scan Types**

Triple quadrupole instruments have high-sensitivity Multiple Reaction Monitoring (MRM) capabilities required for quantitation experiments. In addition, they have highly specific scan types, such as precursor ion and neutral loss scans, which allow a more advanced search to be performed on the components of the samples.

**Q1 MS (Q1):** A full scan type using the first quadrupole (Q1). The ion intensity is returned for every mass in the scan range.

**Q1 Multiple Ions (Q1 MI):** A zero-width scan type using the Q1 quadrupole. The ion intensity is returned for the specified masses only.

**Q3 MS (Q3):** A full scan type using the third quadrupole (Q3). The ion intensity is returned for every mass in the scan range.

**Q3 Multiple Ions (Q3 MI):** A zero-width scan type using the Q3 quadrupole. The ion intensity is returned for the specified masses only.

**MRM (MRM):** An MS/MS scan in which a user-selected ion is passed through the Q1 quadrupole and then fragmented in the Q2 collision cell. The Q3 quadrupole then selects the fragment ion that enters the detector. This scan mode is used primarily for quantitation.

**Product Ion (MS2):** An MS/MS full scan where the Q1 quadrupole is fixed to transmit a specific precursor ion and the Q3 quadrupole scans a defined mass range. Used to identify all of the products of a particular precursor ion.

**Precursor Ion (Prec):** An MS/MS scan where the Q3 quadrupole is fixed at a specified mass-to-charge ratio to transmit a specific product ion and the Q1 quadrupole scans a mass range. Used to confirm the presence of a precursor ion or, more commonly, to identify compounds sharing a common product ion.

**Neutral Loss (NL):** An MS/MS scan where both the Q1 quadrupole and the Q3 quadrupole scan a mass range, a fixed mass apart. A response is observed if the ion chosen by the Q1 quadrupole fragments by losing the neutral
loss (the fixed mass) specified. Used to confirm the presence of a precursor ion or, more commonly, to identify compounds sharing a common neutral loss.

**LIT-Mode Scan Types**

The LIT-mode scans use the Q3 quadrupole as a linear ion trap. Ions are trapped and stored in the Q3 quadrupole before being scanned out, giving increased sensitivity. In addition, MS/MS/MS analysis can be performed in the linear ion trap, providing more information about the sample. LIT-mode scan types are typically used for qualitative measurements.

**Enhanced MS (EMS):** Ions are scanned in the Q1 quadrupole to the linear ion trap where they are collected. These ions are scanned out of the Q3 quadrupole to produce single MS type spectra.

**Enhanced Multi-Charge (EMC):** This scan type is similar to the EMS scan except that before ions are scanned out of the linear ion trap, there is a delay period during which low-charge state ions (primarily singly-charged ions) are allowed to preferentially escape from the linear ion trap. When the retained ions are scanned out, the multiply-charged ion population dominates the resulting spectrum.

**Enhanced Product Ion (EPI):** This scan type is used to obtain a high quality MS/MS spectrum on a specific ion. The fragmentation is done in the Q2 collision cell and thus provides the information-rich MS/MS spectrum typical of collisionally activated dissociation (CAD) fragmentation. In this scan mode, the precursor ion to be fragmented is first selected in the Q1 quadrupole with a mass window that is 1 Da to 4 Da wide, filtering out all other ions. The precursor ion is fragmented by CAD gas in the Q2 collision cell. The fragment ions generated are captured in the linear ion trap and then scanned out at one of three scan speeds, depending on the required fragment ion resolution.

For IDA experiments, the **Product Of** field is set to 30 Da by default, and this value should not be changed.

**Enhanced Resolution (ER):** This scan type is similar to the EMS scan except that a small 30 Da mass around the precursor mass is scanned out of the linear ion trap at the slowest scan rate to produce a narrow window of the best-resolved spectra.

**MS/MS/MS (MS3):** A precursor ion is selected by the Q1 quadrupole and fragmented with collisionally activated dissociation in the Q2 collision cell. The resulting product ions are all transmitted to the linear ion trap, where a single product ion is then isolated. The isolated ion is further fragmented in the linear ion trap, and the resulting product ions are scanned out of the trap at one of three scan speeds. As with any in-trap Collision Induced Disassociation (CID) technique, there is a low mass cut-off for the second MS/MS step due to the condition that the lowest mass fragment and precursor must be simultaneously stable in the trap. For QTRAP® systems, this results in the loss of ions lower than 28 percent of the mass of the precursor ion during MS3 experiments. This phenomenon is often referred to as the one-third cut-off rule.

**About Spectral Data Acquisition**

Spectral data can be acquired in one of the modes described in Table 8-1.
Table 8-1 Spectral Data

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile</td>
<td>The preset value is 0.1 Da. Profile data is the data generated by the mass spectrometer and corresponds to the intensity recorded at a series of evenly spaced discrete mass values. For example, for a mass range from 100 Da to 200 Da and a step size of 0.1 Da, the mass spectrometer scans 99.95 to 100.05 (recorded as value 100), 100.05 to 101.15 (recorded as value 101),…199.95 to 200.05 (recorded as value 200).</td>
</tr>
<tr>
<td>Peak Hopping</td>
<td>The preset value is 1.0 Da. Peak Hopping is a mode of operating a mass spectrometer in which large steps (approximately 1 Da) are made. It has the advantage of speed (fewer data steps are made) but with the loss of peak shape information.</td>
</tr>
<tr>
<td>Centroid</td>
<td>The mass spectrometer scans as in Profile mode, but creates a centroid of the data, replacing found peaks with the intensity-weighted center of gravity for each peak. Centroid data has the advantage of significantly reducing file size. The disadvantage is that peak shape information is lost and if data has been collected as a centroid then it cannot be altered. We recommend the use of profile mode and centroiding of the data post-acquisition.</td>
</tr>
</tbody>
</table>
This section describes how to use the Analyst® software to analyze and process quantitative data. Data can also be processed using the MultiQuant™ software. We suggest that the MultiQuant™ software is used to quantitate data. Refer to the documentation that comes with the MultiQuant™ software.

Use the sample files found in the Example folder to learn how to select samples for quantitation, how to select preset queries and create table-specific queries, and how to analyze the acquired data. For more information about the following topics, refer to the Advanced User Guide.

- Metric Plots
- Layout of a Results Table

**Quantitative Analysis**

Quantitative analysis is used to find the concentration of a specific substance in a sample. By analyzing an unknown sample and comparing it to other samples containing the same substance with known concentrations (standards), the software can calculate the concentration of the unknown sample. The process involves creating a calibration curve using the standards and then calculating the concentration for the unknown sample. The calculated concentrations of each sample are then available in a Results Table.

**Quantitation Methods**

A quantitation method is a set of parameters used to generate peaks in a sample. The quantitation method can include parameters used to locate and integrate peaks, generate standard curves, and calculate unknown concentrations. A previously saved quantitation method can be selected from the Quantitation menu in the batch. The user can create a quantitation method before data acquisition and then apply the method to the quantitative data automatically after the batch is complete. Alternatively, a quantitation method can be created and applied post-acquisition.

Three tools can be used to create a quantitation method: the Quantitation Wizard, the Build Quantitation Method, and Quick Quant.

**Quantitation Wizard**

With the Quantitation Wizard, a Results Table is generated at the same time as the quantitation method. Alternatively, an existing quantitation method can be used to quantitate different sets of data.
Build Quantitation Method

The Build Quantitation Method does not generate a quantitation Results Table although the method can subsequently be used in the Quantitation Wizard to create a Results Table. The Build Quantitation Method can also be used to change existing quantitation methods. This is the most flexible way of creating a quantitation method. Refer to Create a Method Using the Quantitation Method Editor on page 91.

Quick Quant

Quick Quant is not recommended for quantitation of results.

Quick Quant is part of the Batch Editor. Use Quick Quant to add compound concentrations prior to data acquisition. Because a sample has not been acquired, a representative sample cannot be selected nor can peaks be reviewed. With this process, only the method components are defined.

To use a previously saved quantitation method, select it from the Quantitation menu in the batch. For instructions on creating a batch, refer to Create and Submit a Batch on page 135.

About Results Tables

Results tables summarize the calculated concentration of an analyte in each unknown sample based on the calibration curve. Results tables also include the calibration curves as well as statistics for the results. The user can customize the results tables and view the results tables in layouts.

The data from a results tables can be exported to a txt file for use in other applications, such as Microsoft Excel. The user can also export data in the table or just the data in the visible columns.

Quantitation Methods and Results Tables

For the following procedures, use the sample data that is installed in Example folder. The Triple Quad folder contains the data files, Mix_Batch_1 and Mix_Batch_2. These sample files are used to demonstrate the usefulness of metric plots to isolate problematic samples. The ions scanned were reserpine (609.3/195.0), minoxidil (210.2/164.2), tolbutamide (271.1/91.1) and rescinnamine (635.3/221.2), which is the internal standard.

Mix_Batch_1 contains no errors in terms of sample preparation, whereas Mix_Batch_2 contains a QC sample where the internal standard was added twice (sample QC2).

Create a Method Using the Quantitation Method Editor

<table>
<thead>
<tr>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Select the project that contains the data to be quantified.</td>
</tr>
<tr>
<td>- Switch Between Projects and Subprojects on page 63</td>
</tr>
</tbody>
</table>

1. Make sure that the Example folder is selected.
2. On the Navigation bar, under **Quantitate**, double-click **Build Quantitation Method**.

   The Select Sample dialog opens.

3. Double-click the **Triple Quad** folder in the **Data Files** list.

4. Select **Mix_Batch_2. wiff**.

   The samples in the selected data file are shown in the **Samples** list.

   **Note:** If the **Compound ID** field was populated for the samples and internal standards in the acquisition method, then in the **Internal Standards** table, when a value is selected in the **Q1/Q3** field, the **Name** field is automatically populated.

5. Select a sample that provides a detectable signal to select integration parameters that fit the entire batch and then click **OK**.

6. In the **Internal Standards** table, in the **Name** column, select **rescinnamine**. In **Q1/Q3** column, select **635.3/221.2**.

7. In the **Analytes** table, do the following:

   a. In the **Name** column, select **minoxidol** for the **Q1/Q3** column masses of **210.2/164.188**, **tolbutamide** for **271.3/91.146**, and **reserpine** for **609.4/195.039**.

   b. In the **Internal Standard** column, from the list, select the **rescinnamine** as internal standard to be associated with each analyte.

   c. Delete **635.4/221.185** from the **Q1/Q3** column in the **Analytes** table.

   **Note:** If the Compound ID field was populated for the samples and internal standards in the acquisition method, then in the Analytes table, the Name field and Q1/Q3 field are populated.

8. Click the **Integration** tab.

   The preset integration parameters are suitable for most peaks.

9. If the integration is not suitable, then change the algorithm. Refer to **Manually Integrate Peaks on page 103**.

10. Click the **Show or Hide Parameters** icon to show the additional integration algorithms.

11. Click the **Calibration** tab.

   The preset parameters are suitable for these samples. User can change the fit, weighting, and regression parameter depending on the specific applications.

12. Save the quantitation method.

   The new method can be used when a batch is created in the Batch Editor or when the Quantitation Wizard is used to generate a Results Table.
**Tip!** The quantitation method can only be used in the current project unless it is copied to another project. To do this, click **Tools > Project > Copy Data**. A new project must be created and selected to be available for use.

---

**Create a Results Table Using the Quantitation Wizard**

**Prerequisites**

- Select the project that contains the data to be quantified.
- **Switch Between Projects and Subprojects** on page 63

1. On the Navigation bar, under **Quantitate**, double-click **Quantitation Wizard**.

   The Create Quantitation Set - Select Samples page opens.

2. Double-click the **Triple Quad** folder in the **Available Data Files** list.

3. Select **Mix_batch_2. wiff**.

4. Click **Add All**.

   **Note:** We recommend that users do not process or report results from any sample for which acquisition was abnormally or unexpectedly terminated.

5. Click **Next**.

   The Create Quantitation Set - Select Settings & Query page opens.

6. Click **Select Existing: Query** in the **Default Query** section.

7. Select **Accuracy 15%** from the **Query** list.

   **Note:** To create a query at the same time, refer to **Create a Standard Query (Optional)** on page 94.

   **Note:** It is the responsibility of the user to evaluate and validate the query to be used for specific applications.

8. Click **Next**.

   The Create Quantitation Set - Select Method page opens.

9. Click **Choose Existing Method**.

10. Select **PK Data_Mix.qmf** from the **Method** list.
11. Click **Finish**.

   The Results Table opens.

   **Tip!** To add or remove samples in the Results Table, click **Tools > Results Table > Add/Remove Samples**.

12. Review the sample type, actual concentration, peak integration, calibration curves, statistics pane, metric plot for the internal standard, and other information related to data quantitation.

13. Save the Results Table.

   **Note:** We recommend that users do not change datafile (wiff) names if a Results Table includes samples from that file.

   **Tip!** Well-formatted reports can be created from a Results Table using the Reporter software. We recommend that the user validate the results if a Reporter template that contains a query is used. Refer to **Reporter Software on page 129**.

---

**Create a Standard Query (Optional)**

Advanced users can create a query and a standard query numerous ways. The following is one example. For more information about creating queries, refer to the Help.

1. On the Navigation bar, under **Quantitate**, double-click **Quantitation Wizard**.
2. Select samples in the Create Quantitation Set - Select Samples page.
3. Click **Next**.
4. In the Select Settings & Query page, in the **Default Query** section, select **Create New Standard Query**.
5. Type a query name.
6. Click **Next**.
7. In the **Maximum Allowed Accuracy Variation for QCs (%)** table in the **Max. Variation** column, type the maximum allowable percent of variation for each QC, for example 5 is ± 5%, in the same row as the corresponding concentration. If the concentrations were not specified during acquisition, then they are not shown here. In this case, type them in the **Concentration** column.

8. In the **Maximum Allowed Accuracy Variation for Standards (%)** table, in the **Max. Variation** column, type the maximum allowable percent of variation for each standard, for example 10 is ±10%, in the same row as the corresponding concentration. If the concentrations were not specified during acquisition, then they are not shown here. Type the concentrations in the **Concentration** column.

9. Click **Next**.
10. Select or create a method.

11. Click **Finish**.

The query is applied as a standard query. The query results are shown as a Pass or Fail entry in the **Standard Query Status** column of the Results Table.

**Tip!** To return to the full view, right-click and then click **Full**.

**Results Table Right-click Menu**

Right-click in the Results Table to access the options shown in Table 9-1.

**Table 9-1 Results Table Right-click Menu**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full</td>
<td>Shows all the columns.</td>
</tr>
<tr>
<td>Summary</td>
<td>Shows specific columns.</td>
</tr>
<tr>
<td>Analyte</td>
<td>Shows a specific analyte.</td>
</tr>
</tbody>
</table>
### Peak Review and Manual Integration of Peaks

Use peak review to survey the peaks that the software has identified and then redefine the peak or the start and end points where required.

After identifying the analytes and internal standards that the software must find, the software searches for the peaks in the samples. When the software identifies a peak, it shows the chromatograms for each analyte and internal standard in the Create Quantitation Method: Define Integration page of the Standard Wizard or on the Integration tab of the Full Method Editor. The user can confirm the peaks that are found or change the quantitation method to better define the peaks. We recommend that users manually review all integration results.

### Review Peaks

During peak review, the user might want to view a peak in its entirety or to examine the baseline to find out how well the software found the start and end points of the peak. The automatic zooming feature can be used to do either.

To help the software find a peak, define the exact start and end points of the peak and background manually. These changes will apply only to that individual peak unless the global method is updated.

---

**Table 9-1 Results Table Right-click Menu (continued)**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyte Group</td>
<td>Creates an analyte group.</td>
</tr>
<tr>
<td>Sample Type</td>
<td>Shows samples of a specific type or all samples.</td>
</tr>
<tr>
<td>Add Formula Column</td>
<td>Adds a formula column. We recommend that the user validate the results if a formula column is used.</td>
</tr>
<tr>
<td>Table Settings</td>
<td>Edits or selects a table setting.</td>
</tr>
<tr>
<td>Query</td>
<td>Creates or selects a query.</td>
</tr>
<tr>
<td>Sort</td>
<td>Creates a sort or sorts by index.</td>
</tr>
<tr>
<td>Metric Plot</td>
<td>Creates a metric plot.</td>
</tr>
<tr>
<td>Delete Pane</td>
<td>Deletes the active pane.</td>
</tr>
<tr>
<td>Fill Down</td>
<td>Copies the same data into the selected cells.</td>
</tr>
<tr>
<td>Add Custom Column</td>
<td>Adds a custom column.</td>
</tr>
<tr>
<td>Delete Custom Column</td>
<td>Deletes the selected custom column.</td>
</tr>
</tbody>
</table>
Note: We recommend that manually integrated results be validated.

Tip! To review an individual peak, right-click on a point on the curve and then click Show Peak. The software opens the Peak Review window with the selected peak.

1. Right-click in the Results Table and then click Analyte.
2. Select an analyte.
3. Click Tools > Peak Review > Pane.

The peaks are shown below the Results Table with only the peaks listed in the Results Table.

Figure 9-4 Peak Review

4. Right-click in the pane and then click Options.
5. In the Peak Review Options dialog, in the Appearance section, change Num. rows to 1 and Num. columns to 2.
6. In the Automatic Zooming section, click Zoom Y axis to: 100% of largest peak to show the entire peak.
Figure 9-5 Peak Review Options Dialog

<table>
<thead>
<tr>
<th>Item</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Number of rows</td>
</tr>
<tr>
<td>2</td>
<td>Number of columns</td>
</tr>
<tr>
<td>3</td>
<td>Zoom Y-axis to 100% of largest peak to show the entire peak</td>
</tr>
</tbody>
</table>

7. Click **OK**.
8. To move through the peaks, click the right-pointing arrow. Refer to **Figure 9-6** and **Figure 9-7 on page 102**.
9. Go to the second injection of standard 3.

   In this example, the peak can be integrated closer to the baseline by selecting the **Specify Parameters** option.

**Tip!** To move to a specific peak in the Peak Review pane, select the corresponding row in the Results Table.
Figure 9-6 Peak Review Pane

- Bkg. Start: N/A
- Bkg. End: N/A
- Min Peak Height: 0.00 cps
- Min Peak Width: 0.00 sec
- RT Window: 30.0
- Expected RT: 2.29
- Noise Percent: 50
- Peak-Splitting Factor: 2

STD 3 - reserpine (Standard) 609.400/195.039 Da - sample 6 of 49 from M.
Area: 8.70e+003 counts  Height: 9.52e+002 cps  RT: 2.07 min
Figure 9-7 Peak Review Pane

<table>
<thead>
<tr>
<th>Item</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Arrows: Click to move through the peaks.</td>
</tr>
<tr>
<td>2</td>
<td>Show or Hide Parameters: Click to show the integration parameters.</td>
</tr>
<tr>
<td>3</td>
<td>Integration parameters: Click to change the parameters.</td>
</tr>
<tr>
<td>4</td>
<td>Noise Percentage: Type a noise percent.</td>
</tr>
<tr>
<td>5</td>
<td>Apply: Click to integrate the parameters.</td>
</tr>
</tbody>
</table>

10. Click **Show or Hide Parameters** twice.
11. Click **Specify Parameters - MQ III**.
12. Change the **Noise Percent** value.
13. Click **Apply**.

The peak is integrated closer to the baseline.

14. If the change does not improve the peak integration, then adjust the **Noise Percent** parameter until the optimal value is found.

**Note:** The **Update Method** function only updates the algorithm values for that specific analyte (or internal standard) and not all analytes.

15. To update the algorithm for all peaks, right-click in the pane and then click **Update Method**.
Manually Integrate Peaks

Manually integrating peaks should be done last, to limit person-to-person variability. Manually integrate peaks only if all the peaks have not been found after the algorithm parameters have been adjusted and updated. We recommend that users validate the results to determine whether manual integration is acceptable for specific applications.

**Note:** Peaks that are manually integrated, or where the algorithm was changed for only that peak, are identified in the Record Modified column of the Results Table, as are peaks that have algorithm parameter changes for a sample that are not applied to the entire analyte group.

1. In the **Peak Review** pane, click **Manual Integration Mode**.

2. Zoom in on the lower 10% of the peak.
3. Move the cross-hair to where the start of the peak is to be defined and then drag the cross-hair to where the end of the peak is to be defined.

The software shades the area bounded by the base and sides of the peak. Peak parameters are gray as they are no longer applicable because the peak was drawn manually.

4. Do one of the following:

- To make this change permanent, click **Accept**.
- To discard the changes, clear the **Manual Integration** check box.

**Tip!** If a peak was correct as originally selected, right-click the peak and then click **Revert to Method**.

**Peak Review Right-Click Menu**

Right-click in the **Peak Review** window or pane to access the options shown in **Table 9-2.**
Table 9-2 Peak Review Right-click Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>Opens the Peak Review Options dialog.</td>
</tr>
<tr>
<td>Sample Annotation</td>
<td>Opens the Sample Annotation dialog.</td>
</tr>
<tr>
<td>Save Active to Text File</td>
<td>Saves the selected peak as a text file.</td>
</tr>
<tr>
<td>Show First Page</td>
<td>Goes to the first sample.</td>
</tr>
<tr>
<td>Show Last Page</td>
<td>Goes to the last sample.</td>
</tr>
<tr>
<td>Slide Show Peak Review</td>
<td>Opens the slide show.</td>
</tr>
<tr>
<td>Update Method</td>
<td>Updates the algorithm for all peaks.</td>
</tr>
<tr>
<td>Revert to Method</td>
<td>Selects a redefined peak based on the current quantitation method.</td>
</tr>
<tr>
<td>Delete Pane</td>
<td>Deletes the active pane.</td>
</tr>
</tbody>
</table>

Calibration Curves

Use calibration curves to find the calculated concentration of samples, including quality control (QC) samples. QC samples are added to a batch to estimate the data quality and accuracy of standards in the batch. QC samples have known analyte concentrations but are treated as unknowns so that the measured concentrations can be compared to the actual value.

The calibration curve is generated by plotting the concentration of the standard versus its area or height. If an internal standard is used, then the ratio of the standard concentration or internal standard versus the ratio of the standard peak height or area to the internal standard peak height or area is plotted. The area or height ratio of a sample is then applied to this curve to find the concentration of the sample, as shown in the Results Table. A regression equation is generated by this calibration curve according to the regression that was specified. The regression equation is used to calculate the concentration of the unknown samples.

View Calibration Curves

The user can view the calibration curve and change the regression options in an open Results Table. If two or more Results Tables are open, then the calibration curves can be overlaid. To overlay curves, make sure that the method used to create the tables is the same.

Plot a calibration curve to see the curve used for regression. The Calculated Concentration field in the Results Table reflects any changes resulting from the fit of the curve to the points of the standard.
1. Open a Results Table.

2. Click **Tools > Calibration > Pane**.

   The Calibration Curve pane containing the calibration curve opens.

   ![Figure 9-11 Calibration Curve](image)

3. If there is more than one analyte, then use the following steps to view the calibration curve for another analyte:
   
   a. From the **Analyte** list, select an analyte.
   b. If required, from the next list, select **Area** or **Height**.

4. To change the regression options for the calibration curve, do the following:
   
   a. Click **Regression**.

   ![Figure 9-12 Regression Options Dialog](image)

   b. Select **Linear** in the **Fit** list.
   c. Select **1 / x** in the **Weighting** list.
   d. Click **OK**.
The calibration curve opens. The user can review individual peaks on the curve or exclude points from the curve to produce a better curve.

5. If required, repeat these steps to create a more appropriate curve.

6. To save the changes, click Accept.

Overlay Calibration Curves

Tip! To examine the curve for one table more closely, right-click the curve and then click Active Plot. Select the curve to be plotted on top.

1. With two or more open Results Tables, view a calibration curve for one of the tables.
2. Right-click the calibration curve and then click Overlay.

![Figure 9-13 Overlay Dialog](image)

3. Select the tables to overlay with the current curve.
4. Click OK.

The software plots the curves for all selected tables on the same graph.

Calibration Curve Right-Click Menu

Right-click in the Calibration window or pane table to access the options shown in Table 9-3.
Table 9-3 Calibration Curve Right-click Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude (Include)</td>
<td>Right-click the point and then click <strong>Exclude</strong> to exclude the point from the curve. Right-click the point and then click <strong>Include</strong> to include the point.</td>
</tr>
<tr>
<td>Exclude All Analytes (Include All Analytes)</td>
<td>Right-click a point and then click <strong>Exclude All Analytes</strong> to exclude all the analytes from the curve. Right-click a point and then click <strong>Include All Analytes</strong> to include the points.</td>
</tr>
<tr>
<td>Show Peak</td>
<td>Reviews an individual peak.</td>
</tr>
<tr>
<td>Overlay</td>
<td>Overlays two graphs.</td>
</tr>
<tr>
<td>Active Plot</td>
<td>Determines which plot is active.</td>
</tr>
<tr>
<td>Legend</td>
<td>Shows the graph legend.</td>
</tr>
<tr>
<td>Log Scale X Axis*</td>
<td>Uses a log scale for the X-axis.</td>
</tr>
<tr>
<td>Log Scale Y Axis*</td>
<td>Uses a log scale for the Y-axis.</td>
</tr>
<tr>
<td>Delete Pane</td>
<td>Deletes the active pane.</td>
</tr>
<tr>
<td>Home Graph</td>
<td>Scales the graph to its original size</td>
</tr>
</tbody>
</table>

* A log scale arranges the data points in a more manageable view so that the effect of all points can be monitored simultaneously. For this view, select **Log Scale Y Axis** versus **Log Scale X** and not just the log of one axis.

Sample Statistics

Use the Statistics window to view the statistics samples, typically for standards and QCs (quality controls). The data from each available batch in the Results Table opens in tabular form in the grid and a row of data is shown for each standard or QC concentration.

View the Statistics for Standards and QCs

When more than one **Results Table** is open, statistical information about the standards and QCs for additional batches in the **Statistics** window can be obtained. This facilitates comparison of results between batches and identification of trends in the standards or QCs.

1. Open a Results Table.
2. Click **Tools > Statistics**.
3. Select **Concentration** from the **Statistics Metric** list.
4. Select an analyte in the **Analyte Name** field.
5. Select **Standard** in the **Sample Type** field.

The results are shown.

6. Look at the **%CV** and **Accuracy** columns.

The **%CV** shows the coefficient of variance between the measurements of a single parameter, for example the area. **Accuracy** shows how close the plotted point is to the interpolated value.

7. If required, select the **Display Low/High values** check box and then examine the **Low**, **High** values, and **Mean** for each row in the grid. Each row represents standards that have the same concentration levels.

8. Select another analyte.

The results are shown on a per-analyte basis.

9. To check for **Quality Control** variations at the same concentration levels, select **QC** in the **Sample Type** field.

## Compare Results Between Batches

When more than one Results Table is shown, obtain statistical information about the standards and QCs for additional batches in the Statistics window. Normally results are compared between batches to look for trends in the standards or QCs or to verify that the method is valid.

For two or more open Results Tables, compare results in the Statistics window. Both sets of statistics are shown in the Statistics window.

The number of analytes and the analyte names must be the same for the data to be combined in the Statistics pane.

1. Open a Results Table.
2. Click **Tools > Statistics**.
3. Do one of the following:

   - To arrange the results by **Results Table**, select **Group By Batch** in the **Conc. as Rows** list.
   - To arrange the results in order of concentration, select **Group By Concentration** in the **Conc. as Rows** list.
   - To arrange the results in order of concentration without a row showing the statistics for each group or batch, select **Group By Concentration (no All)** in the **Conc. as Rows** list.

The software sorts the results. At the end of each batch or group, one or two additional rows are shown: **All** (statistics for all Results Tables in that group) and **Average** (statistics on the statistics for that batch or group).
Operating Instructions — Analyze and Explore Data

Use the sample files installed in the Example folder to learn how to view and analyze data using the most common analysis and processing tools. For more information about the following topics, refer to the Advanced User Guide:

- Labeling graphs
- Overlaying and summing spectra or chromatograms
- Performing background subtractions
- Smoothing algorithms
- Working with smoothed data
- Working with centroid data
- Working with contour plots
- Working with the fragment interpretation tool
- Working with library databases and library records

Open Data Files

**Tip!** To turn off the automatic update on the mass spectrum, right-click the mass spectrum and then click Show Last Scan. If there is a check mark beside Show Last Scan, then the spectrum will update in real-time.


   The Select Sample dialog is shown.

2. In the Data Files list, navigate to the data file to open, select a sample, and then click OK.

   The data acquired from the sample is shown. If data is still being acquired, then the mass spectrum, DAD/UV trace, and TIC continue to update automatically.

Navigate Between Samples in a Data File

**Note:** If samples were saved in separate data files, then open each file individually.
Table D-5 on page 180 shows the navigation icons used in this procedure.

- Open a data file that contains multiple samples and then do one of the following:
  - Click the icon with the arrow pointing to the right to skip to the next sample in the data file.
  - Click the icon with the arrow curving to the right to skip to a non-sequential sample.
  - In the Select Sample dialog, from the Sample list, select the sample to view.
  - Click the icon with the arrow pointing to the left to go to the previous sample in the data file.

### View Experimental Conditions

The experimental conditions used to collect data are stored in the data file with the results. The information contains the details of the acquisition method used: the MS acquisition method (that is, the number of periods, experiments, and cycles) including instrument parameters and the HPLC device method (LC pump flow rate). In addition, it also contains the MS resolution and mass calibration tables used for the sample acquisition. Table 10-1 shows the software functionality available when the user views the file information.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies the selected data.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes data.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all the data in the pane.</td>
</tr>
<tr>
<td>Save To File</td>
<td>Saves data as an rtf file.</td>
</tr>
<tr>
<td>Font</td>
<td>Changes the font.</td>
</tr>
<tr>
<td>Save Acquisition Method</td>
<td>Saves the acquisition method as a dam file.</td>
</tr>
</tbody>
</table>

**Note:** If data is acquired from more than one sample into the same wiff file, then the file information pane does not refresh automatically while scrolling through the samples. Close the file information pane and then reopen it to view the details for the next sample in the wiff file.

- Click **Explore > Show > Show File Information.**

The File Information pane opens below the graph.

**Tip!** To create an acquisition method from the File Information pane, right-click the File Information pane and then click **Save Acquisition Method**.
Table 10-1 Right-click Menu for Show File Information Pane (continued)

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Acquisition Method to CompoundDB</td>
<td>Opens the Specify Compound Information dialog. Select the IDs and molecular weights to be saved in the compound database.</td>
</tr>
<tr>
<td>Delete Pane</td>
<td>Deletes the selected pane.</td>
</tr>
</tbody>
</table>

Show Data in Tables

1. Open a data file.
2. Click **Explore > Show > Show List Data**.

The data is shown in a pane below the graph.

Figure 10-1 Peak List Tab
Show ADC Data

ADC (analog-to-digital converter) data is acquired from a secondary detector (for example from a UV detector through an ADC card), and is useful for comparison with mass spectrometer data. To have ADC data available, acquire the data and the mass spectrometer data simultaneously and then save it in the same file.

1. Make sure that the Example folder is selected.

   The Select Sample dialog opens.
3. In the Data Files field, double-click Devices and then click Adc16chan.wiff.
4. In the Samples list, select a sample, and then click OK.
5. Click Explore > Show > Show ADC Data.
6. In the **Channel** list, select a channel, and then click **OK**.

The ADC data is shown in a new pane beneath the active pane.

**Show Basic Quantitative Data**

1. Open a data file.
2. Click **Explore > Show > Show List Data**.
3. In the Peak List tab, right-click and then select **Show Peaks in Graph**.

   Peaks are shown in two colors.

4. To change the peak finding algorithm settings, right-click and then select either **Analyst Classic Parameters** or **IntelliQuan Parameters**, whichever is active.

5. (Optional) To remove the colored peaks, right-click in the Peak List tab and then clear **Show Peaks in Graph**.

### Chromatograms

A chromatogram is a graphical view of the data obtained from the analysis of a sample. It plots the signal intensity along an axis that shows either time or scan number. For more information about software functionality available for chromatograms, refer to Table 10-6 on page 124.

The software plots intensity, in counts per second (cps), on the Y-axis against time on the X-axis. Peaks above a set threshold are labeled automatically. In the case of LC-MS, the chromatogram is often shown as a function of time. Table 10-4 contains the description of the types of chromatograms.

Refer to Table 10-8 on page 127 for more information about using the available icons.

**Table 10-4 Types of Chromatograms**

<table>
<thead>
<tr>
<th>Types of Chromatograms</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIC (Total Ion Chromatogram)</td>
<td>A chromatographic view generated by plotting the intensity of all ions in a scan against time or scan number.</td>
</tr>
<tr>
<td></td>
<td>When a data file is opened, it is preset to open as a TIC. If the experiment contains only one scan, then it is shown as a spectrum.</td>
</tr>
<tr>
<td></td>
<td>If the MCA check box is selected during acquisition of the data file, then the data file opens to the mass spectrum. If the MCA check box is not selected, then the data file opens as the TIC.</td>
</tr>
<tr>
<td>XIC (Extracted Ion Chromatogram)</td>
<td>An ion chromatogram created by taking intensity values at a single, discrete mass value, or a mass range, from a series of mass spectral scans. It indicates the behavior of a given mass, or mass range, as a function of time.</td>
</tr>
<tr>
<td>BPC (Base Peak Chromatogram)</td>
<td>A chromatographic plot that shows the intensity of the most intense ion within a scan versus time or scan number.</td>
</tr>
<tr>
<td>TWC (Total Wavelength Chromatogram)</td>
<td>A chromatographic view created by summing all of the absorbance values in the acquired wavelength range and then plotting the values against time. It consists of the summed absorbances of all ions in a scan plotted against time in a chromatographic pane.</td>
</tr>
</tbody>
</table>
Table 10-4 Types of Chromatograms (continued)

<table>
<thead>
<tr>
<th>Types of Chromatograms</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>XWC (Extracted Wavelength Chromatogram)</td>
<td>A subset of TWC. An XWC shows the absorbance for a single wavelength or the sum of the absorbance for a range of wavelengths.</td>
</tr>
<tr>
<td>DAD (Diode Array Detector)</td>
<td>A UV detector that monitors the absorption spectrum of eluting compounds at one or more wavelengths.</td>
</tr>
</tbody>
</table>

Show TICs from a Spectrum

To see an example data file, make sure that the Example project is selected. Open the Triple Quad folder, and then open the Mix_batch_1.wiff file.

• Click Explore > Show > Show TIC.

The TIC opens in a new pane.

**Tip!** Right-click inside a pane containing a spectrum and then click Show TIC.

Show a Spectrum from a TIC

A TIC is created by summing the intensity contributions of all ions from a series of mass scans. Use the TIC to view an entire data set in a single pane. It consists of the summed intensities of all ions in a scan plotted against time in a chromatographic pane. If the data contains results from multiple experiments, then the user can create individual TICs for each experiment and another TIC that represents the sum of all experiments.

When a data file is opened, it is preset to appear as a TIC. However, if the experiment contains only one scan, it is shown as a spectrum. If the user selects the MCA check box before acquiring the data file, then the data file opens to the mass spectrum. If the MCA check box is not selected, then the data file opens with the TIC.

1. In a pane containing a TIC, select a range.
2. Click Explore > Show > Show Spectrum.

The spectrum opens in a new pane.

**Tip!** Double-click in the TIC pane at a particular time to show the spectrum.
About Generating XICs

XICs can be generated only from single-period, single-experiment chromatograms or spectra. To obtain an XIC from multi-period or multi-experiment data, split the data into separate panes by clicking the triangle under the X-axis. Refer to Table 10-8 on page 127 for more information about using the available icons.

Several methods are available for extracting ions to generate an XIC, depending on whether chromatographic or spectral data is used. Table 10-5 contains a summary of methods that can be used with chromatograms and spectra.
Table 10-5 Summary of XIC Generation Methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Use with Chromatogram</th>
<th>Use with Spectrum</th>
<th>Extraction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected range</td>
<td>No</td>
<td>Yes</td>
<td>Extracts ions from a selected area in a spectrum.</td>
</tr>
<tr>
<td>Maximum</td>
<td>No</td>
<td>Yes</td>
<td>Extracts ions from a selected area in a spectrum using the most intense peak in the selected area. This option creates an XIC using the maximum mass from the selected spectral range.</td>
</tr>
<tr>
<td>Base peak masses</td>
<td>Yes</td>
<td>Yes</td>
<td>Can be used only with Base Peak Chromatograms (BPCs). Use the Use Base Peak Masses command to extract ions results in an XIC with a different colored trace for each mass. If the selection includes multiple peaks, then the resulting XIC will have an equal number of colored traces, one for each mass.</td>
</tr>
<tr>
<td>Specified masses</td>
<td>Yes</td>
<td>Yes</td>
<td>Extracts ions from any type of spectrum or chromatogram. Select up to ten start and stop masses for which to generate XICs.</td>
</tr>
</tbody>
</table>

**Generate an XIC Using a Selected Range**

1. Open a data file containing spectra.
2. Select a range by pressing the left mouse button at the start of the range, dragging the cursor to the stop point, and then releasing the left mouse button.
   
   The selection is indicated in blue.
3. Click **Explore > Extract Ions > Use Range**.
   
   An XIC of the selection opens in a pane below the spectrum pane. The experiment information at the top of the pane contains the mass range and the maximum intensity in counts per second.

**Generate an XIC Using the Maximum Peak**

1. Open a data file containing spectra.
2. Select a range in a spectrum.
   
   The selection is indicated in blue.
3. Click Explore > Extract Ions > Use Maximum.

An XIC of the maximum peak specified selection opens below the spectrum pane. The experiment information at the top of the pane contains the mass range and the maximum intensity in counts per second.

**Generate an XIC Using Base Peak Masses**

1. Open a data file containing spectra.
2. In a BPC, select the peak from which to extract ions.

The selection is indicated in blue.

3. Click Explore > Extract Ions > Use Base Peak Masses.

An XIC of the specified selection opens below the spectrum pane. The experiment information at the top of the pane shows the mass range and the maximum intensity in counts per second.

**Extract Ion by Selecting Masses**

1. Open a spectrum or chromatogram.
2. Click Explore > Extract Ions > Use Dialog.
3. Type the values for each XIC to be created. If a stop value is not typed, then the range is defined by the start value.
   - In the Start field, type the start value (lower value) for the mass range.
   - In the Stop field, type the stop value (higher value) for the mass range.

4. Click OK.

   An XIC of the selection opens below the chromatogram pane. The experiment information at the top of the pane includes the masses and the maximum intensity in counts per second.

**Generate BPCs**

BPCs can be generated only from single-period, single-experiment data.

1. Open a data file.
2. Select an area within a TIC.

   The selection is indicated in blue.
3. Click **Explore > Show > Show Base Peak Chromatogram**.

The selections are shown in the **Start Time** and **End Time** fields.

**Figure 10-6 Base Peak Chromatogram Options**

![Base Peak Chromatogram Options](image)

4. In the **Mass Tolerance** field, type the value to indicate the mass range used to find a peak. The software finds the peak using a value twice the typed range (± the mass value).

5. Type the intensity below which peaks are ignored by the algorithm in the **Minimum Intensity** field.

6. Type the mass that determines the beginning of the scan range in the **Minimum Mass** field.

7. Type the mass that determines the end of the scan range in the **Maximum Mass** field.

8. To set the start and end times, select the **Use Limited Range** check box and do the following:
   - In the **Start Time** field, type the time that determines the start of the experiment.
   - In the **End Time** field, type the time that determines the end of the experiment.

9. Click **OK**.

The BPC is generated in a new pane.
Generate XWCs

An XWC is a wavelength chromatogram created by taking intensity values at a single wavelength, or by the sum of the absorbance for a range of several wavelengths. Up to three ranges can be extracted from a DAD spectrum to generate the XWC. Refer to Table 10-8 on page 127 for more information about using the available icons.

1. Open a data file that contains a DAD spectrum.
2. Right-click anywhere in the pane and then click Extract Wavelengths.

![Figure 10-7 Extract Wavelengths Dialog](image)

3. Type **Start** and **Stop** values.
4. Click **OK**.

   The XWC is shown in a pane below the DAD spectrum.

Generate DAD Data

Like mass spectrometer data, DAD data can be viewed in chromatogram or spectrum form. Users can view the DAD spectrum for a single point in time, or for a range of time as a Total Wavelength Chromatogram (TWC).

1. Open a data file containing data acquired with a DAD.

   The TWC, which is analogous to a TIC, opens in a pane below the TIC.
2. In the TWC pane, click a point to select a single point in time, or highlight an area of the spectrum to select a range of time.
3. Click **Explore > Show > Show DAD Spectrum**.

   The DAD spectrum opens in a pane below the TWC. The Y-axis shows the absorbance and the X-axis shows the wavelength.
**Generate TWCs**

A TWC is a less commonly used chromatogram. It shows the total absorbance (mAU) as a function of time. The TWC provides a way of viewing an entire data set in a single pane. It consists of the summed absorbances of all ions in a scan plotted against time in a chromatographic pane. If the data contains results from multiple experiments, then create individual TWCs for each experiment and another TWC that represents the sum of all experiments.

A TWC shows total absorbance (mAU) on the Y-axis plotted against time on the X-axis. Refer to Table 10-8 on page 127 for more information about using the available icons.

1. Open a data file that contains a DAD spectrum.
2. Click **Explore > Show > Show DAD TWC**.

The TWC is shown in a pane below the DAD spectrum.

**Adjust the Threshold**

The threshold is an invisible line drawn parallel to the X-axis of a graph that sets a limit below which the software will not include peaks in a spectrum. The line has a handle, represented by a blue triangle to the left of the Y-axis. Click the blue triangle to view a dotted line that represents the threshold. The threshold can be raised or lowered, but changing the threshold value does not change the data. The software does not label any peaks in the region that lies below the threshold.

1. Open a data file.
2. Do one of the following:
   - To raise the threshold, drag the blue triangle up the Y-axis. To lower the threshold, drag the blue triangle down.
   - Click **Explore > Set Threshold**. In the Threshold Options dialog that opens, type the threshold value and then click **OK**.
   - Click **Explore > Threshold**.

The graph updates to show the new threshold. Peak labeling and the peak list are also updated.

**Tip!** To view the current threshold value, move the pointer over the threshold handle.
## Chromatogram Panes

### Table 10-6 Right-click Menu for Chromatogram Panes

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Data</td>
<td>Lists the data points and integrates the peaks found in chromatograms.</td>
</tr>
<tr>
<td>Show Spectrum</td>
<td>Generates a new pane containing the spectrum.</td>
</tr>
<tr>
<td>Show Contour Plot</td>
<td>Shows a color-coded plot of a data set, where the color represents the intensity of the data at that point. Only certain MS modes are supported.</td>
</tr>
<tr>
<td>Extract Ions</td>
<td>Extracts a specific ion or set of ions from a selected pane and then generates a new pane containing a chromatogram for the specific ions.</td>
</tr>
<tr>
<td>Show Base Peak Chromatogram</td>
<td>Generates a new pane containing a base peak chromatogram.</td>
</tr>
<tr>
<td>Show ADC Data</td>
<td>Generates a new pane containing the ADC data trace, if acquired.</td>
</tr>
<tr>
<td>Show UV Detector Data</td>
<td>Generates a new pane containing the UV data trace, if acquired.</td>
</tr>
<tr>
<td>Spectral Arithmetic Wizard</td>
<td>Opens the Spectral Arithmetic Wizard.</td>
</tr>
<tr>
<td>Save to Text File</td>
<td>Generates a text file containing the data in a pane, which can be opened in Microsoft Excel or other programs.</td>
</tr>
<tr>
<td>Save Explore History</td>
<td>Saves information about changes to processing parameters, also called processing options, that were made when a wiff file was processed in Explore mode. The processing history is stored in a file with an eph (Explore Processing History) extension.</td>
</tr>
<tr>
<td>Add Caption</td>
<td>Adds a caption at the cursor point in the pane.</td>
</tr>
<tr>
<td>Add User Text</td>
<td>Adds a text box at cursor point in the pane.</td>
</tr>
<tr>
<td>Set Subtract Range</td>
<td>Sets the subtract range in the pane.</td>
</tr>
<tr>
<td>Clear Subtract Range</td>
<td>Clears the subtract range in the pane.</td>
</tr>
<tr>
<td>Subtract Range Locked</td>
<td>Locks or unlocks the subtract ranges. If the subtract ranges are not locked, then each subtract range can be moved independently. The subtract ranges are preset to locked.</td>
</tr>
<tr>
<td>Delete Pane</td>
<td>Deletes the selected pane.</td>
</tr>
</tbody>
</table>
Spectra Panes

Table 10-7 Right-click Menu for Spectra Panes

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Data</td>
<td>Lists the data points and integrates chromatograms.</td>
</tr>
<tr>
<td>Show TIC</td>
<td>Generates a new pane containing the TIC.</td>
</tr>
<tr>
<td>Extract Ions (Use Range)</td>
<td>Extracts a specific ion or set of ions from a selected pane and then</td>
</tr>
<tr>
<td></td>
<td>generates a new pane containing a chromatogram for the specific ions.</td>
</tr>
<tr>
<td>Extract Ions (Use Maximum)</td>
<td>Extracts ions using the most intense peak in a selected area.</td>
</tr>
<tr>
<td>Save to Text File</td>
<td>Generates a text file of the pane, which can be opened in Microsoft Excel</td>
</tr>
<tr>
<td></td>
<td>or other programs.</td>
</tr>
<tr>
<td>Save Explore History</td>
<td>Saves information about changes to processing parameters, also</td>
</tr>
<tr>
<td></td>
<td>called Processing Options, that were made when a wiff file was</td>
</tr>
<tr>
<td></td>
<td>processed in Explore mode. The processing history is stored in a file</td>
</tr>
<tr>
<td></td>
<td>with an eph (Explore Processing History) extension.</td>
</tr>
<tr>
<td>Add Caption</td>
<td>Adds a caption at the cursor position in the pane.</td>
</tr>
<tr>
<td>Add User Text</td>
<td>Adds a text box at the cursor position in the pane.</td>
</tr>
<tr>
<td>Show Last Scan</td>
<td>Shows the scan prior to the selection.</td>
</tr>
<tr>
<td>Select Peaks For Label</td>
<td>In this dialog, select the parameters to reduce peak labeling.</td>
</tr>
<tr>
<td>Delete Pane</td>
<td>Deletes the selected pane.</td>
</tr>
<tr>
<td>Add a Record</td>
<td>Adds records and compound-related data, including spectra, to the library. An active spectrum is required to perform this task.</td>
</tr>
<tr>
<td>Search Library</td>
<td>Searches the library without constraints or with previously saved</td>
</tr>
<tr>
<td></td>
<td>constraints.</td>
</tr>
<tr>
<td>Set Search Constraints</td>
<td>Searches the library using the criteria typed in <strong>Search Constraints</strong> dialog.</td>
</tr>
</tbody>
</table>

Graphical Data Processing

Graphical data can be processed many ways. This section provides information and procedures for using some of the most commonly used tools.
The user can zoom in on part of a graph to view a particular peak or an area in greater detail in both spectra and chromatograms. The user can also zoom in repeatedly to view smaller peaks.

**Graphs**

The same data can be examined in different ways. Data can also be kept for comparison purposes before performing processing operations such as smoothing or subtraction.

A window contains one or more panes arranged in such a way that all the panes are fully visible and that they do not overlap.

Panes might be of a variable or fixed size. Panes are automatically tiled within the window and are arranged into column and row format. If the size of a window is changed, then the panes within the window change in size to accommodate the new size. A window cannot be sized to the point where any of the panes become smaller than their minimum size.

Two or more windows or panes containing similar data can be linked, for example, spectra with similar mass ranges. As one pane or window is zoomed in, the other pane zooms in simultaneously. For example, the user can link an XIC to the BPC from which the XIC was extracted. Zooming in the BPC also zooms the XIC, so that both chromatograms show the same magnification.

**Manage Data**

Data can be compared or examined in different ways. Users might want to keep the data for comparison purposes before performing processing operations such as smoothing or subtraction.

A window contains one or more panes, arranged in such a way that all the panes are fully visible and they do not overlap.

Panes can be of variable or fixed size. Panes are automatically tiled within the window and are arranged into column and row format. If window size is changed, then the panes within the window change in size to accommodate the resizing. A window cannot be resized to the point where any of the panes would become smaller than its minimum size.

Two or more windows or panes containing similar data can be linked, for example, spectra with similar mass ranges. When the user zooms in one pane or window, the other pane zooms simultaneously. For example, the user can link an XIC to the BPC from which it was extracted. Zooming in the BPC also zooms the XIC, so that both chromatograms are shown with the same magnification.

- Use the following menu options or icons to manage data in graphs.
### Table 10-8 Graph Options

<table>
<thead>
<tr>
<th>To do this...</th>
<th>use this menu option...</th>
<th>...or click this icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy a graph to a new window</td>
<td>Select the graph to copy. Click <strong>Explore &gt; Duplicate Data &gt; In New Window</strong>.</td>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td>Rescale a graph to its original size</td>
<td>Select the graph. Click <strong>Explore &gt; Home Graph</strong>.</td>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td>Move a pane</td>
<td>• Select the graph. Click <strong>Window &gt; Move Pane</strong>.</td>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td></td>
<td>• Select the pane or window and then drag it to the new position. This position can be inside the same window or within another window.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A four-headed arrow is shown when the cursor is on the boundary of the active window or pane.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If the pane is at the top or bottom of the target pane, then the pane moves above or below that pane, respectively.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If the pane is at the left or right of the target pane, then the pane moves to the left or right of that pane, respectively.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If the pane is at any other position, then the pane moves to the target row. The drop shadow of the pane as the pane is moved indicates its new position.</td>
<td></td>
</tr>
<tr>
<td>Link panes</td>
<td>a. With the two graphs open, click one to make that pane active.</td>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td></td>
<td>b. Click <strong>Explore &gt; Link</strong> and then click the other pane.</td>
<td></td>
</tr>
<tr>
<td>Remove linking</td>
<td>Close one of the panes. Click <strong>Explore &gt; Remove Link</strong>.</td>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td>Delete a pane</td>
<td>Select the graph. Click <strong>Window &gt; Delete Pane</strong>.</td>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td>Lock a pane</td>
<td>Select the graph. Click <strong>Window &gt; Lock Panes</strong>.</td>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td>Hide a pane</td>
<td>Select the graph. Click <strong>Window &gt; Hide Pane</strong>.</td>
<td><img src="image" alt="Icon" /></td>
</tr>
</tbody>
</table>
### Table 10-8 Graph Options (continued)

<table>
<thead>
<tr>
<th>To do this...</th>
<th>use this menu option...</th>
<th>...or click this icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize a pane</td>
<td>Select the graph. Click <strong>Window &gt; Maximize Pane.</strong></td>
<td>![Maximize Pane Icon]</td>
</tr>
<tr>
<td>Tile panes</td>
<td>Select the graph. Click <strong>Window &gt; Tile all Panes.</strong></td>
<td>![Tile Panes Icon]</td>
</tr>
</tbody>
</table>

### Zoom In on the Y-axis

1. Move the pointer to the left of the Y-axis to either side of the area to be expanded and then drag away from the starting point in a vertical direction while holding the left mouse button.

   A box is drawn along the y-axis representing the new scale.

   **Note:** Take care when zooming in on the baseline. Zoom in too far and the zoom-in box closes.

2. Release the mouse button to draw the graph to the new scale.

### Zoom In on the X-axis

**Tip!** To return the graph to the original scale, double-click either axis. To restore the entire graph to the original scale, click **Explore > Home Graph.**

1. Move the pointer under the X-axis to either side of the area to be expanded and then drag away from the starting point in a horizontal direction while holding the left mouse button.

2. Release the mouse button to draw the graph to the new scale.
The Reporter software extends the reporting functionality available in the Analyst® software.

We recommend that users validate the results if a modified Reporter template or one that contains a query is used. The Reporter software can be used to create custom reports with Microsoft Word and Excel (2010, 2013, or 2016). The Reporter software has the following features:

- Provides a variety of reports that use the data available in a Results Table, in file information, and in quantitative peak review windows.
- Provides a variety of reports that present MS/MS library search results. The user can configure the Reporter software to search against any MS/MS spectral library that uses the Analyst® (mdb) format.
- Uses Microsoft Word templates to provide the format information needed when generating reports. These templates can be created or modified to provide customized report formats. Refer to the Help for information about creating or editing the Report Template Editor.
- Contains a blank starting template that can be used in the Analyst® software Reporter editing environment to design report templates to meet most reporting requirements.
- Automates report generation through the use of the Autoquan Reporter batch script.
- Automatically prints, exports to Adobe Portable Document Format (pdf), and delivers results by e-mail.
- Attaches processing scripts to report templates to expand both the content and automation level for various workflow requirements.
- Generates reports from custom software applications that use the available Analyst® software programming libraries.

Reporter software can be used as follows:

- Within the Analyst® software to manually generate a report or set of reports.
- By a batch script to automate report generation within a batch. Users can generate reports on a sample-by-sample basis, either during or after batch acquisition.
- By applications that do not use the Analyst® software.
Analyst Reporter User Interface

Figure 11-1 Analyst Reporter

1. Analyst Reporter
2. File
3. Settings
4. Help
5. Current Output Language
6. Current Spectral Library
7. Available Templates
8. Output Format
9. Print Automatically
10. Create Report

Sample.mdb
English
Description
Report showing for each sample a section including File Information, Sample info, IS info, Analyte results table, XIC table including IS and each analyte - WILL GENERALLY PRINT 2 PAGES PER SAMPLE FOR < 8 ANALYTES
<table>
<thead>
<tr>
<th>Item</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>File &gt; Exit</td>
<td>Exits the program and releases all resources.</td>
</tr>
<tr>
<td>2</td>
<td>Settings &gt; Select Output Language</td>
<td>Sets the language dictionary that will be used to replace language tags within a report template. Templates that contain language tags can be used to generate reports in any language. The language tags are replaced with text from a matching tag in the dictionary file for the selected language. These dictionary files are contained in the folder: C:\Program Files\AB SCIEX\AnalystReporter\Resources\Languages on Windows 7, 32-bit operating systems or C:\Program Files (x86)\AB SCIEX\AnalystReporter\Resources\Languages on Windows 7, 64-bit or Windows 10, 64-bit operating systems.</td>
</tr>
<tr>
<td>2</td>
<td>Settings &gt; Select Library</td>
<td>Browse to a spectral library. This library will be used for matching and scoring MS/MS data from Results Tables that contain data from information dependent acquisition (IDA) triggered MS/MS scan types.</td>
</tr>
<tr>
<td>2</td>
<td>Settings &gt; Select Template Folder</td>
<td>Sets the folder from which the available templates will be read. To return to the default template folder, select the Default option.</td>
</tr>
<tr>
<td>3</td>
<td>Help &gt; About</td>
<td>Shows information about the version of Reporter software currently installed.</td>
</tr>
<tr>
<td>4</td>
<td>Current Output Language</td>
<td>Shows the currently selected language dictionary used for replacing language tags within a report template. The language dictionary can be selected using Settings &gt; Select Output Language.</td>
</tr>
<tr>
<td>5</td>
<td>Current Spectral Library</td>
<td>Shows the currently selected spectral library. The spectral library can be selected using Settings &gt; Select Library.</td>
</tr>
<tr>
<td>6</td>
<td>Available Templates and Description</td>
<td>Shows a list of available report templates. Selecting a template will show a description of the template. To change the folder from which available templates are read, select Settings &gt; Select Template Folder &gt; Browse.</td>
</tr>
</tbody>
</table>
The Reporter software extracts numerical data from the Results Table and sample and graphical information from the wiff file.

Select a template in the Available Template field.

**Tip!** For reports that can be generated on a sample-by-sample basis, it may be more efficient to generate the reports automatically using a batch script during acquisition to avoid long processing times at the end of the acquisition. For more information about batch scripts, refer to the *Scripts User Guide*.

1. Open a **Results Table**.
2. Under **Companion Software**, double-click **Reporter**.

3. In the **Analyst Reporter** dialog, in the **Available Templates** field, select the applicable report template.

4. Click the **PDF** output format.

   The Word option is pre-selected and the report is automatically saved in the current project Results folder. If this option is not selected, then the report is created and opened in Word or printed as selected, but the report is not saved. This lets the user edit the report in Word prior to saving the original report.

5. Select either one document containing all samples or multiple documents with one sample in each.

6. (Optional) Select the **Print Automatically** check box to print the reports automatically on a pre-selected printer.

   The Default Printer set in Windows is used unless a different printer is selected. The Reporter tool retains the selected printer between operations. If the printer is set to a PDF printer driver, then the Reporter generates PDF file versions of the created reports automatically.

7. Click **Create Report**.

   The screen shows various progress indicators as the tool opens the template and populates it with data from the Results Table. Some reports can take seconds to generate, others can take longer. A large data set with many MRM transitions or a large number of graphics might result in reports of several hundred pages that take hours to generate.
CAUTION: Potential System Damage. If the HPLC system connected to the mass spectrometer are not controlled by the software, then do not leave the mass spectrometer unattended while in operation. The liquid stream from the HPLC system can flood the ion source when the mass spectrometer goes into Standby mode.

Set Queue Options

The queue goes one-by-one through the list, acquiring each sample with the selected acquisition method. After all of the samples have been acquired, the queue stops and the mass spectrometer goes into Standby mode. In Standby mode, the LC pumps and some instrument voltages are turned off.

The user can change the length of time the queue runs after the last acquisition has finished, before the Analyst software puts the mass spectrometer into Standby mode. For information about the other fields in the Queue Options dialog, refer to the Help.

1. On the Navigation bar, click Configure.
2. Click Tools > Settings > Queue Options.

Figure 12-1 Queue Options Dialog
3. In the **Max. Num. Waiting Samples** field, set the maximum number of samples to a value that is greater than the number of samples that will be submitted to the queue.

4. In the **Max. Idle Time** field, type the length of time the queue will wait after acquisition is completed before going to Standby mode. The preset value is 60 minutes.

   If gas cylinders are used, then adjust this time to make sure that the gas in the cylinders is not depleted.

   If an LC method is used, then before the run is started, make sure that there is enough solvent in the reservoirs for all of the sample runs at the primary flow rate and the maximum idle time.

5. Select the **Leave Mass Spec on in Standby** check box to keep the mass spectrometer running after analysis has been completed. This feature allows the heaters and gases to continue running, even after devices have entered Idle state, so that the ion source and entrance to the mass spectrometer are kept free of contaminants.

6. Select the **Fail Whole Batch in Case of Missing Vial** check box to fail the entire batch when a missing vial is encountered. If this option is not selected, then only the current sample will fail and the queue will continue to the next sample.

## Create and Submit a Batch

Use this workflow to create a batch. In this example, use the MRM scan type that was created previously. Go through the workflow twice more for practice, once using the Q1MS method and the second time using the Q1MI method.

## Add Sets and Samples to a Batch

A set can consist of a single sample or multiple samples.

**Note:** For more information about adding quantitation information to a batch, refer to the *Advanced User Guide*.

1. On the Navigation bar, under **Acquire**, double-click **Build Acquisition Batch**.
2. In the Sample tab, in the Set list, type a name.
3. Click **Add Set**.
4. Click **Add Samples** to add samples to the new set.

**Figure 12-3 Add Sample Dialog**
5. In the **Sample name** section, in the **Prefix** field, type a name for the samples in this set.

6. To add incremental numbering to the end of the sample name, select the **Sample number** check box.

7. If the **Sample number** check box is selected, then in the **Number of digits** field, type the number of digits to include in the sample name.

   For example, if 3 is typed, then the sample names would be samplename001, samplename002, and samplename003.

8. In the **Data file** section, in the **Prefix** field, type a name for the data file that will store the sample information.

9. Select the **Set name** check box to use the set name as part of the data file name.

10. Select the **Auto Increment** check box to increment the data file names automatically.

   **Note:** The data for each sample can be stored in the same or a separate data file. The names of the data file will have numerical suffixes starting from 1.

11. Type a name in the **Sub Folder** field.

   The folder is stored in the Data folder for the current project. If the **Sub Folder** field is left blank, then the data file is stored in the **Data** folder and a subfolder is not created.

12. In the **New samples** section, in the **Number** field, type the number of new samples to add.

13. Click **OK**.

   The sample table fills with the sample names and data file names.

   **Tip!** **Fill Down** and **Auto Increment** options are available in the right-click menu after a single column heading or several rows in a column are selected.

14. On the Sample tab, in the **Acquisition** section, select a method from the list.

   Depending on how the system is set up, specific information for the autosampler must be entered. Even if the injection volume is set in the method, the user can change the injection volume for one or more samples by changing the value in the injection volume column.

   **Note:** To use different methods for some of the samples in this set, select the **Use Multiple Methods** check box. The **Acquisition Method** column is shown in the **Sample** table. Select the acquisition method for each sample in this column.

15. To change the injection volumes from the volumes listed in the method, in the **Inj. Volume (µL)** column, type the injection volume for each sample.

16. To set sample locations, do one of the following:
Operating Instructions — Batches

- Set Sample Locations in the Batch Editor on page 140
- Select Vial Positions Using the Locations Tab (Optional) on page 141

17. (Optional) To define quantitation details prior to submitting the batch, refer to Set Quantitation Details in the Batch Editor (Optional) on page 142.

18. Click the Submit tab.

**Note:** The order of samples can be edited before the samples are submitted to the queue. To change the order of samples, on the Submit tab, double-click any of the numbers at the far left of the table (a very faint square box is shown), and then drag them to the new location.

19. If the Submit Status section contains a message about the status of the batch, then do one of the following:

   - If the message indicates that the batch is ready for submission, then proceed to step 20.
   - If the message indicates that the batch is not ready for submission, then make the changes as indicated by the message.

20. After confirming that all of the batch information is correct, click Submit.

   The batch is submitted to the queue and can be viewed in the Queue Manager.

21. Save the file.

**Equilibrate the System**

Equilibrate the system before submitting a batch. Equilibration warms up and prepares the mass spectrometer for the next sample or batch.

1. Click ◐.

   The Equilibrate dialog opens.

2. Select the acquisition method used for the submitted batch.

3. Type the equilibration time in the **Time (min)** field, in minutes.

4. Select OK. The system starts the equilibration.

   After the equilibration is completed, the system will change to Ready status.
Tip! If the equilibration does not finish as expected, or if the system status does not change to Ready after the equilibration finishes, then make sure that

- The activated hardware profile is appropriate for the acquisition method.
- The HPLC system is turned on.
- The HPLC system has correctly established communication with the software.

Submit a Sample or Set of Samples

Note: Run the sample again in the event of an abnormal termination during sample acquisition. If the abnormal termination is caused by a power failure, then the temperature of the autosampler tray is not maintained and sample integrity might be compromised.

1. Select one sample or a set of samples.
2. Click the Submit tab in the Batch Editor.
3. If the Submit Status section contains a message about the status of the batch, then do one of the following:
   - If the message indicates that the batch is ready for submission, then proceed to the next step.
   - If the message indicates that the batch is not ready for submission, then make the changes as indicated by the message.
4. Click Submit.

Change Sample Order

The order of the samples can be edited before the samples are submitted to the Queue.

- On the Submit tab, double-click any of the numbers at the far left of the table (a very faint square box is visible), and then drag them to the new location.

Acquire Data

The system must not be in Tune and Calibrate mode when sample acquisition is started. Also, if the system has been previously run that day and has not yet been set to Standby mode, then sample acquisition will start automatically.

1. Make sure that the column oven temperature is reached.
Operating Instructions — Batches

2. Make sure that the icon is not pressed in.
4. Click View > Sample Queue.

The Queue Manager opens with all submitted samples.

**Figure 12-4 Queue Manager**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The Reserve Instrument for Tuning icon should not be pressed in.</td>
</tr>
<tr>
<td>2</td>
<td>Queue status should be in Ready mode.</td>
</tr>
<tr>
<td>3</td>
<td>Queue Server should be in Normal. Refer to Queue States on page 145.</td>
</tr>
</tbody>
</table>

5. Click Acquire > Start Sample.

**Set Sample Locations in the Batch Editor**

If an autosampler is used in the acquisition method, then the vial positions of the samples must be defined in the acquisition batch. Define the location in the Sample tab or in the Locations tab. For more information about creating batches, refer to Add Sets and Samples to a Batch on page 135.

1. In the Sample tab, from the Set list, select the set.
2. For each sample in the set, do the following if applicable:
   - In the Rack Code column, select the rack type.
   - In the Rack Position column, select the position of the rack in the autosampler.
   - In the Plate Code column, select the plate type.
   - In the Plate Position column, select the position of the plate on the rack.
   - In the Vial Position column, type the position of the vial in the plate or tray.
3. Save the file.
Select Vial Positions Using the Locations Tab (Optional)

1. Click the Locations tab in the Batch Editor.
2. Select the set from the Set list.
3. Select the autosampler from the Autosampler list.
4. In the space associated with the rack, right-click and then select the rack type.
   
   The plates or trays are shown in the rack.
5. Double-click in the white space labeled rack type. A visual sample rack layout is shown.
   
   The appropriate number of rack spaces for the autosampler is shown in the graphic rack view.
6. Double-click one of the rectangles.
   
   The circles depicting the wells or vials for the plate or tray are shown.

   **Tip!** To see the corresponding vial number in the graphical representation, move the cursor over the sample position. Use this information to confirm that the vial positions in the software match the vial positions in the autosampler.

**Figure 12-5 Locations Tab**

![Locations Tab Diagram]

**Note:** Depending on the autosampler being used, it might not be necessary to type details in additional columns.

7. To select whether samples are marked by row or column, click the Row/Column selection selector button.

   If the button shows a red horizontal line, then the Batch Editor marks the samples by row. If the button shows a red vertical line, then the Batch Editor marks the samples by column.
8. Click the sample wells or vials in the order to be analyzed.

**Tip!** Click a selected well or vial again to clear it.

**Tip!** To fill in the samples automatically, press the **Shift** key while clicking the first and last vial within a set. To perform multiple injections from the same vial, press the **Ctrl** key while clicking the vial location. The red circle changes to a green circle.

---

**Set Quantitation Details in the Batch Editor (Optional)**

If a quantitation method is used with a batch and if the user does not want to select quantitation details after acquisition, then the quantitation details (sample type, sample concentration) must be defined before the batch is submitted.

The appropriate Internal Standard and Standard columns are shown in the Quantitation tab according to the quantitation method selected in the Sample tab.

1. With a batch file open in the **Batch Editor** window, click the **Quantitation** tab.
2. Select the set containing the samples.
3. Select a **Quant Type** for all the samples from the list in the cell.
4. If applicable, type the analyte concentration in the **Analyte** column.
5. If applicable, type the internal standard concentration in the **Internal Standard** column.
6. Repeat this procedure for each set in the batch.

---

**Stop Sample Acquisition**

When a sample acquisition is stopped, the current scan finishes before the acquisition is stopped.

1. In the **Queue Manager**, click the sample in the queue after the point where acquisition should stop.
2. On the Navigation bar, click **Acquire**.
3. Click **Acquire > Stop Sample**.

The queue stops after the current scan in the selected sample is complete. The sample status in the **Queue Manager (Local)** window changes to **Terminated**, and all other samples following in the queue are **Waiting**.

4. To continue processing the batch, click **Acquire > Start Sample**.
Import Batch Files

Users can import a text file containing batch information instead of creating a batch in the **Batch Editor**. If all the sample details are in a spreadsheet, then it is faster to rearrange and import the data in the spreadsheet than to manually type the data into the **Batch Editor**.

Before importing batch information from a text file, make sure that the data in the file is organized and formatted correctly. In particular, the column headings in the spreadsheet must match the **Batch Editor** column headings.

Build a Batch as a Text File

<table>
<thead>
<tr>
<th>Prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make sure that the active hardware profile includes all of the devices to be used to acquire the samples.</td>
</tr>
</tbody>
</table>

To make sure that the text file includes the proper headings, create a batch using the Batch Editor, export it as a text file, type the appropriate values in a spreadsheet editor, and then import the file back into the Batch Editor. Users can export a batch only if it contains at least one set with at least one sample. The saved text file can be used again later as a template.

1. In the **Batch Editor**, create a single-set, single-sample batch.
2. Click **File > Export**.
   - The **Save As** dialog opens.
3. Type a name for the text file in the **File name** field and then click **Save**.
4. Open the text file in a spreadsheet program such as Microsoft Excel.
5. Type, or copy and paste, the details for the samples: one sample per row, with the details under the appropriate headings.

   **Note:** Do not delete any of the columns. The columns in the spreadsheet must match the columns in the **Batch Editor**.

6. Save the modified text file as a .txt or .csv file and then close the spreadsheet program.

   The text file is now ready to be imported into the **Batch Editor**.

Import a Batch from a Text File

1. In the **Batch Editor**, in the **Sample** tab, right-click, and then click **Import From > File**.
   - The **Open** dialog opens.
2. Click the required text file and then click **Open**.
If an autosampler is used, then the Select Autosampler dialog opens.

**Note:** If the saved text file is not visible in the Files of type list, then select Microsoft Text Driver (*.txt; *.csv). Files with the extension .txt are shown in the field.

3. In the autosampler list, select the autosampler and then click OK.

   The sample table fills with the details from the text file.

4. Submit the batch.

### Batch Editor Right-click Menu

Right-click in the Batch Editor table to access the options.

**Figure 12-6 Batch Right-Click Menu**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens a batch file.</td>
</tr>
<tr>
<td>Import From</td>
<td>Imports a file.</td>
</tr>
<tr>
<td>Save As Batch</td>
<td>Saves the batch with a different name.</td>
</tr>
<tr>
<td>Save As a Template</td>
<td>Saves the batch as a template.</td>
</tr>
<tr>
<td>Hide/Show Column</td>
<td>Hides or shows a column.</td>
</tr>
<tr>
<td>Menu</td>
<td>Function</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Save Column Settings</td>
<td>Saves the batch column settings.</td>
</tr>
<tr>
<td>Add Custom Column</td>
<td>Adds a custom column.</td>
</tr>
<tr>
<td>Delete Custom Column</td>
<td>Deletes a custom column.</td>
</tr>
<tr>
<td>Fill Down</td>
<td>Copies the same data into the selected cells.</td>
</tr>
<tr>
<td>AutoIncrement</td>
<td>Automatically increments data into the selected cells.</td>
</tr>
<tr>
<td>Delete Samples</td>
<td>Deletes the selected row.</td>
</tr>
<tr>
<td>Select Autosampler</td>
<td>Selects an autosampler.</td>
</tr>
</tbody>
</table>

**Queue States and Device Status**

The **Queue Manager** shows queue, batch, and sample status. Detailed information about a particular sample in the queue can also be viewed.

**Tip!** Click ![Image](image.png) to view the queue.

**Queue States**

The current state of the queue is indicated in the **Queue Server**.

**Figure 12-7 Queue Server Indicator Showing Normal Mode**

![Image](image.png)

**Figure 12-8 Queue Server Indicator Showing Tune Mode**

![Image](image.png)

The first icon indicates the queue state. The second icon indicates whether the queue is in **Tune** mode (for tuning) or **Normal** mode (for running samples). **Table 12-1** describes the icons and queue states.
Table 12-1 Queue States

<table>
<thead>
<tr>
<th>Icons</th>
<th>State</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Queue Server" /> Not Ready Normal</td>
<td>Not Ready</td>
<td>The hardware profile is deactivated and the queue is not accepting any sample submissions.</td>
</tr>
<tr>
<td><img src="image2" alt="Queue Server" /> Stand By Normal</td>
<td>Stand By</td>
<td>The hardware profile has been activated, but all devices are idle. Pumps are not running and gases are turned off.</td>
</tr>
<tr>
<td><img src="image3" alt="Queue Server" /> Warming Up Normal</td>
<td>Warming Up</td>
<td>The mass spectrometer and devices are equilibrating, columns are being conditioned, the autosampler needle is being washed, and column ovens are reaching temperature. The duration of equilibration is selected by the operator. From this state, the system can go to the Ready state.</td>
</tr>
<tr>
<td><img src="image4" alt="Queue Server" /> Ready Normal</td>
<td>Ready</td>
<td>The system is ready to start running samples and the devices have been equilibrated and are ready to run. In this state, the queue can receive samples and will run after samples are submitted.</td>
</tr>
<tr>
<td><img src="image5" alt="Queue Server" /> Waiting Normal</td>
<td>Waiting</td>
<td>The system will automatically begin acquisition when the next sample is submitted.</td>
</tr>
<tr>
<td><img src="image6" alt="Queue Server" /> PreRun Normal</td>
<td>PreRun</td>
<td>The method is being downloaded to each device and device equilibration is occurring. This state occurs before the acquisition of each sample in a batch.</td>
</tr>
<tr>
<td><img src="image7" alt="Queue Server" /> Acquiring Normal</td>
<td>Acquiring</td>
<td>The method is running and data acquisition is occurring.</td>
</tr>
<tr>
<td><img src="image8" alt="Queue Server" /> Paused Normal</td>
<td>Paused</td>
<td>The system has been paused during acquisition.</td>
</tr>
</tbody>
</table>

View Instrument and Device Status Icons

Icons representing the mass spectrometer and each device in the active hardware configuration are shown on the status bar in the bottom right corner of the window. The user can view the detailed status of an LC pump to
determine whether the LC pump pressure is appropriate or view the detailed status of the mass spectrometer to confirm the temperature of the ion source.

**Note:** For each status, the background color can be red. A red background indicates that the device encountered an error while in that state.

- On the status bar, double-click the icon for the device or mass spectrometer.

  The Instrument Status dialog opens.

**Table 12-2 Instrument and Device Status Icons**

<table>
<thead>
<tr>
<th>Status</th>
<th>Icon</th>
<th>Background Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idle</td>
<td><img src="image" alt="Green or yellow" /></td>
<td>Green or yellow</td>
<td>The device is not running. If the background color is yellow, then the device should be equilibrated before it is ready to run. If the background color is green, the device is ready to run.</td>
</tr>
<tr>
<td>Equilibrating</td>
<td><img src="image" alt="Green or yellow" /></td>
<td>Green or yellow</td>
<td>The device is equilibrating.</td>
</tr>
<tr>
<td>Waiting</td>
<td><img src="image" alt="Green" /></td>
<td>Green</td>
<td>The device is waiting for a command from the software or another device, or for some action by the operator.</td>
</tr>
<tr>
<td>Running</td>
<td><img src="image" alt="Green" /></td>
<td>Green</td>
<td>The device is running a batch.</td>
</tr>
<tr>
<td>Aborting</td>
<td><img src="image" alt="Green" /></td>
<td>Green</td>
<td>The device is aborting a run.</td>
</tr>
<tr>
<td>Downloading</td>
<td><img src="image" alt="Green" /></td>
<td>Green</td>
<td>A method is being transferred to the device.</td>
</tr>
<tr>
<td>Ready</td>
<td><img src="image" alt="Green" /></td>
<td>Green</td>
<td>The device is not running, but is ready to run.</td>
</tr>
<tr>
<td>Error</td>
<td><img src="image" alt="Red" /></td>
<td>Red</td>
<td>The device has encountered an error that should be investigated.</td>
</tr>
</tbody>
</table>

**Queue Right-click Menu**

Right-click in the Queue table to access the options.
Figure 12-9 Queue Manager Right-Click Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Details</td>
<td>Opens the Sample Details dialog.</td>
</tr>
<tr>
<td>Reacquire</td>
<td>Acquires a sample again.</td>
</tr>
<tr>
<td>Insert Pause</td>
<td>Inserts a pause, in seconds, between two samples.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes either the batch or the selected samples.</td>
</tr>
<tr>
<td>Move Batch</td>
<td>Moves the batch within the queue.</td>
</tr>
<tr>
<td>Sort</td>
<td>Sorts on the preselected column.</td>
</tr>
<tr>
<td>Column Settings</td>
<td>Changes the column settings.</td>
</tr>
</tbody>
</table>
Regularly clean and maintain the system for optimal performance.

**WARNING!** Electrical Shock Hazard. Do not remove the covers. Removing the covers might cause injury or malfunctioning of the system. The covers need not be removed for routine maintenance, inspection, or adjustment. Contact a SCIEX Field Service Employee (FSE) for repairs that require the covers to be removed.

**WARNING!** Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Determine whether decontamination is required prior to cleaning or maintenance. The customer must decontaminate the system prior to cleaning or maintenance if radioactive materials, biological agents, or toxic chemicals have been used with the system.

### Recommended Maintenance Schedule

*Table 13-1* provides a recommended schedule for cleaning and maintaining the system.

**Tip!** Perform maintenance tasks regularly to make sure that the mass spectrometer is performing optimally.

For information on maintaining the ion source, refer to the ion source *Operator Guide*.

Contact a Qualified Maintenance Person (QMP) to order consumable parts. Contact a SCIEX Field Service Employee (FSE) for maintenance service and support.

#### Table 13-1 Maintenance Tasks

<table>
<thead>
<tr>
<th>Component</th>
<th>Frequency</th>
<th>Task</th>
<th>For more information...</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tubing</td>
<td>Daily</td>
<td>Inspect the tubing and fittings to make sure that they are securely connected, and that there are no leaks.</td>
<td>Refer to <em>Chemical Precautions on page 11</em>.</td>
</tr>
</tbody>
</table>
Table 13-1 Maintenance Tasks (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Frequency</th>
<th>Task</th>
<th>For more information...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mass Spectrometer</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Curtain plate</td>
<td>Daily</td>
<td>Clean</td>
<td>Refer to Clean the Curtain Plate on page 155.</td>
</tr>
<tr>
<td>Orifice plate (front)</td>
<td>Daily</td>
<td>Clean</td>
<td>Refer to Clean the Front of the Orifice Plate on page 156.</td>
</tr>
<tr>
<td>Roughing pump oil</td>
<td>Weekly</td>
<td>Inspect the level</td>
<td>Refer to Inspect the Roughing Pump Oil Level on page 157.</td>
</tr>
<tr>
<td>Mass spectrometer air filter</td>
<td>Every 6 months</td>
<td>Replace</td>
<td>Contact the local QMP or FSE.</td>
</tr>
<tr>
<td>Roughing pump oil</td>
<td>Annually</td>
<td>Replace</td>
<td>Contact the local QMP or FSE.</td>
</tr>
<tr>
<td>Instrument surfaces</td>
<td>As needed</td>
<td>Clean</td>
<td>Refer to Clean the Surfaces on page 151.</td>
</tr>
<tr>
<td>Source exhaust drain bottle</td>
<td>As needed</td>
<td>Empty</td>
<td>Refer to Empty the Source Exhaust Drain Bottle on page 157.</td>
</tr>
<tr>
<td>Orifice plate (front and rear)</td>
<td>As needed</td>
<td>Clean</td>
<td>Contact the local QMP or FSE.</td>
</tr>
<tr>
<td>QJet ® ion guide and IQ0 lens</td>
<td>As needed</td>
<td>Clean</td>
<td>Contact the local QMP or FSE.</td>
</tr>
<tr>
<td>Q0 rod set and IQ1 lens</td>
<td>As needed</td>
<td>Clean</td>
<td>Contact the local QMP or FSE.</td>
</tr>
<tr>
<td>Roughing pump oil</td>
<td>As needed</td>
<td>Refill</td>
<td>Contact the local QMP or FSE.</td>
</tr>
<tr>
<td>Interface heater</td>
<td>As needed</td>
<td>Replace</td>
<td>Contact the local QMP or FSE.</td>
</tr>
<tr>
<td><strong>Ion Source</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TurbolonSpray ® and APCI electrodes</td>
<td>As needed</td>
<td>Inspect and replace</td>
<td>Refer to the ion source Operator Guide.</td>
</tr>
<tr>
<td>Corona discharge needle</td>
<td>As needed</td>
<td>Replace</td>
<td>Refer to the ion source Operator Guide.</td>
</tr>
<tr>
<td>Turbo heater</td>
<td>As needed</td>
<td>Replace</td>
<td>Contact the local QMP or FSE.</td>
</tr>
<tr>
<td>Sample tubing</td>
<td>As needed</td>
<td>Replace</td>
<td>Refer to the ion source Operator Guide.</td>
</tr>
</tbody>
</table>
For “As needed” tasks, follow these guidelines:

- Clean the mass spectrometer surfaces after a spill or when they become dirty.
- Empty the drain bottle before it becomes full.
- Clean the orifice plate, QJet® ion guide, and Q0 region if system sensitivity degrades.

**Tip!** Clean the Q0 region regularly to minimize the impact of charging (a significant loss of sensitivity of the ions of interest over a short period of time) on the quadrupoles and lenses. Contact a QMP or FSE.

- Clean the QJet® ion guide and Q0 region if system sensitivity degrades.

**Tip!** Clean the Q0 region regularly to minimize the impact of charging (a significant loss of sensitivity of the ions of interest over a short period of time) on the quadrupoles and lenses. Contact a QMP or FSE.

- Refill the roughing pump oil when it falls below the minimum oil level.

### Clean the Surfaces

Clean the external surfaces of the mass spectrometer after a spill or when they become dirty.

**CAUTION: Potential System Damage. Use only the recommended cleaning methods and materials to avoid damaging the equipment.**

1. Wipe the external surfaces with a soft cloth dampened with warm, soapy water.
2. Wipe the external surfaces with a soft cloth moistened with water to remove any soap residue.

### Clean the Front-End

The following warning applies to all of the procedures in this section:

**WARNING! Hot Surface Hazard.** Let the ion source cool for at least 30 minutes before starting any maintenance procedures. Surfaces of the ion source and the vacuum interface components become hot during operation.

Clean the mass spectrometer front-end using the routine cleaning method, to:

- Minimize unscheduled system downtime.
- Maintain optimum sensitivity.
- Avoid more extensive cleaning that requires a service visit.
Service and Maintenance Information

When contamination occurs, perform an initial routine cleaning. Clean up to and including the front of the orifice plate. If routine cleaning does not resolve issues with sensitivity, then a full cleaning might be necessary. Contact the local QMP or FSE.

This section provides instructions for performing routine cleaning without breaking vacuum.

Note: Follow all of the applicable local regulations. For health and safety guidelines, refer to Chemical Precautions on page 11.

Symptoms of Contamination

The system might be contaminated if any one of the following is observed:

- Significant loss in sensitivity
- Increased background noise
- Additional peaks that are not part of the sample are shown in full scan or survey scan methods

If any of these issues are observed, then clean the mass spectrometer front-end.

Required Materials

Note: U.S. customers can call 877-740-2129 for ordering information and inquiries. International customers can visit sciex.com/contact-us.

- Powder-free gloves (nitrile or neoprene recommended)
- Safety glasses
- Laboratory coat
- Fresh, high-quality (pure) water (at least 18 Ω de-ionized [DI] water or ultra-pure HPLC-grade water). Old water can contain contaminants that can further contaminate the mass spectrometer.
- MS-grade methanol, isopropanol (2-propanol), or acetonitrile
- Cleaning solution. Use one of:
  - 100% methanol
  - 100% isopropanol
  - 1:1 acetonitrile:water solution (freshly prepared)
  - 1:1 acetonitrile:water with 0.1% acetic acid solution (freshly prepared)
- Clean 1 L or 500 mL glass beaker to prepare cleaning solutions
- 1 L beaker to catch used solvent
- Organic waste container
Tools and Supplies Available from the Manufacturer

<table>
<thead>
<tr>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small poly swab (thermally bonded). Also available in the Cleaning kit.</td>
<td>1017396</td>
</tr>
<tr>
<td>Lint-free wipe (11 cm x 21 cm, 4.3 inches x 8.3 inches). Also available in the Cleaning kit.</td>
<td>018027</td>
</tr>
<tr>
<td>Cleaning kit. Contains the small poly swab, lint-free wipes, Q0 cleaning tool, straight QJet® ion guide cleaning brush, and Alconox packets.</td>
<td>5020761</td>
</tr>
</tbody>
</table>

Cleaning Best Practices

**WARNING! Hot Surface Hazard.** Let the ion source cool for at least 30 minutes before starting any maintenance procedures. Surfaces of the ion source and the vacuum interface components become hot during operation.

**WARNING!** Toxic Chemical Hazard. Refer to the chemical product Safety Data Sheets and follow all of the recommended safety procedures when handling, storing, and disposing of chemicals. For health and safety precautions, refer to the System User Guide.

**WARNING!** Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Determine whether decontamination is required prior to cleaning or maintenance. The customer must decontaminate the system prior to cleaning or maintenance if radioactive materials, biological agents, or toxic chemicals have been used with the system.

**WARNING!** Environmental Hazard. Do not dispose of system components in municipal waste. Follow local regulations when disposing of components.

- Allow the ion source to cool before removing it.
- Always wear clean, powder-free gloves (nitrile or neoprene recommended) for the cleaning procedures.
- After cleaning the mass spectrometer components, and before reassembling them, put on a new, clean pair of gloves.
Service and Maintenance Information

- Do not use cleaning supplies other than those specified in this procedure.
- If possible, prepare cleaning solutions just before cleaning.
- Prepare and store all of the organic solutions and organic-containing solutions in very clean glassware only. Never use plastic bottles. Contaminants can leach from these bottles and further contaminate the mass spectrometer.
- To avoid contaminating the cleaning solution, pour the solution on the wipe or swab.
- Allow only the center area of the wipe to contact the mass spectrometer surface. Cut edges can leave fibers behind.

**Tip!** Wrap the wipe around a thermally-bonded poly swab.

Figure 13-1 Example: Folding the Wipe

- To avoid cross-contamination, discard the wipe or swab after it has touched the surface once.
- Larger parts of the vacuum interface, such as the curtain plate, might require several cleanings, using multiple wipes.
- Only dampen the wipe or swab slightly when applying water or cleaning solution. Water, more often than organic solvents, might cause the wipe to deteriorate, leaving residue on the mass spectrometer.
- Do not rub the wipe across the aperture. Wipe around the aperture to prevent fibers from the wipes from entering the mass spectrometer.
- Do not insert the brush in the aperture on the curtain plate or orifice plate.

Prepare the Mass Spectrometer

**Note:** Mass spectrometers with a NanoSpray® ion source might require a full cleaning for best results. Contact a local QMP or an FSE.

**WARNING!** Hot Surface Hazard. Let the ion source cool for at least 30 minutes before starting any maintenance procedures. Surfaces of the ion source and the vacuum interface components become hot during operation.
CAUTION: Potential System Damage. Do not drop anything into the source drain when the ion source is removed.

Figure 13-2 Source Drain on the Vacuum Interface

1. Deactivate the hardware profile.
2. Remove the ion source. Refer to the ion source Operator Guide.

When the ion source is not in use, store it to protect it from damage and to maintain operating integrity.

Clean the Curtain Plate

CAUTION: Potential System Damage. Do not rest the curtain plate or orifice plate on the aperture tip. Make sure that the conical side of the curtain plate faces up.

CAUTION: Potential System Damage. Do not insert a wire or metal brush into the aperture on the curtain plate, orifice plate, or interface heater to avoid damaging the aperture.

1. Pull the curtain plate off of the vacuum interface and then put it, conical side up, on a clean, stable surface.

The curtain plate is held in place by three retaining ball catches mounted on the orifice plate.

Tip! If the curtain plate does not immediately separate from the orifice plate, then turn the curtain plate slightly (less than 90 degrees) to release the ball spring latches.
2. Dampen a lint-free wipe with pure water and then clean both sides of the curtain plate.

   **Note:** Use multiple wipes, as required.

3. Repeat step 2 using the cleaning solution.

4. Using a dampened wipe or small poly swab, clean the aperture.

5. Wait until the curtain plate is dry.

6. Inspect the curtain plate for solvent stains or lint, removing any residue with a clean, slightly damp, lint-free wipe.

   **Note:** Persistent spotting or filming is an indicator of contaminated solvent.

---

**Clean the Front of the Orifice Plate**

**CAUTION: Potential System Damage.** When cleaning the surface of the orifice plate, do not remove the interface heater. Frequent removal of the interface heater can result in damage to the interface heater. Surface cleaning of the interface heater is adequate for routine cleaning.

**CAUTION: Potential System Damage.** Do not insert a wire or metal brush into the aperture on the curtain plate, orifice plate, or interface heater to avoid damaging the aperture.

1. Dampen a lint-free wipe with water and then wipe the front of the orifice plate, including the interface heater.

2. Repeat step 1 using the cleaning solution.

3. Wait until the orifice plate is dry.

4. Inspect the orifice plate for solvent stains or lint, removing any residue with a clean, slightly damp, lint-free wipe.

   **Note:** Persistent spotting or filming is an indicator of contaminated solvent.

---

**Put the Mass Spectrometer Back in Service**

1. Install the curtain plate on the mass spectrometer.

2. Install the ion source on the mass spectrometer. Refer to the ion source *Operator Guide*.

3. Activate the hardware profile. Refer to the *System User Guide*. 
Inspect the Roughing Pump Oil Level

- Inspect the sight glass on the roughing pump to verify that the oil is above the minimum level.

If the oil is below the minimum level, then contact the qualified maintenance person (QMP) or SCIEX field service employee (FSE).

Figure 13-3 Sight Glass

Empty the Source Exhaust Drain Bottle

WARNING! Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Deposit hazardous materials in appropriately labeled waste containers and dispose of them according to local regulations.

WARNING! Radiation Hazard, Biohazard, or Toxic Chemical Hazard. Take care to vent exhaust gases to a dedicated laboratory fume hood or exhaust system and make sure that the ventilation tubing is secured with clamps. Make sure that the laboratory has appropriate air exchange for the work performed.
Inspect the source exhaust drain bottle regularly, and empty it before it becomes full. Also inspect the bottle and its fitting for leaks, and tighten connections or replace components, if required. Follow the steps in this procedure to empty the bottle.

1. Remove the ion source. Refer to the ion source *Operator Guide*.
2. Loosen the clamps connecting the hoses to the cap of the source exhaust drain bottle.
3. Disconnect the hoses from the cap.
4. If applicable, lift the drain bottle out of the holder.
5. Remove the cap from the drain bottle.
6. Empty the drain bottle and then dispose of the waste according to laboratory procedures and local waste regulations.
7. Install the cap on the bottle and then put the bottle in the holder.
8. Attach the hoses to the cap and then secure them tightly with clamps.

**Figure 13-4 Source Exhaust Drain Bottle**
### Service and Maintenance Information

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Connection to vent</td>
</tr>
<tr>
<td>2</td>
<td>Source exhaust drain tubing: 2.5 cm (1.0 inch) inside diameter (i.d.)</td>
</tr>
<tr>
<td>3</td>
<td>Roughing pump exhaust hose: 3.2 cm (1.25 inch) i.d.</td>
</tr>
<tr>
<td>4</td>
<td>Source exhaust drain bottle. Make sure that the bottle is secured to prevent spillage.</td>
</tr>
<tr>
<td>5</td>
<td>Connection to the mass spectrometer: 1.6 cm (0.625 inch) i.d.</td>
</tr>
</tbody>
</table>

**Note:** Source exhaust hose connections at the drain bottle, mass spectrometer, and the lab vent are secured with hose clamps.

### Storage and Handling

**WARNING!** Environmental Hazard. Do not dispose of system components in municipal waste. Follow local regulations when disposing of components.

If the mass spectrometer must be stored for a long time or prepared for shipping, then contact a SCIEX FSE for decommissioning information. To disconnect power from the mass spectrometer, remove the mains supply connector from the AC mains supply.

**Note:** The ion source and mass spectrometer must be transported and stored between −30 °C to +60 °C (−22 °F to 140 °F). Store the system at an altitude not exceeding 2 000 m (6 562 feet) above sea level.
This section contains information for troubleshooting basic system issues. Certain activities can only be carried out by a SCIEX-trained Qualified Maintenance Person (QMP) in the laboratory. For advanced troubleshooting, contact a SCIEX Field Service Employee (FSE).

### Table 14-1 System Issues

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The QJet® ion guide is extremely dirty or frequently becomes dirty.</td>
<td>The Curtain Gas™ flow rate is too low.</td>
<td>Verify the setting for the CUR parameter, and increase it, if applicable.</td>
</tr>
<tr>
<td>A system fault has occurred because the vacuum pressure is too high.</td>
<td>1. The roughing pump oil level is too low.</td>
<td>1. Inspect the roughing pump oil level, and then contact the local QMP or an FSE to add oil.</td>
</tr>
<tr>
<td></td>
<td>2. There is a leak.</td>
<td>2. Inspect and repair leaks.</td>
</tr>
<tr>
<td></td>
<td>3. The wrong orifice plate is installed.</td>
<td>3. Install the correct orifice plate.</td>
</tr>
<tr>
<td>A system fault has occurred because the QPS exciter module temperature is too high.</td>
<td>1. The mass spectrometer air filter is blocked.</td>
<td>Contact the local QMP or FSE.</td>
</tr>
<tr>
<td></td>
<td>2. Ambient temperature is too high.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. The coil box is not tuned.</td>
<td></td>
</tr>
<tr>
<td>The Analyst® software reports that the mass spectrometer is in Fault status because of the ion source.</td>
<td>1. The probe is not installed.</td>
<td>1. Confirm the fault in the Status panel of the device details page.</td>
</tr>
<tr>
<td></td>
<td>2. The probe is not connected securely.</td>
<td>2. Install the probe. Refer to the ion source Operator Guide.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Remove and replace the probe. Tighten the retaining ring securely. Refer to the ion source Operator Guide.</td>
</tr>
<tr>
<td>The Analyst® software indicates that the APCI probe is in use, but the TurbolonSpray® probe is installed.</td>
<td>The F3 fuse is blown.</td>
<td>Contact an FSE.</td>
</tr>
</tbody>
</table>
Table 14-1 System Issues (continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The spray is not uniform.</td>
<td>The electrode is blocked.</td>
<td>Clean or replace the electrode. Refer to the ion source Operator Guide.</td>
</tr>
<tr>
<td>Sensitivity is reduced.</td>
<td>1. The ion source parameters are not optimized.</td>
<td>1. Optimize the ion source parameters. Refer to the Analyst® software Help system.</td>
</tr>
<tr>
<td></td>
<td>2. The mass spectrometer is not optimized.</td>
<td>2. Refer to Clean the Curtain Plate on page 155.</td>
</tr>
<tr>
<td></td>
<td>3. The curtain plate is dirty.</td>
<td>3. Refer to Clean the Front of the Orifice Plate on page 156 or contact the local QMP or FSE.</td>
</tr>
<tr>
<td></td>
<td>4. The orifice plate is dirty.</td>
<td>4. Clean the Q0 region. Contact the QMP or FSE.</td>
</tr>
<tr>
<td></td>
<td>5. The QJet® ion guide or IQ0 lens is dirty.</td>
<td>5. Inspect the syringe or sample line for leaks, and repair any leaks found. Make sure that all fittings are the correct type and size.</td>
</tr>
<tr>
<td></td>
<td>6. The Q0 region is dirty.</td>
<td>6. Verify the sample concentration. Use a fresh sample.</td>
</tr>
<tr>
<td></td>
<td>7. The syringe or sample line is leaking.</td>
<td>7. Remove and install the probe.</td>
</tr>
<tr>
<td></td>
<td>8. The sample has degraded or has a low concentration.</td>
<td>8. Remove and install the ion source, making sure that the latches are properly secured. If this does not resolve the issue, then install and optimize an alternate ion source.</td>
</tr>
<tr>
<td></td>
<td>9. The probe is not installed properly.</td>
<td>9. If the O-rings are on the ion source, then install them on the vacuum interface. If they are missing, then contact an FSE.</td>
</tr>
<tr>
<td></td>
<td>10. The ion source is not installed properly, or it is faulty.</td>
<td>10. Troubleshoot the LC system.</td>
</tr>
<tr>
<td></td>
<td>11. One or more of the O-rings on the vacuum interface is missing.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>12. There is an issue with the LC system or connections.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 14-1 System Issues (continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
</table>
| The mass spectrometer performance has degraded. | 1. The probe is not optimized.  
2. The sample was not prepared correctly or the sample has degraded.  
3. The sample inlet fittings are leaking.                        | 1. Optimize the probe. Refer to the ion source *Operator Guide*.  
2. Confirm that the sample was prepared correctly.  
3. Verify that the fittings are the right size and type and make sure that they are tight. Do not overtighten the fittings. Replace the fittings if leaks continue.  
4. Install and optimize an alternate ion source.  
5. Contact an FSE if the issue persists. |
| Arcing or sparks occur.                       | The position of the corona discharge needle is incorrect.                     | Turn the corona discharge needle toward the curtain plate, and away from the stream of heater gas. Refer to the ion source *Operator Guide*. |

For sales, technical assistance, or service, contact an FSE or visit the SCIEX Web site at sciex.com for contact information.
The user must control the autosampler and injection valve manually, as these devices cannot be controlled through the system while it is in Tune and Calibrate mode.

**Prerequisites**
- The mass spectrometer is tuned and calibrated.
- Conditions for an LC separation are known.
- All of the required peripheral devices, including the syringe pump, if needed, and LC components are in the hardware profile.

**Required Materials**
To tune instrument parameters for particular compounds the following solutions are recommended. The mixture of four compounds is used for illustrating the steps of the procedure.
- Mobile phase: 1:1 acetonitrile:water + 2 mM ammonium acetate + 0.1% formic acid.
- LC pump and autosampler.
- Autosampler vials.
- Four-compound mix (50 ng/mL), consisting of reserpine, minoxidil, tolbutamide, and rescinnamine. Use a solution that is 49.9% acetonitrile, with 50% deionized water and 0.1% formic acid as diluent. Other compounds can be substituted as long as their molecular weight is known and the compound is reasonable to be ionized by a API (Atmospheric Pressure Ionization) source.

**Table A-1 Compounds and Molecular Weights**

<table>
<thead>
<tr>
<th>Compound</th>
<th>m/z</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minoxidil</td>
<td>210.2</td>
</tr>
<tr>
<td>Tolbutamide</td>
<td>271.1</td>
</tr>
<tr>
<td>Reserpine</td>
<td>609.3</td>
</tr>
<tr>
<td>Rescinnamine</td>
<td>635.3</td>
</tr>
</tbody>
</table>
About Manual Compound Optimization

Manual compound optimization is used to optimize compound- and ion source-dependent parameters for an analyte. When the user manually optimizes for an analyte, an MS acquisition method is created in Tune and Calibrate mode. Depending on the method of sample introduction selected, add an LC method to the acquisition method so that infusion or LC can be used.

Optimizing to give the highest signal does not always give the highest signal-to-noise ratios. Noise can scale with signal for some parameters and should be verified during optimization if the goal is to obtain maximum signal-to-noise ratio.

When optimizing ion source-dependent parameters, introduce the sample at flow rates that will be used during sample analysis, using either flow injection analysis (FIA) or Tee-infusion as the method of sample introduction. The CAD gas is the only compound-dependent parameter that is shown on the Source/Gas tab and can be easily optimized while infusing the analyte.

Optimize the position of the ion source before optimizing the ion source-dependent parameters. Refer to the ion source Operator Guide.

About Scan Types

For this example, use the Q1 MS, Q1 MI, Product Ion, and MRM scan types. The Q1 MS scan type is used to confirm the presence of compounds of interest. The Q1 MI scan is used to optimize MS or pre-collision cell voltages. The Product Ion scan type is used to determine the product ions of each compound. The MRM scan type is used to optimize the collision energy (CE) and collision cell exit potential (CXP) for each product ion or fragment. Use the methods created in this section for quantitative or qualitative analysis.

Manually Optimize an Analyte

After the acquisition method is created, optimize compound-dependent parameters using the Edit Ramp function or by manually editing the parameters in the Tune Method Editor. Ion source-dependent parameters can be optimized only by manually adjusting the parameters in the Tune Method Editor. Depending on the scan type used, different parameters are available to optimize.

Follow the procedures in the order given:

1. Confirm the Presence of Compounds on page 165
2. Optimize MS-Specific Parameters on page 166
3. Determine the Product Ions for Optimization on page 168
4. Determine the Product Ions for Optimization on page 168
5. Optimize Collision Cell Exit Potential for each Product Ion on page 169
Confirm the Presence of Compounds

1. Create a project.
2. Activate the hardware profile.
3. Prepare the sample:
   a. Aspirate the compound solution into a syringe and remove the air from the syringe.
   b. Use the tubing with the special fitting to connect the syringe to the mass spectrometer.
   c. Install the syringe in the integrated syringe pump.
4. Infuse the compound in solution at a rate of 5 µL/min to 10 µL/min.
5. On the Navigation bar, under **Tune and Calibrate**, double-click **Manual Tuning**.
6. On the Syringe Pump Method Properties tab, type the parameter values shown in Table A-2.

Table A-2 Syringe Pump Method Properties Tab

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Syringe Diameter</td>
<td>Syringe dependent. 4.610 mm if a 1.0 mL syringe is used</td>
</tr>
<tr>
<td>Flow Rate</td>
<td>10</td>
</tr>
<tr>
<td>Unit</td>
<td>µL/min</td>
</tr>
</tbody>
</table>

7. Click **Start Syringe Pump**.
8. Click **MS Method** from the method list.
9. Click **Start**.
10. Wait until an even TIC is shown on the left and peaks are shown on the right and then click **Stop**.
11. Select the **MCA** check box.
12. Type **10** in the **Cycles** field.
13. Click **Start**.
14. When ten scans are complete, the masses of the four compounds are shown as ions.

**Tip!** If the previous or expected ion chromatogram pane is hidden, then select the window to be shown from the **Window** menu.

**Note:** Ion intensities of the compounds can show large variances. To facilitate moving to a solution of higher or lower concentration as needed during the optimization, have several concentration levels prepared before beginning optimization.

15. Right-click the bottom-right spectral pane and then click **Open File**.
16. Find the compounds of interest and then write down the **m/z** values for the highest peaks. These values should be within 0.1 Da to 0.2 Da of the expected **m/z**. In the next procedure, use the **m/z** values.

### Optimize MS-Specific Parameters

Declustering potential (DP) and entrance potential (EP) are pre-collision cell voltages. Optimization of these values involves gradually changing the voltage range while monitoring the signal intensity of the compound.

The DP is the difference between the orifice and the ground. The higher the potential difference, the greater the amount of declustering.

The DP parameter has a significant effect on analyte signal. Typical DP values range from 20 V to 150 V. A DP value that is too low will result in lower ion intensity and potential interferences from clusters. A DP value that is too high can cause fragmentation of the analyte in the source. Generally, the DP should be set to the value that provides the highest intensity.

The EP parameter controls the entrance potential, which guides and focuses the ions through the high-pressure Q0 region. It is typically set at 10 V for positive ions or −10 V for negative ions. The EP has a minor effect on compound optimization and can generally be left at default values without impact on analyte detection limits.

1. Return to the Tune Method Editor and change the method to the **Q1 Multiple Ions (Q1 MI)** scan type.
2. In the mass table, type the appropriate parameter values. Refer to **Table A-3**.

#### Table A-3 Mass Table Parameters—Q1 Multiple Ions (Q1 MI)

<table>
<thead>
<tr>
<th>Compound</th>
<th>Q1 Mass</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserpine</td>
<td>609.4</td>
<td>1</td>
</tr>
<tr>
<td>Minoxidil</td>
<td>210.2</td>
<td>1</td>
</tr>
</tbody>
</table>
Table A-3 Mass Table Parameters—Q1 Multiple Ions (Q1 MI) (continued)

<table>
<thead>
<tr>
<th>Compound</th>
<th>Q1 Mass</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tolbutamide</td>
<td>271.3</td>
<td>1</td>
</tr>
<tr>
<td>Rescinnamine</td>
<td>635.4</td>
<td>1</td>
</tr>
</tbody>
</table>

Start with reserpine for a simple case. Repeat the manual optimization process for the remaining compounds.

3. Click **Edit Ramp**.


**Note:** Start with the DP parameter and then optimize the other parameters in the order that they are shown in the dialog. The parameters might not be optimized correctly if they are optimized out of order.

5. Type the required **Start**, **Stop**, and **Step** values.

**Tip!** The existing values are good starting points. Use the **Edit Ramp** function to change these values to be more efficient.

6. Click **OK**.

7. Click **Start**.

8. Right-click the bottom-right XIC pane and then click **Open File** to maximize the XIC view.

9. Monitor the XICs.

**Note:** The value that gives the best signal per second for the ion of interest is the optimal value.

10. Note the optimal value for the ion of interest.

11. Move the cursor to the mass table, right-click, and then add the parameter just optimized.

    A column is added to the table.

12. Add the optimized value to the appropriate row.

13. Repeat these steps for each mass in the acquisition method until there is a list of optimal values for all of the masses.

14. Repeat these steps to optimize for the other MS-specific parameters.
Table A-4 MS-Specific Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>DP</td>
<td>Set the DP to the value that provides the highest intensity.</td>
</tr>
<tr>
<td>EP</td>
<td>Rarely optimize this parameter because it has a smaller effect.</td>
</tr>
</tbody>
</table>

**Determine the Product Ions for Optimization**

The collision energy (CE) controls the amount of energy that the precursor ions receive as they are accelerated into the collision cell.

Perform this procedure, one compound at a time, using the MS-specific optimized values that were obtained previously. The product ions provide the Q3 mass of MRM transitions.

In this example, the compound reserpine is used.

1. In the Tune Method Editor, close the XIC panes.
2. Click **Product Ion (MS2)** in the **Scan type** field.
3. Click the **Compound** tab and then type the optimal value noted previously.
4. On the MS tab, in the **Product Of** field, type **609.4**. This value is the mass assignment for reserpine that was noted in Confirm the Presence of Compounds on page 165.
5. Make sure that the **Center / Width** check box is not selected.
6. In the mass table, type the appropriate Start, Stop, and **Time** values. Refer to Table A-5.

Table A-5 Mass Table Parameters (Product Ion Scan)

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start (Da)</td>
<td>100</td>
</tr>
<tr>
<td>Stop (Da)</td>
<td>650</td>
</tr>
<tr>
<td>Time (sec)</td>
<td>2</td>
</tr>
</tbody>
</table>

7. Click **Edit Ramp**.
8. In the Ramp Parameter Settings dialog, select **Collision Energy** and then type the required **Start**, **Stop**, and **Step** values.

**Note:** The existing values are good starting points. Use the **Edit Ramp** function to change these values to be more efficient.
9. Click **OK**.

10. Select the **MCA** check box.

11. Click **Start**.

12. Right-click the bottom-right XIC pane and then click **Open File**.

13. Select the product ions with the greatest intensity and note the product ion m/z value to the first decimal point, such as 195.1.

   We recommend that two or three product ions be optimized for each compound. The additional transitions can be used for confirmation, or to avoid the need to re-optimize a compound in case an interference is found.

   **Note:** Make sure that the highest peaks selected for optimization do not represent a common loss from the precursor ion, such as water or carbon dioxide. Also make sure that the product ion is not too low in mass or interferences might occur for that transition in real samples or clusters from the mobile phase when analyzing on column.

14. Repeat this procedure for the remaining compounds.

### Optimize Collision Cell Exit Potential for each Product Ion

1. In the Tune Method Editor, close the XIC panes.

2. Open the previously saved method.

3. In the mass table, verify the Q1 and Q3 m/z values for the compound.

4. Click the **Compound** tab and then type the optimal DP and CE values noted previously.

5. Click **Edit Ramp**.


7. Type the required **Start**, **Stop**, and **Step** values.

   **Tip!** The existing values are good starting points. Use the **Edit Ramp** function to change these values to be more efficient.

8. Click **OK**.

9. Click **Start**.

10. Right-click the bottom-right XIC pane and then click **Open File**.

11. Note the optimal value for the ion of interest.

   The value that gives the best signal is the optimal value.

12. In the mass table, right-click and then select the parameter just optimized.
This adds a column to the table.

13. Repeat if other product ions were monitored.
14. Add the optimized values to the appropriate row.
15. Save the method.
16. Repeat this procedure for any other compounds that were previously optimized.

**Manually Optimize the Ion Source and Gas Parameters**

The ion source and gas settings must be set correctly to prevent contamination of the mass spectrometer and to make sure that the compounds of interest are optimally put into the gas phase as ions.

---

**Note:** The optimal ion source and gas settings are related to the solvent composition and the flow rate.

---

The ion source and gas settings must be adjusted when the LC conditions change significantly.

To optimize the ion source and gas parameters, set up a syringe pump with the compounds of interest and connect the line with a tee to the LC device. Controlling the LC pump can be done manually or through the software.

Another way to manually optimize ion source and gas settings is to use the autosampler to manually inject the compound of interest while manually varying the parameters in manual tuning to find the optimal settings.

**Prepare the Ion Source**

1. Set the horizontal micrometer to 5.
2. Set the vertical micrometer on the ion source for the flow rate.

Use the parameters in Table A-6.

**Table A-6 Turbo V™ Ion Source Vertical Parameters**

<table>
<thead>
<tr>
<th>Flow Rate</th>
<th>Initial Vertical Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 µL/min to 20 µL/min</td>
<td>10</td>
</tr>
<tr>
<td>20 µL/min to 250 µL/min</td>
<td>5</td>
</tr>
<tr>
<td>250 µL/min to 500 µL/min</td>
<td>2</td>
</tr>
<tr>
<td>500 + µL/min</td>
<td>0</td>
</tr>
</tbody>
</table>

Depending on how the optimization is run, a hardware profile with the LC pumps might need to be configured.
Refer to the ion source Operator Guide.

**Optimize the Ion Source Parameters**

Ion source parameters are optimized for best signal-to-noise for the compound of interest. The Curtain Gas™ supply is optimized at the highest setting without losing sensitivity. Refer to the ion source Operator Guide.

Use the following procedure to optimize the Curtain Gas™ flow parameter. The main function of the Curtain Gas™ flow parameter is to prevent the contamination of the ion optics. The Curtain Gas™ flow parameter should always be maintained as high as possible without losing sensitivity. The value depends on the type of mass spectrometer and ion source.

Do not set the parameter below the starting value.

The minimum flow rate supported by the APCI probe is 200 µL/min.

**Note:** Depending on the mass spectrometer, all parameters might not be available.

1. On the Navigation bar, under **Tune and Calibrate**, double-click **Manual Tuning**.
2. Click **File > Open**.
3. In the **Files** list, click the acquisition method used to optimize the compound parameter and then click **OK**. The method opens in the Tune Method Editor.
4. Click the **Source/Gas** tab.
5. Using the ion source and gas flow guide, set all of the ion source and gas parameters so that they are appropriate for the flow rate.
6. Set the run time long enough so that many parameters can be adjusted. A recommended starting time is 15 minutes.
7. Click **Start**.
   
   Data is shown in panes below the Tune Method Editor.
8. Note the signal of the peak of interest.
9. In the **Curtain Gas (CUR)** field, increase the value by five.
10. Continue increasing the **Curtain Gas (CUR)** value until the highest value without losing sensitivity is found.

   As with most Source/Gas parameters, if two values give the same result, then use the higher value.
11. Repeat this procedure for the other Source/Gas parameters.

When optimizing for these parameters, look for the value that gives the highest signal-to-noise value.
Advanced Parameters

The following parameters should only be optimized by an experienced operator.

Optimize AF2

The AF2 parameter controls the fragmentation of the second precursor ion in an MS3 scan. The amount of excitation energy used depends on the compound and the desired amount of fragmentation.

1. For both positive and negative ion modes, ramp AF2 from 0.07 V to 0.3 V, with a step value of 0.01 V.
   
   The allowable range is 0 V to 1 V.

2. For both positive and negative ion modes, ramp AF2 from 0 mV to 200 mV with a step value of 5 mV.

3. Select the AF2 value that gives the best amount of fragmentation.

If the MS3 scan is selected when using the 6500 and 6500+ series of instruments, the No Fragmentation option is not available. However, users can achieve the effect of the No Fragmentation option by setting the AF2 parameter to 0 on the Compound tab of the Tune Method Editor.

About Collision Energy Spread (CES)

Under the compound-dependent parameters in Enhanced Product Ion (EPI) and MS3 experiments, the collision energy spread (CES) field allows users to specify the difference in collision energies that will be applied in the experiment. For example, if CE value of 30 and a CES value of 15 are used, then collision energies of 15, 30, and 45 are used.
The following table contains generic parameters for the SCIEX Triple Quad 3500 instrument. The first number under each scan type is the preset value. The range of numbers is the accessible range for each parameter.

Table B-1 System Parameters for Triple Quadrupole Scan Types

<table>
<thead>
<tr>
<th>Access ID</th>
<th>Positive Ion Mode</th>
<th></th>
<th>Negative Ion Mode</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Q1</td>
<td>Q3</td>
<td>MS/MS</td>
<td>Q1</td>
</tr>
<tr>
<td>CUR¹(1)(2)</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>10 to 55</td>
<td>10 to 55</td>
<td>10 to 55</td>
<td>10 to 55</td>
</tr>
<tr>
<td>CAD</td>
<td>0</td>
<td>5</td>
<td>9</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Fixed</td>
<td>Fixed</td>
<td>0 to 12</td>
<td>Fixed</td>
</tr>
<tr>
<td>IS¹(1)(2)</td>
<td>5500</td>
<td>5500</td>
<td>5500</td>
<td>–4500</td>
</tr>
<tr>
<td></td>
<td>0 to 5500</td>
<td>0 to 5500</td>
<td>0 to 5500</td>
<td>–4500 to 0</td>
</tr>
<tr>
<td>NC³</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>–3</td>
</tr>
<tr>
<td></td>
<td>0 to 5</td>
<td>0 to 5</td>
<td>0 to 5</td>
<td>–5 to 0</td>
</tr>
<tr>
<td>TEM²(2)(3)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0 to 750</td>
<td>0 to 750</td>
<td>0 to 750</td>
<td>0 to 750</td>
</tr>
<tr>
<td>DP</td>
<td>130</td>
<td>130</td>
<td>120</td>
<td>–60</td>
</tr>
<tr>
<td></td>
<td>0 to 300</td>
<td>0 to 300</td>
<td>0 to 300</td>
<td>–300 to 0</td>
</tr>
<tr>
<td>EP</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>–10</td>
</tr>
<tr>
<td></td>
<td>2 to 15</td>
<td>2 to 15</td>
<td>2 to 15</td>
<td>–15 to –2</td>
</tr>
<tr>
<td></td>
<td>0 to 3300</td>
<td>0 to 3300</td>
<td>0 to 3300</td>
<td>0 to 3300</td>
</tr>
<tr>
<td>GS1</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>0 to 90</td>
<td>0 to 90</td>
<td>0 to 90</td>
<td>0 to 90</td>
</tr>
<tr>
<td>GS2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0 to 90</td>
<td>0 to 90</td>
<td>0 to 90</td>
<td>0 to 90</td>
</tr>
</tbody>
</table>
Parameters for SCIEX Triple Quad 3500 Instruments

Table B-1 System Parameters for Triple Quadrupole Scan Types (continued)

<table>
<thead>
<tr>
<th>Access ID</th>
<th>Positive Ion Mode</th>
<th>Negative Ion Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>IQ1</td>
<td>Q0 + (−0.5)</td>
<td>Q0 + (−0.5)</td>
</tr>
<tr>
<td>ST</td>
<td>Q0 + (−8) −12 to −5</td>
<td>Q0 + (−8) −12 to −5</td>
</tr>
<tr>
<td>IE1</td>
<td>0.9 0 to 3 n/a</td>
<td>0.9 0 to 3 n/a</td>
</tr>
<tr>
<td>CE</td>
<td>n/a</td>
<td>53 5 to 180 n/a</td>
</tr>
<tr>
<td>CXP</td>
<td>n/a</td>
<td>9 0 to 55 n/a</td>
</tr>
<tr>
<td>IE3</td>
<td>n/a</td>
<td>2 0 to 5 1.5 0 to 5</td>
</tr>
</tbody>
</table>

(1) Turbo V™ ion source (2) TurboIonSpray® probe (3) APCI probe
## Calibration Ions and Solutions

### Table C-1 Tuning Frequency

<table>
<thead>
<tr>
<th>Scan Type</th>
<th>Calibration Frequency</th>
<th>Resolution Optimization Frequency</th>
<th>Manual/Automated</th>
<th>Manual/Automated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1 and Q3</td>
<td>3 months to 6 months</td>
<td>Both</td>
<td>3 months to 6 months</td>
<td>Both</td>
</tr>
</tbody>
</table>

### Table C-2 Suggested Tuning Solutions for the SCIEX Triple Quad™ 3500 System

<table>
<thead>
<tr>
<th>System</th>
<th>Positive</th>
<th>Negative</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCIEX SCIEX Triple Quad™ 3500</td>
<td>POS PPG, 1e-5 M</td>
<td>NEG PPG, 3e-4 M</td>
</tr>
<tr>
<td>LC-MS/MS system</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Calibration Ions and Solutions

### Table C-3 Q1 and Q3 PPG Scans

<table>
<thead>
<tr>
<th>Polarity</th>
<th>Masses</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1952.43</td>
</tr>
<tr>
<td></td>
<td>1979.39</td>
</tr>
<tr>
<td>Positive</td>
<td>59.05</td>
</tr>
<tr>
<td></td>
<td>175.13</td>
</tr>
<tr>
<td></td>
<td>500.38</td>
</tr>
<tr>
<td></td>
<td>616.46</td>
</tr>
<tr>
<td></td>
<td>906.67</td>
</tr>
<tr>
<td></td>
<td>1254.93</td>
</tr>
<tr>
<td></td>
<td>1545.13</td>
</tr>
<tr>
<td></td>
<td>1952.43</td>
</tr>
<tr>
<td>Negative</td>
<td>45.00</td>
</tr>
<tr>
<td></td>
<td>411.26</td>
</tr>
<tr>
<td></td>
<td>585.39</td>
</tr>
<tr>
<td></td>
<td>933.64</td>
</tr>
<tr>
<td></td>
<td>1223.85</td>
</tr>
<tr>
<td></td>
<td>1572.10</td>
</tr>
<tr>
<td></td>
<td>1863.31</td>
</tr>
<tr>
<td></td>
<td>1979.39</td>
</tr>
</tbody>
</table>
### Toolbar Icons

For additional toolbar icons, refer to the *Advanced User Guide*.

**Table D-1 Tool Bar Icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>New Subproject</td>
<td>Creates a subproject. <strong>Subprojects</strong> can only be created later in the process if the project was originally created with subprojects.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Copy Subproject</td>
<td>Copies a Subproject folder. Subprojects can be copied only from another project that has existing subprojects. If the same folders exist at both the project and subproject levels, then the software uses the project level folders.</td>
</tr>
</tbody>
</table>

**Table D-2 Acquisition Method Editor Icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Mass Spec</td>
<td>Click to show the MS tab in the Acquisition Method editor.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Period</td>
<td>Right-click to add an experiment, add an <strong>IDA Criteria Level</strong>, or delete the period.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Autosampler</td>
<td>Click to open the Autosampler Properties tab.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Syringe Pump</td>
<td>Click to open the Syringe Pump Properties tab.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Column Oven</td>
<td>Click to open the Column Oven Properties tab.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Valve</td>
<td>Click to open the Valve Properties tab.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>DAD</td>
<td>Click to open the DAD Method Editor. Refer to <em>Generate DAD Data on page 122</em>.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>ADC</td>
<td>Click to open the ADC Properties tab. Refer to <em>Show ADC Data on page 113</em>.</td>
</tr>
</tbody>
</table>
## Toolbar Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="View Queue Icon" /></td>
<td>View Queue</td>
<td>Shows the sample queue.</td>
</tr>
<tr>
<td><img src="image" alt="Instrument Queue Icon" /></td>
<td>Instrument Queue</td>
<td>Shows a remote instrument station.</td>
</tr>
<tr>
<td><img src="image" alt="Status for Remote Instrument Icon" /></td>
<td>Status for Remote Instrument</td>
<td>Shows the status of a remote instrument.</td>
</tr>
<tr>
<td><img src="image" alt="Start Sample Icon" /></td>
<td>Start Sample</td>
<td>Starts the sample in the queue.</td>
</tr>
<tr>
<td><img src="image" alt="Stop Sample Icon" /></td>
<td>Stop Sample</td>
<td>Stops the sample in the queue.</td>
</tr>
<tr>
<td><img src="image" alt="Abort Sample Icon" /></td>
<td>Abort Sample</td>
<td>Aborts a sample acquisition in the middle of the processing of that sample.</td>
</tr>
<tr>
<td><img src="image" alt="Stop Queue Icon" /></td>
<td>Stop Queue</td>
<td>Stops the queue before it has completed processing all the samples.</td>
</tr>
<tr>
<td><img src="image" alt="Pause Sample Now Icon" /></td>
<td>Pause Sample Now</td>
<td>Inserts a pause in the queue.</td>
</tr>
<tr>
<td><img src="image" alt="Insert Pause before Selected Sample(s) Icon" /></td>
<td>Insert Pause before Selected Sample(s)</td>
<td>Inserts a pause before a specific sample.</td>
</tr>
<tr>
<td><img src="image" alt="Continue Sample Icon" /></td>
<td>Continue Sample</td>
<td>Continues acquiring the sample.</td>
</tr>
<tr>
<td><img src="image" alt="Next Period Icon" /></td>
<td>Next Period</td>
<td>Starts a new period.</td>
</tr>
<tr>
<td><img src="image" alt="Extend Period Icon" /></td>
<td>Extend Period</td>
<td>Extends the current period.</td>
</tr>
<tr>
<td><img src="image" alt="Next Sample Icon" /></td>
<td>Next Sample</td>
<td>Stops acquiring the current sample and starts acquiring the next sample.</td>
</tr>
<tr>
<td><img src="image" alt="Equilibrate Icon" /></td>
<td>Equilibrate</td>
<td>Selects the method to be used to equilibrate the devices. This method should be the same as the method used with the first sample in the queue.</td>
</tr>
<tr>
<td><img src="image" alt="Standby Icon" /></td>
<td>Standby</td>
<td>Puts the instrument in Standby mode.</td>
</tr>
<tr>
<td><img src="image" alt="Ready Icon" /></td>
<td>Ready</td>
<td>Puts the instrument in Ready mode.</td>
</tr>
</tbody>
</table>
### Table D-3 Acquire Mode Icons (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![T]</td>
<td>Reserve Instrument for Tuning</td>
<td>Reserves the mass spectrometer for tuning and calibrating.</td>
</tr>
<tr>
<td>![IDA]</td>
<td>IDA Method Wizard</td>
<td>Starts the IDA Method Wizard.</td>
</tr>
<tr>
<td>![P]</td>
<td>Purge Modifier</td>
<td>Starts the modifier purge from the modifier pump.</td>
</tr>
</tbody>
</table>

### Table D-4 Tune and Calibrate Mode Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Calibrate]</td>
<td>Calibrate from spectrum</td>
<td>Opens the Mass Calibration Option dialog and uses the active spectrum to calibrate the mass spectrometer.</td>
</tr>
<tr>
<td>![Compound Optimization]</td>
<td>Compound Optimization</td>
<td>Optimizes for a compound using infusion by FIA.</td>
</tr>
<tr>
<td>![Instrument Optimization]</td>
<td>Instrument Optimization</td>
<td>Verifies the instrument performance, adjusts the mass calibration, or adjusts mass spectrometer settings.</td>
</tr>
<tr>
<td>![View Queue]</td>
<td>View Queue</td>
<td>Views the sample queue.</td>
</tr>
<tr>
<td>![Instrument Queue]</td>
<td>Instrument Queue</td>
<td>Views a remote instrument.</td>
</tr>
<tr>
<td>![T]</td>
<td>Reserve Instrument for Tuning</td>
<td>Reserves the instrument for tuning and calibrating.</td>
</tr>
<tr>
<td>![IDA]</td>
<td>IDA Method Wizard</td>
<td>Starts the IDA Method Wizard.</td>
</tr>
</tbody>
</table>
### Toolbar Icons

**Table D-5 Explore Quick Reference: Chromatograms and Spectrum**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Open Data File icon]</td>
<td>Open Data File</td>
<td>Opens files.</td>
</tr>
<tr>
<td>![Next Sample icon]</td>
<td>Show Next Sample</td>
<td>Goes to the next sample.</td>
</tr>
<tr>
<td>![Previous Sample icon]</td>
<td>Show Previous Sample</td>
<td>Goes to the previous sample.</td>
</tr>
<tr>
<td>![Select Sample icon]</td>
<td>Go To Sample</td>
<td>Opens the Select Sample dialog.</td>
</tr>
<tr>
<td>![List Data icon]</td>
<td>List Data</td>
<td>Views the data in tables.</td>
</tr>
<tr>
<td>![Show TIC icon]</td>
<td>Show TIC</td>
<td>Generates a TIC from a spectrum.</td>
</tr>
<tr>
<td>![Extract Using Dialog icon]</td>
<td>Extract Using Dialog</td>
<td>Extracts ions by selecting masses.</td>
</tr>
<tr>
<td>![Show BPC icon]</td>
<td>Show Base Peak Chromatogram</td>
<td>Generates a BPC.</td>
</tr>
<tr>
<td>![Show Spectrum icon]</td>
<td>Show Spectrum</td>
<td>Generates a spectrum from a TIC.</td>
</tr>
<tr>
<td>![Copy Graph to new Window icon]</td>
<td>Copy Graph to new Window</td>
<td>Copies the active graph to a new window.</td>
</tr>
<tr>
<td>![Baseline Subtract icon]</td>
<td>Baseline Subtract</td>
<td>Opens the Baseline Subtract dialog.</td>
</tr>
<tr>
<td>![Threshold icon]</td>
<td>Threshold</td>
<td>Adjusts the threshold.</td>
</tr>
<tr>
<td>![Noise Filter icon]</td>
<td>Noise Filter</td>
<td>Shows the Noise Filter Options dialog, which can be used define the minimum width of a peak. Signals below this minimum width are regarded as noise.</td>
</tr>
<tr>
<td>![Show ADC icon]</td>
<td>Show ADC</td>
<td>Shows ADC data.</td>
</tr>
<tr>
<td>![Show File Info icon]</td>
<td>Show File Info</td>
<td>Shows the experimental conditions used to collect the data.</td>
</tr>
<tr>
<td>![Add arrows icon]</td>
<td>Add arrows</td>
<td>Adds arrows to the X-axis of the active graph.</td>
</tr>
<tr>
<td>![Remove all arrows icon]</td>
<td>Remove all arrows</td>
<td>Removes arrows from the X-axis of the active graph.</td>
</tr>
<tr>
<td>![Offset Graph icon]</td>
<td>Offset Graph</td>
<td>Compensates for slight differences in the time during which the ADC data and the mass spectrometer data were recorded. This is useful when overlaying graphs for comparison.</td>
</tr>
</tbody>
</table>
### Table D-5 Explore Quick Reference: Chromatograms and Spectrum (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon1.png" alt="Icon" /></td>
<td>Force Peak Labels</td>
<td>Labels all of the peaks.</td>
</tr>
<tr>
<td><img src="icon2.png" alt="Icon" /></td>
<td>Expand Selection By</td>
<td>Sets the expansion factor for a portion of a graph to be viewed in greater detail.</td>
</tr>
<tr>
<td><img src="icon3.png" alt="Icon" /></td>
<td>Clear ranges</td>
<td>Returns the expanded selection to normal view.</td>
</tr>
<tr>
<td><img src="icon4.png" alt="Icon" /></td>
<td>Set Selection</td>
<td>Defines start and stop points for a selection. This feature provides more accurate selection than is possible by selecting the region using the cursor.</td>
</tr>
<tr>
<td><img src="icon5.png" alt="Icon" /></td>
<td>Normalize To Max</td>
<td>Scales a graph to maximum size, so that the most intense peak is scaled to full scale, whether or not it is visible.</td>
</tr>
<tr>
<td><img src="icon6.png" alt="Icon" /></td>
<td>Show History</td>
<td>Shows a summary of data processing operations performed on a particular file, such as smoothing, subtraction, calibration, and noise filtering.</td>
</tr>
<tr>
<td><img src="icon7.png" alt="Icon" /></td>
<td>Open Compound Database</td>
<td>Opens the compound database.</td>
</tr>
<tr>
<td><img src="icon8.png" alt="Icon" /></td>
<td>Set Threshold</td>
<td>Adjusts the threshold.</td>
</tr>
<tr>
<td><img src="icon9.png" alt="Icon" /></td>
<td>Show Contour Plot</td>
<td>Shows selected data as either a spectrum graph or an XIC. Additionally, for data acquired by a DAD, a contour plot can show selected data as either a DAD spectrum or an XWC.</td>
</tr>
<tr>
<td><img src="icon10.png" alt="Icon" /></td>
<td>Show DAD TWC</td>
<td>Generates a TWC of the DAD spectrum.</td>
</tr>
<tr>
<td><img src="icon11.png" alt="Icon" /></td>
<td>Show DAD Spectrum</td>
<td>Generates a DAD spectrum.</td>
</tr>
<tr>
<td><img src="icon12.png" alt="Icon" /></td>
<td>Extract Wavelength</td>
<td>Extracts up to three wavelength ranges from a DAD spectrum to view the XWC.</td>
</tr>
</tbody>
</table>

### Table D-6 Explore Toolbar Quick Reference: Overlaying Graphs

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon13.png" alt="Icon" /></td>
<td>Home Graph</td>
<td>Click to return the graph to the original scale.</td>
</tr>
<tr>
<td><img src="icon14.png" alt="Icon" /></td>
<td>Overlay</td>
<td>Click to overlay graphs.</td>
</tr>
</tbody>
</table>
### Toolbar Icons

#### Table D-6 Explore Toolbar Quick Reference: Overlaying Graphs (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Cycle Overlays Icon" /></td>
<td>Cycle Overlays</td>
<td>Click to cycle between overlaid graphs.</td>
</tr>
<tr>
<td><img src="image" alt="Sum Overlays Icon" /></td>
<td>Sum Overlays</td>
<td>Click to add the graphs together.</td>
</tr>
</tbody>
</table>

#### Table D-7 Explore Toolbar Quick Reference: Fragment Interpretation Tool

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Show Fragment Interpretation Tool Icon" /></td>
<td>Show Fragment Interpretation Tool</td>
<td>Click to open Fragment Interpretation tool, which calculates the single, non-cyclic bond cleavage fragments from a .mol file.</td>
</tr>
</tbody>
</table>

#### Table D-8 Navigation Icons on the Explore Toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open File Icon" /></td>
<td>Open File</td>
<td>Click to open files.</td>
</tr>
<tr>
<td><img src="image" alt="Show Next Sample Icon" /></td>
<td>Show Next Sample</td>
<td>Click to navigate to the next sample.</td>
</tr>
<tr>
<td><img src="image" alt="Show Previous Sample Icon" /></td>
<td>Show Previous Sample</td>
<td>Click to navigate to the previous sample.</td>
</tr>
<tr>
<td><img src="image" alt="GoTo Sample Icon" /></td>
<td>GoTo Sample</td>
<td>Click to open the Select Sample dialog.</td>
</tr>
<tr>
<td><img src="image" alt="List Data Icon" /></td>
<td>List Data</td>
<td>Click to view the data in tables.</td>
</tr>
<tr>
<td><img src="image" alt="Show TIC Icon" /></td>
<td>Show TIC</td>
<td>Click to generate a TIC from a spectrum.</td>
</tr>
<tr>
<td><img src="image" alt="Extract Using Dialog Icon" /></td>
<td>Extract Using Dialog</td>
<td>Click to extract ions by selecting masses.</td>
</tr>
<tr>
<td><img src="image" alt="Show Base Peak Chromatogram Icon" /></td>
<td>Show Base Peak Chromatogram</td>
<td>Click to generate a BPC.</td>
</tr>
<tr>
<td><img src="image" alt="Show Spectrum Icon" /></td>
<td>Show Spectrum</td>
<td>Click to generate a spectrum from a TIC.</td>
</tr>
<tr>
<td><img src="image" alt="Copy Graph to new Window Icon" /></td>
<td>Copy Graph to new Window</td>
<td>Click to copy the active graph to a new window.</td>
</tr>
<tr>
<td><img src="image" alt="Baseline Subtract Icon" /></td>
<td>Baseline Subtract</td>
<td>Click to open the Baseline Subtract dialog.</td>
</tr>
</tbody>
</table>
### Table D-8 Navigation Icons on the Explore Toolbar (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Threshold Icon]</td>
<td>Threshold</td>
<td>Click to adjust the threshold.</td>
</tr>
<tr>
<td>![Noise Filter Icon]</td>
<td>Noise Filter</td>
<td>Click to use the Noise Filter Options dialog to define the minimum width of a peak. Signals below this minimum width are regarded as noise.</td>
</tr>
<tr>
<td>![Show ADC Icon]</td>
<td>Show ADC</td>
<td>Click to view ADC data.</td>
</tr>
<tr>
<td>![Show File Info Icon]</td>
<td>Show File Info</td>
<td>Click to show the experimental conditions you used to collect your data.</td>
</tr>
<tr>
<td>![Add Arrows Icon]</td>
<td>Add arrows</td>
<td>Click to add arrows to the x-axis of the active graph.</td>
</tr>
<tr>
<td>![Remove All Arrows Icon]</td>
<td>Remove all arrows</td>
<td>Click to remove arrows from the x-axis of the active graph.</td>
</tr>
<tr>
<td>![Offset Graph Icon]</td>
<td>Offset Graph</td>
<td>Click to compensate for slight differences in the time during which the ADC data and the mass spectrometer data were recorded. This is useful when overlaying graphs for comparison.</td>
</tr>
<tr>
<td>![Force Peak Labels Icon]</td>
<td>Force Peak Labels</td>
<td>Click to label all the peaks.</td>
</tr>
<tr>
<td>![Expand Selection By Icon]</td>
<td>Expand Selection By</td>
<td>Click to set the expansion factor for a portion of a graph that you want to view in greater detail.</td>
</tr>
<tr>
<td>![Clear Ranges Icon]</td>
<td>Clear ranges</td>
<td>Click to return the expanded selection to normal view.</td>
</tr>
<tr>
<td>![Set Selection Icon]</td>
<td>Set Selection</td>
<td>Click to type start and stop points for a selection. This provides more accurate selection than is possible by highlighting the region using the cursor.</td>
</tr>
<tr>
<td>![Normalize to Max Icon]</td>
<td>Normalize to Max</td>
<td>Click to scale a graph to maximum, so that the most intense peak is scaled is to full scale, whether or not it is visible.</td>
</tr>
<tr>
<td>![Show History Icon]</td>
<td>Show History</td>
<td>Click to view a summary of data processing operations performed on a particular file, such as smoothing, subtraction, calibration, and noise filtering.</td>
</tr>
<tr>
<td>![Open Compound Database Icon]</td>
<td>Open Compound Database</td>
<td>Click to open the compound database.</td>
</tr>
<tr>
<td>![Set Threshold Icon]</td>
<td>Set Threshold</td>
<td>Click to adjust the threshold.</td>
</tr>
<tr>
<td>![Show Contour Plot Icon]</td>
<td>Show Contour Plot</td>
<td>Click to display selected data as either a spectrum graph or an XIC. Additionally, for data acquired by a DAD, a contour plot can display selected data as either a DAD spectrum or an XWC.</td>
</tr>
<tr>
<td>![Show DAD TWC Icon]</td>
<td>Show DAD TWC</td>
<td>Click to generate a TWC of the DAD.</td>
</tr>
</tbody>
</table>
### Toolbar Icons

#### Table D-8 Navigation Icons on the Explore Toolbar (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Show DAD Spectrum</td>
<td>Click to generate a DAD spectrum.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Extract Wavelength</td>
<td>Click to extract up to three wavelength ranges from a DAD spectrum to view the XWC.</td>
</tr>
</tbody>
</table>

#### Table D-9 Integration Tab and Quantitation Wizard Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Set parameters from Background Region</td>
<td>Uses the selected peak.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Select Peak</td>
<td>Uses the selected background.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Manual Integration Mode</td>
<td>Manually integrates peaks.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Show or Hide Parameters</td>
<td>Toggles the peak-finding parameters between shown and hidden.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Show Active Graph</td>
<td>Shows the analyte chromatogram only.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Show Both Analyte and IS</td>
<td>Shows the analyte and its associated chromatogram (available only when an associated internal standard exists).</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Use Default View for Graph</td>
<td>Returns to the preset (view all data) view (if, for example, the user has zoomed in on a chromatogram).</td>
</tr>
</tbody>
</table>

#### Table D-10 Results Table Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Sort Ascending by Selection</td>
<td>Sorts the selected column by ascending values.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Sort Descending by selection</td>
<td>Sorts the selected column by descending values.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Lock Or Unlock Column</td>
<td>Locks or unlocks the selected column. A locked column cannot be moved.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Metric Plot By Selection</td>
<td>Creates a metric plot from the selected column.</td>
</tr>
</tbody>
</table>
### Table D-10 Results Table Icons (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Show all Samples</td>
<td>Shows all the samples in the Results Table.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Delete Formula Column</td>
<td>Deletes formula columns.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Report Generator</td>
<td>Opens the Reporter software.</td>
</tr>
</tbody>
</table>

### Table D-11 Icon Quick Reference: Quantitate Mode

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Add/Remove Samples</td>
<td>Adds or removes samples from the Results Table.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Export as Text</td>
<td>Saves the Results Table as a text file.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Modify Method</td>
<td>Opens a wiff file.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Peak Review - Pane</td>
<td>Opens peaks in a pane.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Peak Review - Window</td>
<td>Opens peaks in a window.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Calibration - Pane</td>
<td>Opens the calibration curve in a pane.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Calibration - Window</td>
<td>Opens the calibration curve in a window.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Show First Peak</td>
<td>Shows the first peak in the pane or window.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Show Last Peak</td>
<td>Shows the last peak in the pane or window.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Show Audit Trail</td>
<td>Shows the audit trail for the Results Table.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Clear Audit Trail</td>
<td>Clears the audit trail for the Results Table.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Statistics</td>
<td>Opens the Statistics window.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Report Generator</td>
<td>Opens the <strong>Reporter</strong> software.</td>
</tr>
</tbody>
</table>
Glossary of Symbols

Note: Not all of the symbols in the following table are applicable to every instrument.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Symbol" /></td>
<td>Australian Regulatory Compliance Mark. Indicates the products complies with Australian communications Media Authority (ACMA) EMC Requirements.</td>
</tr>
<tr>
<td><img src="image2" alt="Symbol" /></td>
<td>Alternating current</td>
</tr>
<tr>
<td><img src="image3" alt="Symbol" /></td>
<td>Amperes (current)</td>
</tr>
<tr>
<td><img src="image4" alt="Symbol" /></td>
<td>Authorized representative in the European community</td>
</tr>
<tr>
<td><img src="image5" alt="Symbol" /></td>
<td>Biohazard</td>
</tr>
<tr>
<td><img src="image6" alt="Symbol" /></td>
<td>CE Marking of Conformity</td>
</tr>
<tr>
<td><img src="image7" alt="Symbol" /></td>
<td>cCSAus mark. Indicates electrical safety certification for Canada and USA.</td>
</tr>
<tr>
<td><img src="image8" alt="Symbol" /></td>
<td>Catalogue number</td>
</tr>
<tr>
<td><img src="image9" alt="Symbol" /></td>
<td>Caution</td>
</tr>
</tbody>
</table>

Note: In SCIEX documentation, this symbol identifies a personal injury hazard.
### Glossary of Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="China RoHS Caution Label" /></td>
<td>China RoHS Caution Label. The electronic information product contains certain toxic or hazardous substances. The center number is the Environmentally Friendly Use Period (EFUP) date, and indicates the number of calendar years the product can be in operation. Upon the expiration of the EFUP, the product must be immediately recycled. The circling arrows indicate the product is recyclable. The date code on the label or product indicates the date of manufacture.</td>
</tr>
<tr>
<td><img src="image" alt="China RoHS logo" /></td>
<td>China RoHS logo. The device does not contain toxic and hazardous substances or elements above the maximum concentration values, and it is an environmentally-friendly product that can be recycled and reused.</td>
</tr>
<tr>
<td><img src="image" alt="Consult instructions for use" /></td>
<td>Consult instructions for use.</td>
</tr>
<tr>
<td><img src="image" alt="cTUVus mark for TUV Rheinland of North America" /></td>
<td>cTUVus mark for TUV Rheinland of North America.</td>
</tr>
<tr>
<td><img src="image" alt="Data Matrix symbol" /></td>
<td>Data Matrix symbol that can be scanned by a barcode reader to obtain a unique device identifier (UDI).</td>
</tr>
<tr>
<td><img src="image" alt="Ethernet connection" /></td>
<td>Ethernet connection</td>
</tr>
<tr>
<td><img src="image" alt="Explosion Hazard" /></td>
<td>Explosion Hazard</td>
</tr>
<tr>
<td><img src="image" alt="Fire Hazard" /></td>
<td>Fire Hazard</td>
</tr>
<tr>
<td><img src="image" alt="Fragile" /></td>
<td>Fragile</td>
</tr>
<tr>
<td><img src="image" alt="Fuse" /></td>
<td>Fuse</td>
</tr>
<tr>
<td><img src="image" alt="Hz" /></td>
<td>Hertz</td>
</tr>
</tbody>
</table>
## Glossary of Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![High Voltage](image) | High Voltage. Electrical Shock Hazard  
If the main cover must be removed, contact a SCIEX representative to prevent electric shock. |
| ![Hot Surface](image) | Hot Surface Hazard |
| ![In Vitro Diagnostic Device](image) | In Vitro Diagnostic Device |
| ![Ionizing Radiation](image) | Ionizing Radiation Hazard |
| ![Keep dry.](image) | Keep dry.  
Do not expose to rain.  
Relative humidity must not exceed 99%. |
<p>| <img src="image" alt="Keep upright." /> | Keep upright. |
| <img src="image" alt="Laser Radiation" /> | Laser Radiation Hazard |
| <img src="image" alt="Lifting Hazard" /> | Lifting Hazard |
| <img src="image" alt="Manufacturer" /> | Manufacturer |
| <img src="image" alt="Moving Parts Hazard" /> | Moving Parts Hazard |
| <img src="image" alt="Pinch Hazard" /> | Pinch Hazard |
| <img src="image" alt="Pressurized Gas Hazard" /> | Pressurized Gas Hazard |</p>
<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Protective Earth (ground)" /></td>
<td>Protective Earth (ground)</td>
</tr>
<tr>
<td><img src="image" alt="Puncture Hazard" /></td>
<td>Puncture Hazard</td>
</tr>
<tr>
<td><img src="image" alt="Serial number" /></td>
<td>Serial number</td>
</tr>
<tr>
<td><img src="image" alt="Toxic Chemical Hazard" /></td>
<td>Toxic Chemical Hazard</td>
</tr>
<tr>
<td><img src="image" alt="Transport and store the system within 66 kPa to 103 kPa." /></td>
<td>Transport and store the system within 66 kPa to 103 kPa.</td>
</tr>
<tr>
<td><img src="image" alt="Transport and store the system within 75 kPa to 101 kPa." /></td>
<td>Transport and store the system within 75 kPa to 101 kPa.</td>
</tr>
<tr>
<td><img src="image" alt="Transport and store the system within 10% to 90% relative humidity." /></td>
<td>Transport and store the system within 10% to 90% relative humidity.</td>
</tr>
<tr>
<td><img src="image" alt="Transport and store the system within –30 °C to +45 °C." /></td>
<td>Transport and store the system within –30 °C to +45 °C.</td>
</tr>
<tr>
<td><img src="image" alt="Transport and store the system within –30 °C to +60 °C." /></td>
<td>Transport and store the system within –30 °C to +60 °C.</td>
</tr>
<tr>
<td><img src="image" alt="USB 2.0 connection" /></td>
<td>USB 2.0 connection</td>
</tr>
<tr>
<td><img src="image" alt="USB 3.0 connection" /></td>
<td>USB 3.0 connection</td>
</tr>
<tr>
<td><img src="image" alt="Ultraviolet Radiation Hazard" /></td>
<td>Ultraviolet Radiation Hazard</td>
</tr>
<tr>
<td><a href="image">VA</a></td>
<td>Volt Ampere (power)</td>
</tr>
</tbody>
</table>
### Glossary of Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>V</td>
<td>Volts (voltage)</td>
</tr>
<tr>
<td>![WEEE logo]</td>
<td>WEEE. Do not dispose of equipment as unsorted municipal waste.</td>
</tr>
<tr>
<td>W</td>
<td>Watts</td>
</tr>
</tbody>
</table>
| ![Date Format] | yyyy-mm-dd  
Date of manufacture |
## Glossary of Warnings

**Note:** If any of the labels used to identify a component become detached, contact an FSE.

<table>
<thead>
<tr>
<th>Label</th>
<th>Translation (if applicable)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN61326—1, EN61326—2-6, CLASS A, GROUP 1, ISM EQUIPMENT</td>
<td>EN61326—1, EN61326—2-6, CLASS A, GROUP 1, ISM EQUIPMENT</td>
</tr>
<tr>
<td>FOR RESEARCH USE ONLY. NOT FOR USE IN DIAGNOSTIC PROCEDURES.</td>
<td>FOR RESEARCH USE ONLY. NOT FOR USE IN DIAGNOSTIC PROCEDURES.</td>
</tr>
<tr>
<td>IMPACT INDICATOR SENSITIVE PRODUCT WARNING</td>
<td>IMPACT INDICATOR SENSITIVE PRODUCT WARNING</td>
</tr>
<tr>
<td><strong>Note:</strong> If the indicator is tripped, then this container has been dropped or otherwise mishandled. Make a note on the Bill of Lading and then check for damage. Any claims for shock damage require a notation.</td>
<td></td>
</tr>
<tr>
<td>IMPORTANT! RECORD ANY VISIBLE CRATE DAMAGE INCLUDING TRIPPED &quot;IMPACT INDICATOR&quot; OR &quot;TILT INDICATOR&quot; ON THE WAYBILL BEFORE ACCEPTING SHIPMENT AND NOTIFY YOUR LOCAL AB SCIEX CUSTOMER SUPPORT ENGINEER IMMEDIATELY. DO NOT UNCRATE. CONTACT YOUR LOCAL CUSTOMER SUPPORT ENGINEER FOR UNCRATING AND INSTALLATION.</td>
<td>IMPORTANT! RECORD ANY VISIBLE CRATE DAMAGE INCLUDING TRIPPED &quot;IMPACT INDICATOR&quot; OR &quot;TILT INDICATOR&quot; ON THE WAYBILL BEFORE ACCEPTING SHIPMENT AND NOTIFY YOUR LOCAL AB SCIEX CUSTOMER SUPPORT ENGINEER IMMEDIATELY. DO NOT UNCRATE. CONTACT YOUR LOCAL CUSTOMER SUPPORT ENGINEER FOR UNCRATING AND INSTALLATION.</td>
</tr>
<tr>
<td>MINIMUM OF SIX PERSONS REQUIRED TO SAFELY LIFT THIS EQUIPMENT</td>
<td>MINIMUM OF SIX PERSONS REQUIRED TO SAFELY LIFT THIS EQUIPMENT</td>
</tr>
<tr>
<td>TIP &amp; TELL</td>
<td>Tilt Indicator</td>
</tr>
<tr>
<td><strong>Note:</strong> Indicates whether the container was tipped or mishandled. Write on the Bill of Lading and inspect for damage. Any claims for tipping require a notation.</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>Translation (if applicable)</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>TiltWatch PLUS ShockWatch</td>
<td>Tilt Indicator</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Indicates whether the container was tipped or mishandled. Write on the Bill of Lading and inspect for damage. Any claims for tipping require a notation.</td>
</tr>
<tr>
<td>WARNING: DO NOT OPERATE WITHOUT FIRST ENSURING BOTTLE CAP IS SECURED.</td>
<td>WARNING: DO NOT OPERATE WITHOUT FIRST ENSURING BOTTLE CAP IS SECURED.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This warning is attached to the source exhaust waste bottle.</td>
</tr>
<tr>
<td>WARNING: NO USER SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED PERSONNEL.</td>
<td>WARNING: NO USER SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED PERSONNEL.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Consult instructions for use.</td>
</tr>
</tbody>
</table>